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MpoAoyog

Me 1D1aiTepn Xapd Kai ikavonoinon npoloyilw To &vrtuno UAIKO yia TNV unooTnpiEn Tng
di1daokaAiag Tou padbrparoc Twv Epappoywv MAnpogopikng otn I Aukeiou.

Méoa anod Tnv npoondbeia OIaNOPPWONG €vog VveEou AvaAuTikoUu Mpoypduparoc,
OpopoAoynonkav kai epapuolovral alkayéc pe oToxo Tnv avapabupion kar  Tov
EKOUYXPOVIOWO TOu pabnuato¢ T6co oTto Mupvacio 600 kal oto AUkelo. Ol Mo €KTEVEIG
aM\ayéc napatnpouvTal ota padnuata Tng B’ kar Tng I Aukeiou, AOyw TnG UI0BETNONG TWV
KATEUBUVOEWV OTO VEO WPOAOYIO NMPOYPAMHA TwV AUKEIWV, PE TO VEO PABNMA EQapuoyec
TTAnpo@opikric va dnuioupyeital €10IKA yia TNV €EUNNPETNON TWV AVAYKWV OGUYKEKPINEVWY
KATEUBUVOEWV.

H dopn Tou padnoiakoU UAIKoU BaaileTal oTIC ENTA EVOTNTEC TOU AVAAUTIKOU NpoypaupaToc,
KaAUNToOVTAC TIC YVWOEIC, TIC IKAVOTNTEC, TIC O€€I0TNTEC, TIC OTACEIC Kal TIC afiec nou
NPOKUNTOUV anod TO YeVIKO OKOMO TOU MaBAuaTog, va npoeTolpacel dnAadn Toug/Tig
HaBNTEC/TPIEG yIa TNV EvTagr Toug oTnv Koivwvia Tng MAnpogopiac. Ta podia autda 6a Toug
EMITPEYOUV TNV UNEUBUVN, TNV EVOUVEIdNTN, TV AOQPAAN, TNV anodoTIKN Kal T SNUIOUPYIKN
Xpron Twv TexvoAoyiwv TnG MANPO@OPIKAG OTOV €nayyeAUATIKO TOWEa nou Ba emAEEouy,
oTov kAado onoudwv nou Meavo va akoAoubrioouv aAAa kai oTnv KabnuepivoTnTa Touc,.

To UAIKO eival dlaxwpliopévo o dUO TOWOUG, O SIUEIWOEIC KAl O TETPAOIO, Ol Onoiol €ival
OPYAVWMEVOI OTIC EVOTNTEG ME TIC OMOIEC O PABNTEC/TPIEC eival RON e€oikelwpévol/ec. Ol
2nueiwoeic dev anoteAolv OIOAKTIKO €yXEIPIOIO AAAG UAIKO avagopdc, TO Onoio MEPIEXE
napadeiypata, €neEnynoeig kalr eMnPOCBETEG NANPOPOPIEG Kal XPNOIMOMNOIEITAl WG MNyn
avtAnong NAnPo@opIwV Kal gival oTeva ouvOESEPEVO [E TO AVAAUTIKO Npoypappa. ZTnv apxn
TOU kABe kepalaiou diaTunwvovTal ol dIBAKTIKOI OTOXO0I, BACIOUEVOI OTOUG JEIKTEG EMITUXIAG
Kal TO NEPIEXOMEVO avanTUxOnKe e BAcn Toug JEIKTEC ENAPKEIAC.

To Terpadio anoteheital and evdelkTiKG QUANG €pyaciag, onou nepIAapBavovTal noikiAeg
dpacTnpIOTNTEG HE dlagoponoinuevo deikTn duokoAiag, waoTe va €ival duvaTn n NpPocapuoyn
TOU paBnuaTog oTIG IKAVOTNTEG, OTIG ANAITRACEIG KAl OTIC avayKeG OAwV TwWV PabnTwv/Tpiav.
YioBeTouvTal gUyxpova OI0aKTIKA HOVTEAA, mou oTnpidovTal oTnv npowdnon EENyUEVV
HEBOBWV 0IKODOKNONG TNG YVWONG, HE ANWTEPO OTOXO TNV avanTu€n Tng dnMIOUPYIKNAG Kal
KPITIKNG OKEWNG Kal TNV KAANIEPyEIa OEEIOTATWY ENIKOIVWVIAG, GUVEPYATIag Kal GUGTNHATIKWY
TPONWV NPOCEYYIONG YIa TNV €NiAUGN NPOBANHATWV.

Euxapiotwy Beppd OAOUC TOUG OUVTEAEOTEG TNG Npoonabelag autng, 18IaiTepa TNV opada
UMNooTNPIENG TNG EPAPHOYNG TOU avaAuTIKoU NpoypdupaTog Kal Twv CURBOUAWY KaBnyntwv
™G MAnpogopIknG kal TNG EnioTung Twv HAekTpovikwv YnoAoyioTwy yia Tn dnuioupyia Tou
évTunou UAIKOU aAAd Kkal TOu nNAEKTPOVIKOU UAIKOU MOU TO OUVODEUEl, TOUC OIKEIOUG
eMBEWPNTEC, TOUC AsiToupyoUc NG Ynnpeoiag AvanTuéng MpoypaupdTwv Kai 1I01aiTeEpa Toug
EMIOTNMOVIKOUG  OuvepyaTeg, Tov Apa Xpuon Tlewpyiou (Tunua MANPOQOPIKAG ToU
Maveniotnuiou Kunpou), Tn Apa XapoUAa AyyeAny (Tunua Emiotnuwv Tng Aywyng Tou
MavenioTnpiou Kunpou) kai Tov Apa Avdpea Avdpeou (Tunua HAekTpoAdywv Mnxavikwv Kal
Mnxavikwv HAekTpovikwv YnoloyioTwv kal MAnpogopikng Tou TexvoAoyikou MavenioTnpiou
KUunpou) yia Tn ouhBOAN Toug oTnv avanTuén Tou UAIKoU auTtou.

Ap Kunpiavog A. Aoung
AiguBuvTng Meonc Eknaideuong
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Eicaynyn

‘Otav Tov MdpTio Tou 2009 Eekivnoe n npoondbeia yia €knovnon Tou NEou AvaAuTikoU
MpoypdupaTog Tou padnuartoc Tng MANpo@opiknG Kar TG EnioTAung Twv HAEKTpOVIKGOV
YnoAoyIoTwv, TEBNKE WG NPOTEPAIOTNTA N Bewpnon Tou PabrpaTog Yeoa anod To NPIoPa Twv
TPIOV NUAWVWV TNG €KNAIOEUTIKNG MeTappubuionc. Méoa and To npiopa, OnAadn, Tng
anokTNoNG &vOC €NAPKOUC OWMATOC YVWOEWV and Toug WadnTég kal TIC WabnTpieg, Tnv
KaAAIEpYEIa a&lwV Kal TNV EKONAWON GUMMEPIPOPWYV MOU va GuvVAdouv We Tn ouyxpovn &vvoia
TNG ONUOKPATIKAG NOANITOTNTAG KAl TNV KAAAIEPYEIQ KOUBIKWV IKAVOTATWV Kal OEI0TATWY ano
TOUC HaBNTEC Kkal TIC WABATPIEC, WOTE va HnopoUv va AEIToupyoUv oTn OlaHOPPOUMEVN
Kolvwvia Tou 21° aiwva.

3TNV €mITPONN yia TNV €knovnon Tou AvaAuTikoU [MpoypdupatoC TOTE CUMMETEIXQV O
akadnuaikog Avopeac Avdpéou (AvanAnpwTtng Kabnyntnc oTto Texvoloyikd MavenioTrnpio
Kunpou), ol eniBewpnTec MAnpopopikng Mapiog MIATIGdou kai MixaAng TopTtoupnc kai ol
kadnynTteg MAnpo@opiknG NikoAaog Zayyouhog, Iwavvng Iwdavvou, Mnvac KapaoAng,
©eo0doulog KwvoTtavTivou, Mapia Mapda, Zwkpatng MuAwvag kar MavayiwTtng Manerrac.
MapoAo nou eixe NpoTabei éva oAOKANPWHEVO avaAuTIkO npoypapua and Tnv A’ Mupvaaciou
MEXPI kKal TNV " Aukeiou, o€ NpWTN PAoN EPAPHOCTNKE MOVO PEXP! TV I Tupvaaciou.

To 2014 n diadikacia epappoyng Tou Néou AvaAuTikoU MpoypdupaTog avacTaABnke yia eva
£TOC hE okono Tnv a&loAoynon Tou. H aveEapTtnTn enitponny a&loAdynong n onoia eEETace To
nepiexopevo Tou Néou AvaAuTikou Mpoypdppatog yia To padnua tng NMANPo@OopIKAG Kal TNG
Eniotnpng Twv HAekTpovikwv YnoAoylioTwv Ogv evronmioe NAPaAEiWelG aAAa eMonPave OTI
auTo nATav Bacicpevo e dIEBv NpOTUNA Kal OTI ATAV ENIOTNHOVIKA ENAPKEG,

Tov deBpouapio Tou 2015 diopioTnke vea enmirponn yia Tn BeATioon Tou NEou AvaAuTikou
MpoypaupaTog kai Tnv avadiaTunwaon TOU HE OUYKEKPIKMEVO TPOMo (WE TN Hopdn OEIKTWV
emITuyiag kal dEIKTWV eNApKeIac), kabwg kal Tnv Tolpacia AvaAuTikoU MpoypdupaTog yia Ta
pabnuata nou Ba didackovTal oTo AUKeIO, AauBavovtac unown Kal TIG NapagéTpoug Tou
Neou Qpoloyiou MpoypAppaToc. TNV ENITPONN AUTH CUMKETEIXaV ol akadnuaikoi Ap Xpuong
Fewpyiou (AvanAnpwtng Kabnyntng, Tunua MAnpogopikng Tou MavenmioTnuiou Kunpou), n
Ap XapoUAa AyyeAr) (AvanAnpwTpia KaBnyntpia, Tunua Emotnuov Tng Aywyng Tou
Maveniotnuiou Kunpou) kai Ap Avdpeag Avdpeou (AvanAnpwtng Kabnyntng, Tunua
HAekTpoAdywv Mnyxavikwv kai Mnxavikwv HAekTpovikwv YnoAoyioTwv kal MANpoQopIkng Tou
TexvoAoyikou MavenioTnuiou Kunpou), ol EmBewpnTég MAnpo@opikng Mapiog MIATIGdouU Kal
MixaAng TopToupng, ol BonBoi AlguBuvTeg MANPO@OPIKNG ZwKpaTnG MUAwvaAg kal NikoAaog
Zayyouhog kai ol KaBnynteg/tpieg MAnpogopikng, MauAog MauAikkag, MoAa MAakkouAq,
Mavayiwtng HpakAgoug, KwvoTavTivog Zw@poviou, MIATIAdNG XapIAdou, Z€viog ZeVOPWVTOG,
Zopia Kaléhn, HAiag ©ecodwpou, AnuATpnG MaupoBouvinTng, AnuATeng XatdnnavrteAng,
NikOAag ZTpatn kal Owpag Iwavvou.

H diatunwon Tou AvaAuTikoU MpoypappaTtog yia T B kar Tn ' Aukeiou 0AoKANpwONKe Tov
IoUAlO Tou 2016. MapdAAnAa avanTUxBnke kai TO UMOOTNPIKTIKO UAIKO (EvTuno Kal
NAEKTPOVIKO) TO OMOIO EXETE OTA XEPIA OAG.

Y€ eninedo nepiexopevou, To NEo AvaluTikO Mpoypappa NeEPIEXEI ONUAVTIKEG aAAayEC and To
avTioTolxo NaAaioTepo, aAMda Oev nepiExel Peyaho apiOpd véwv BepdTtwv. Tooo To NEo
AvaluTiko Mpoypapua, 600 Kal TO unooTnPIKTIKO UAIKO €ival opyavwpévo pe Baon enta
evOTNTEG, Ol onoie¢ avantuocovtal napdAMnAa and Tn pia TAEN OTNV €nOpEVN Kal




Eicaynyn

avTikatonTpilouv BacikoUc BepaTikoUs afovec TNG MANPo@OPIKAC kal EmoTAung Twv
HAEKTPOVIKWV YNOAOYIOTWV:

e Baoikég 'Evvoleg

e To YAkO/ApXITEKTOVIKN YMOAOYIOTWV

e ASITOUPYIKA ZUOTAUATA

Noyiopikd Epappoywv

Aiktua kar AiadikTuo

Baoeic Acdopevwv kal AvanTuén MANPopopIakwv ZUoTNUATWY

ANyopI1BuIKn ZkEWN, MpoypaupaTionoc kal ZUyxpovec Eqpappoyec MANPOQPopIKNG.

>Ta padnuarta Tng B’ kal " Aukeiou undapyel €EEIdikeuon oTa NPOoPEPOPEvVa Pabnuara. 1o
naenua E@apuoyec MAnpo@opikric diveTal Eupaon oTIC Baoike ‘Evvoleg, oTnV APXITEKTOVIKN
YnoAoyloTwv, oTa AsIToupyikd ZUOTAKATA Kal KUpiwg oTiC Epappoyeg MANPo®opIKAG Kal oTa
Aiktua kai Aiadiktuo. To OUYKEKPIMEVO WABNUa, endIWKEl va KAAIEPYNOEl TIC  YVWOEIG,
IKAVOTNTEG Kal OEIOTNTEC Nou BewpoUvTal anapaiTNTEG yIa va AEITOUPYNOEI KAMNOIOC EITE WG
eNayyeAUaTiag €iTe wg NoAiTNG oTnv uno eEENIEN Kolvwvia TnG NAnpogopiag Tou 21° aiwva.

O1 evOTNTEC auTEC avanTuooovTal oTadiakd pEca anod dlaBabuIoNEVOUC OTOXOUG/OEIKTEG
enmTuxiac and Tn pia TaG&n oTnv €ndpeEvn, NAPEXOVTAC ENINPOCOETEG EUKAIPIEC OTOUC/OTIC
HaBNTEC/TPIEC Mou dev PNOPECAV va TOUC KATAKTNOOUV Ot Mia TAEn va 1o npagouv o€
ENOMEVN, ME NAPAAMNAN €uBdabuvaon. ZnUavTikd OTOIXEID TNG VEAG NMPOCEYYIONG €ival Kal n
aMnA€EapTNON TWV €VOTATWV, GAAA KAl N OUYKEKPIKEVOMOINGN Kal O MNEPIOPIOHOG TWV
€VVOIQV Nou Ba npenel va yvwpifouv ol JabnTEG/TPIEG, HE EUPAon aTNV EPApHOyn Toug TNV
npa&n.

Ta evdelkTiKG QUANa epyaciag nou akoAouBouv (kabBwg kal 0 OUVOJEUTIKOG TOMOG TwV
OnMEIWOoEwWV), BacioTnkav oe SIDAKTIKEG MPOTACEIC MOU ETOINACTNKAV AMNO TOUG UNOCTNPIKTEG
NG €pApUOYNc Tou VEou AvaluTikoU [lpoypduupatoc, Kai and TouG GUMBOUAOUC TNG
MAnpo@opiknG kal Tng Emotnung Twv HAekTpovikwv YnoloyioTwv. O1 dpactnpidTNTEG Nou
nepiIAapBavouyv gival diaBabpIOPEVEG, WOTE va JIVETal N EuKaIpia EPAPHOYNG TNG VEAC YVWONG
o€ OAOUG/EC TOUC/TIC HaBnTEG/TpIeC avaloya pe To Babud €ToiOTNTAG TOug, apxifovtag anod
TO anAO Kal NPOXWPWVTAG 0To oUVOETO. Méoa and auTd napexeTal kabodrynon TO0O yia TO
€UPOC Kal To BABOC TwV YVWOEWV Kal Twv OeEI0TATWV Mou XpelaleTal va avantu&ouv ol
MaBNTEC/TPIEG, OO0 Kal yia TIG NPOTEIVOUEVEG HEBODOAOYIKEC Npooeyyioels. 'Epgaon diveral
OTNV NPAKTIKA €PAPHOYN TWV YVMOOEWV Kal Twv OeEI0TATWV TWV HaBNTWV Kal oTn Xprnon
€PyaAeiwv kal AOYIOHIKOU and TOUG/TIG paBNTEG/TPIEG OTOUG NAEKTPOVIKOUG UMOAOYIOTEC,
NPoAyovTag pabnToKEVTPIKEG MPOOoEYYIoeIG kal neplopifovtag Tn HeTwnikn didackaAia. Ol
KadnynTeg/Tpiec evBappUvovTal va Ta Npooapuooouv 1 kai va dnuioupynoouv aAAa, Ta
onoia va avranokpivovral kaAuTepa, TO0O OTa IDIAITEPA XAPAKTNPIOTIKA TwV HABNTwV Kal
HadnNTpILV Toug, 600 Kai aTn OIKN Toug JIDAKTIKI NPOCEYYION OTO KABE pabnua kabwc Kai va
polpacToUv TIC OIOAKTIKEG TOUC E€I0NYNOEIG ME AAAOUG eknaideuTikoUG, aAd kal pE TN
ouYYPa@IKN opada.
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®YAAO EPraziAz M4.1.M1
Awaxeipion YnoAoyioTik@v ®UAA@V

Ti 6a padoupe onpepa:

© Na si0ayoups kal va diaypapoupe OTNAEC Kal YPAUUEC O £va (PUANO £pyaciag

© Na eioayoupe, va petovopaloupe kal va diaypdgoupse QUAAG epyaciac péoa oe eva PBiBAio
epyaoiac.

ApaoTnpioTnTeCG EUnédmwong

1. Na evepyonoInoEeTE TNV PAPHOY UNOAOVIOTIKWV QUAA®V.

2. Na avoieTte To apyeio e-commerce.xlsx and Tov pakeAd oag.

3. Na anoBnkeUoeTe TO apyeio oTov PakeAd oac Ye To ovopa FE1.xIsx.
4. Na ei0ayeTe pia véa oTnAAN avapeoa oTig otrAeg E kai F.

5. 210 keAi F3 va nAnkTpoAoynosTe 2007.

6. Na oupnAnpwoeTe Tn VEa OTAAN HE TOUG akOAouBoug apiBuouc, avTioTolxa:
1440, 3500, 7300, 15250, 6480, 7320, 9460, 1840, 15390, 2170.

7. Na npooBeoeTe pia véa ypappn avaueoa oTiC Ypaupeg 7 kal 8.
8. 270 keAi A8 va nAnkTpoAoynoeTe Eidn évduong, aOAnTika €idn.

9. Na OouUUNANPWOETE TN VEa YPAHMR ME Touc akdAouBouc apiBuouc, avTioToIXa:
20345, 19675, 17289, 14376, 10300, 7480.

10. Na diaypayete Tn ypapun 2.

11. Na diaypayete Tn oTNAN G.

12. Na diaypayete Ta QUAAa epyaciac Sheet2 kal Sheet3.

13. Na petovopdosTe To QUANO gpyaciac Sheetl os AyopEg.

14. Na npooBéoeTe éva véo pUAAO gpyaaiac.

15. Na PETAKIVAOETE, 0TN OUVEXEID, TO PUAAO epyaciac AyopEG 0To TEAOC.

16. Na anoBnkeUoeTe TIC AAAAYEG NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

ApaoTtnpioTnTeG AEI0AOYNONG

17. Na avoiéete To apyeio MyExpenses.xlIsx and Tov (pakeAd 0ag kal va To anobnkeuoeTe
he To ovoua FEla.xlsx.
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18.

19.

20.

21.

22,

23.

Na npooBéoeTe pia véa oTAAN avapeoa oTic oTAAEG € kal D kal va guPNANPWOETE HE
Ta akoAoubBa, avTioToixa: OkT®wRPNg, 70, 10, 30, 10.

Na diaypayeTe Tn ypauun 2 kai Tn otnAn B.

>Tn ypauun 7 va oupnAnpwoeTe e Ta akoAouBa avTioToixa: Awpa, 5, 25, 10.

Na petovopdosTe To Sheetl o EEOAA 2017, va si0dyeTe €va véo pUAAO epyaciag
kal va diaypayete 1o Sheet3.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEpATIOETE Kal TNV EQAPUOYT UNOAOYIOTIKMV QUAAWV.

+ Eninpoo0erec ApaoTnpidTnTEG

24,

25.

26.

27.

28.

29.

30.

31.

32.

33.

Na evepyonoINOETE TNV EQAPLIOYH UNOAOYIOTIKWV QUAAWV.

Na dnMIOUPYNOETE €va VEO APXEIO kal va TO anoBnkeUOETE OTOV (PAKEAO OAC HE TO
ovoua FE1b.xlsx.

Na napaTnPnOETE TO APXEIO MOU EXETE WNPOOTA OAC KAl va OUUNANPWOETE Ta
napakaTw Keva:

(a) To 6vopa Tou BiBAiou Epyaagiag (Workbook) €ival: ..........ccuvvvviiiiiiiiiccenniiiiieeee,

(B) ZTo BiBAio Epyaciag unapxel ......... ®uMo Epyaaiac (Worksheet) kai To 6voud Tou
311V [

Na peTovopdosTe To PUAAO epyaciag Sheetl oc Tunua ri.

Na npooBéoeTe £va véo pUAAO epyaciac.

270 keAi A1, TOU VEOU PUANOU £pyaciac, va NANKTPOAOYNOETE TO OVOUATENWVUHO GAG.
Na HETOVOUACTETE TO VEO PUANO epyaociag o€ TuRua 2.

Na diaypaweTe To PUANO gpyaciac TuRHa 1.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEppATIOETE Kal TNV EQAPUOYT UNOAOYIOTIKWV QUAAWV.

ApaoTnpIOTNTEG YIa TO ZNiTI

34.

Na anavrnoEeTE OTIG NIO KATW EPWTNOEIC:
(a) Tieival To BiBAio Epyaociag;
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(B) Ano T anoTeAeital éva pUAANO gpyaaiag;
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®YAAO EPraziAz N4.1.M2
Awaxeipion YnoAoyioTik@v ®UAA@V

Ti1 6a padoupe onpepa:

©OOOOd

Na npooapuoloupe Ta nepiBwpla TNG oeAidag

Na aAhaloupe Tov npooavaToMopo TngG oeAidag

Na npooBEToulE Kal va TpononoloUUe KepaAida kal unooeAdo

Na kaBopiloupe TNV NePIoXn EKTUNWONG

Na gugpavifoupe kal va anokpUNToupe To NAéyua (grid) katd Tnv ekTUNwon

Na ep@avifoude Kal va anokpUMTOUME TIC ETIKETEC TWV YPAUMWV KAl TwV OTNAWV KATA TNV
ekTUNWaon.

ApaoTnpioTnTeCG EUnédmwong

>TIC dpaoTnPIOTNTEC €UNEdWONG OIVETAI ETOIMO KEIMEVO KAl KAAEIOTE va KATAypAWETE TI
nepiExel N kepahida kal To unooeAido, NOCO Eival Ta NePIBwpIa Kal TI NPOCAvATOAIOMO EXEl TO
PUANO gpyaoiac. Aev Ba aAAG&eTe onoleadnnoTe anod TIG pUBUIoEIC.

1.

2.

Na evepyonoINOETE TNV EQAPLIOYH UNOAOYIOTIKWY QUAAWV.

Na avoi&ete To apxeio Grades1.xlsx ano Tov PpAkeAO oac,.

Na ouunANPWOETE NIo KATW Ta Tpid PEPN TNG KEPAAIdag Tou PUANOU epyaciag oagc:
Header

T NANPOPOPIEG NEPIEXOUV AUTA Ta TPIa PEPN TNG KEPAAIDAC;

Na guuNANPWOETE NIO KATW TA Tpid PEPN TOU UNOGEAIBOU TOU PUANOU £pyaciag oag:

Footer

TI nAnPO@OPIEG NEPIEXOUV AUTA Ta Tpia PEPN TOU UunoagAIdou;

Na guunANPWOETE GTO MNIO KATW NAAicIo Ta NEPIBWPIa TOU PUANOU £pyaciag oac:

18



4.1 YnoAoyioTika ®UAAa r.4.1.mM2

6.

Na KUKAWOETE TOV NPooavaToAIoH0 Tou pUANOU epyaaiag oac:

Na kAcioeTe To apyeio AIXQS va 1o anobnkeuoste. MHN KA€iosTE OPWC TNV £DApPUOYN
UMOAOVIOTIKWV QUAAGV.

ApaoTtnpioTnTeg ASI0AOYNONG

10.

11.

12.

13.

14.

15.

Na avoi&eTe To apxeio Grades2.xlsx ano Tov pAkeAO oac.

Na npooBéoeTe TNV KEPAAida Ta Nio KATW OTOIXEIQ:
e 3Ta apioTepd, Tn onuepivi) Huepounvia
e 3TO KEVTPO, YPAWETE TN Ppacn Babpoi padnromv

e >T1a 0e€1d, TNV €ikOva grade2.jpg ano Tov pAKeNO 0ag

Na npooBegeTe 0TO UNOGEAISO TA MNIO KATW OTOIXEIA:

e 2Ta apioTepd, To ‘Ovopa TOU apyeiou

e 3TO KEVTPO, TOV ApIOHO oAidag — ApIOHOI OEAIdWV
e 2T1a 0e€1a, TN onuepivi) ‘Qpa

Na aM\aEeTe Ta nePIB®pPIa Tou PUANOU €pyaciac oag oe:
e Top = 2,0cm

e Bottom = 2,0cm

o Left = 2,0cm

e Right = 2,0cm

Na aM\a&ete Tov npooavaToAlopo Tou GUANOU epyaciac oag oc Landscape.
3TN OUVEXEID, va KAOOPIOETE yia eKTUNWON TNV nepioxn keliwv B1:E17.

Na ep@avioete kal To NAEypa (grid) kata@ TNV EKTUNWON KAl VA EKTUNWOETE TO PUAAO
€pYaciag oag oTov NPOEMIAEYLEVO EKTUNWTH, A(POU pWTHOETE NPWTA ToV KABNyNTH 0dg.

Na anobnkeUoeTe TO apxeio aTov PAkeAd oac, Pe To ovopua FE2.xIsx Kal va To KA€ioETE.

“+ Eninp6o0eTec ApaoTnpioTnTES

16.

17.

Na avoi&ete &ava To apxeio Grades2.xlsx anod Tov pAkeAd 0ag Kal va NpooBECETE OTO
unoo€Aido de&1a Tnv sikdva pe To ovoua back-to-school.gif ano Tov pdakeAd oac.

Na aAAG&eTe To nEPIBWPIO TOU PUANOU €pyaciag oag o€ npokabopiopévo Narrow kai
va YPAYETE TIC NAPATNPAOCEIC 0aG NIO KATW:




r.4.1.mM2 4 Aoyiopiko Eqpappoy®v

18.

19.

20.

21,

Na aAM\a€ete Tov npooavaToAiopo Tou pUAAOU epyaciac oag oc Landscape. NopileTe
OTI €ival 0 OWOTOG NPOCAvaToAIoHOG NOU NPENEl va £xel To UANO £pyaociag oag;

Na €U@AVIOETE TIC ETIKETEG TWV YPAHH®OV KAl TWV OTNA®V KATA TNV KTUNWON Kal
va deiTe To PUANO £pyaaciac oag oTn OUVEXEID, O NPOBOAN EKTUNWGONC.

Na anobnkeUoeTe TO apYeio OoTov (PAKENO oac pe To Ovopa FE2a.xlsx kai va To
KAEIOETE.

Na TEPUATIOETE KAl TNV EQAPUOYT UNOAOVIOTIKWV QUAAWV.

ApaoTnpIOTNTEG yia TO ZNiTI

22,

23.

Me Bdon Tnv nio navw Aaoknon 16, va ypayere nio kATw Ta PAMATA NOU EXETE
akoAouBnoel yia va NpooBEoETE €IkOVA OTO UNOTEAIDO.

Me Baon Tnv nio ndvw aoknon 11, va ypdyete nio kKATw Ta PBAMATA MOU EXETE
akohoubnoel yia va aAageTe Ta nepiBwpia Tou QUANOU Epyaaiag oag.
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®YANO EPrAZIAZ MN.4.1.M3
Mop@onoinon ®UAAwv Epyaciag

Ti 6a padoupe onpepa:

© Na al\aloupe Tn ypappaToosipd Twv dedOUEVWV
© Na al\aloupe To PEyeBOC Kal TO XpWHA TNG YPAUKATOOEIPAC TwV JEDOUEVWV
© Na epappoloupe popponoinan oTo NEPIEXOUEVO KEAIWV, WE &vTovn ypa®n, rAdyia ypagr ka
unoypapuion
© Na ouyXwveUoupe pia opada KeAIWV Kal va KEVTPAPOUKE TO MEPIEXOUEVO TOUG ) VA avalpoUlE TN
OUYXWVEUON
© Na pOpQpOMOIOUME KEAId, WOTE va ey@avifouv apiBPouc HPE OUYKEKPIYEVO aplOPo dekadikwv
Yneiwv, OTUA nuepounviag, cUUBOAO VOUIOUATIKNG HOovVAdAg kal MogoaTa
© Na TpornonoloUpE To UWOG YPAUH®V Kal TO MAGTOC OTNA®V.
ApaocTnpioTnTeG EUnédmong
1. Na evepyonoinoeTe TNV pappoyn unoAoyioTikwv UAAwY Microsoft Excel.
2. Na avoi&eTe 10 apyeio KpunToAego.xlsx ano Tov pakeAo odg,.
3. Na anoBnkeUOETE TO APXEIO OTOV PAKEAO 0ac¢ e To ovopa FE3.xlIsx.
4. Na em\e€ete To kKeEAi C1 and 1o PUAO epyaciac Sheetl kal va €PapuOOETE OTO
NEPIEXOMEVO TOU Ta MIO KATW:
e 'Evrtovn ypaon
e Ynoypdauuion
e MnAe XpWHA YPAUHATOOEIPAG
e Méyebog ypappaTooelpdag 16 oTiydwv
5. Na spappooeTe oTnv nepioxn keAlowv C1:N1 guyXwVEUON Kal KEVTPAPIoWd.
6. Na evronioere TIG AE€EeIC nou avaypdgovtali oTa Oefid Tou KpunTOAeEou,
epappolovTag kabe Qopa:
e [pappaTooeipd Comic Sans MS
e  AIGQOPETIKO XPWHA YPAUHATOOEIPAG
e [Adyia ypaon
7. Na TpOnoOnoINOETE TO NAAGTOG TWV OTNAMV TOU KPUMNTOAEEOU, WOTE vd
npooapuoleTal auTOPATA, avaloyda HE TO NEPIEXOMEVO TwV KEANIWV OaC.
8. Na peraBeite Twpa oTo PUANO epyaciac Sheet2.
9. Na petatpéyere Ta Oedopeva TnG nepIoXnG keAiwv B4:B7 oe XpnuATIKO NOCO ME

oUuBoAo To Eupw (€).

10. Na peratpeyete Ta dedopéva Tne nepioxne kellwv C4:C7 os noocooTa (%).
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11. Na petaTtpéyeTe Ta dedopeva TG nNeploxng keAiwv D4:D7 os dekadikoUg apiOpolG e
Tpia (3) dekadika wneoia.

12. Na avaipégeTe TN GUYXWVEUON TNG NePIOXNC keAlwv A1:D1 o€ £va KeAl.

13. Na anoBnkeloeTe TIGC aAAAYEG NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

14. Na TepUATIOETE KAl TNV EQAPUOYH UNOAOYIOTIKWV PUAAWV.

ApaoTnpioTnTeG AZIoAOYynong

15. Na avoiTe 10 apyeio IN.4.1.M3-Quiz.htm and Tov QAkeAd 0ag Kal va dnavinoeTe o€
OAeC TIC epwTnoelG. 'ETOl, Ba KAVETE AUTOEAEYXO TWV YVWOEWV 0ac. MOMNC To
OAOKANPWOETE EVNUEPWOTE TOV/TNV KABNyNTH/KabnynTpIa oac.

=+ EninpooOeTec ApaoTnpioTnTEG

16. Na evepyonoInoeTe TNV EQApPOYN UNOAOYIOTIKWV QUAAWV.

17. Na avoi&ete Eava 1o apxeio FE3.xIsx and Tov @pakeAo oac.

18. Na perapeite oTo PUAO gpyaciag Sheet3 onou Ba Bpeite éva oTaupoAego.

19. No emAUoeTe TO OTAUPOAEEO auTd (povo opiddvTid) oTa ayyAdka kal va
XPNOILOMNOINCETE, Yia KABE 0ag anavtnaon, €vrovn ypa@n kal S1a@opeTIKO XpWHA
YPAUHATOOEIPAG,

20. Na anoBnkeUoeTe TO apxeio oTov QAakeAd oag, Je To Ovopa FE3a.xlsx kal va To
KAEIOETE.

21. Na TepuaTioETE Kal TNV £PAPHOY UNOAOYIOTIKWV QUAAWV.

ApaocTnpIOTNTEG yia TO ZNiTI

22. Na kukAwoeTte To OPOO ) To AAGOZ oTov nivaka nio KATw:

MNa va TPOMOMOINCOUME TO NAATOC Miag  oTAANG,

Xpnoidonoloupe TiG evToAéc Format > Row Height. OPE0 | AABO2

(@)

Ma va ouyXwveUOOUWE Hia opada KeNIWV Kal va KEVTPAPOULE
(B) | To nepiexopevd  TOUuG,  XpnoidonoloUhe TNV evtoAn | OPGO | AAGOZ
Merge & Center.

Ma va TPOMOMOINCOUME TO  UWOG Hiag  YPAMMNAG,

XPnoidonoloupe TiG evToAéc Format > Row Height. OPE0 | AABO2

(v)

) Ma va £papuOCOUMPE €vTovn Ypa®ry OTO NEPIEXOUEVO EVOC

. . Y g OPOO | NAGOZ
KEAIOU, XpNOILONOIOUKE TO glkovidio Italic.

Ma va aMa&oupe To PEYEBOG TNC YPAMPATOOEIPAG OTO
(€) | nepiEXOPEVO  €VOC KEANIOU, XpnOIMOMOIOUME To  glkovidio | OPOO | AAGOZ
Font Size.
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®YAAO EPTrAZIAZ .4.1.M4
Mop@onoinan ®UAAwv Epyaciag

Ti 6a padoupe onpepa:

© Na epappoloupe POVTO Kal Nepiypappa ora KeAid

© Na avTiypapoupE TIG HOPPOMOINTEIG EVOG KENIOU i} NEPIOXNC KEANIWV O£ AAAO KEAI ) nNEPIOXT) KEAIWV
© Na epappoloupe oToiXIon OTa NEPIEXOUEVA TWV KEAIOV

© Na €10ayoupe €1kova GovTou o€ OA0 To PUANO £pyaaciac.

ApaoTnpioTnTeg EUnédmwong

1. Na evepyonoInosTe TNV EQAPLOYA UNOAOYIOTIKWY QUAAWV.

2. Na avoieTe To apyeio KMZ.xIsx ano Tov ¢pakeAd oag.

3. Na ouyxwveuoeTte TNV nepioxn kehllwv B1:G1.

4. Na epappooete 1o nepiypaypa All Borders otnv nepioxn kehiwv C5:F11.

5. Na Hop@onoInoeTe TO NEPiyPANMA, WOTE va €xel HAAE XpwUa Kal N ypauun Tou va givai
SInAn.

6. Na ouyXxwveUOETE Kal va KEVTPAPETE TNV neploxn keAiwv C3:F3.

7. 70 KeAi B1 va epappO0ETE WG POVTO TO AVOIXTO NPACIVO XpwHa.

8. Na avTiypdyete TN popponoinon Tou keAlou B1 oTo keAi C3.

9. Na oToIXioETE TO NEPIEXOPEVO ToU keAIoU B1 oTa de&ia.

10. Na dlaXwpioETE, 0TN OUVEXEIQ, TO KeAi C3.

11. Na sioayayste w¢ OvTo oTo PUANO e£pyaciag oac, Tnv eikova Desert.jpg and Tov
(PAkeAd oag,.

12. Na @apuOOETE WG XPWHA YPAUHATOOEIPAG otnv nepioxn keAlwv C5:F11 To donpo
Xpwua.

13. Na anoBnkeloeTe TO apxeio aTov PAKENO 0ac pe To ovoua FE4.xIsx kal va To KAEIoETE.

14. Na TepuaTIOETE KAl TNV EQAPUOYN UNOAOVYIOTIKWYV PUAAWV.

ApaoTtnpioTnTeg ASI0AOYNONG

15. Na evepyonoInoETE TNV EPAPHOYR UNOAOVIOTIKWV PUAAWV.

16. Na avoieTe Eava To apxeio FE4.xIsx ano Tov (pakeAo oac,.

17. Na diaypdyeTe TO POVTO MOU UNAPXEI OTO (PUANO €pyaciac oac.
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18. Na €pappOOETE WG XPWHA YPAUMATOOEIPAC oTnv nepioxn keAiwv C5:F11 To pauvpo
Xpwua.

19. Na pop@onoinoeTe To EwTepIkO nepiypappa os Thick Box Border otnv nepioxn KEN®V
C5:F11.

20. Na popponoInosTe To €EWTEPIKO NEPIYPANKA, WOTE VA EXEl KAl KOKKIVO XPWHA.

21. Na spappooete otnv nepioxn kehiwv C5:F11 w¢ pOVTO TO KiTPIVO XPWHA Kal vd
OTOIXIOETE TA NEPIEXOMEVA TWV KEAIWV TNC OTO KEVTPO.

22. Na diaypayeTe POVO TO NAV® NEPIYyPAMHA TNG NEPIOXNG keAiwv C5:F11.

23. Na Bpeite pia eikdva TnG apeokeiag oag and To dIadikTuo Kal va TNV EPApHOCETE WG
@OovTOo o€ OAO TO PUAAO £pyaaciag oag,

24. Na anoBnkeuoeTe TIG AAAAYEG MOU KAVATE OTO APXEIO 0AG KAl VA TO KAEIOETE.

+ Eninpoo0erec ApaoTnpidTnTEG

25. Na dnuioupynaoeTe To O1kO 0aC OXOAIKO NPOypapHa.

26. Na popponoInoeTe To PUANO £pyaciag wg eENG:
e Eikova ®OvTou TNG apeokeiag oag aTto PUANO epyaaciac.
e  DOVTO TNG apeokeiag oag o€ onoia nepioxn KeEAIWV BEAETE.
e 2TOIXION TNG apeoKeiag oag os Onoia NepIoxn KEAIwV BEAETE.

o lepiypappa TNG ApECKEIAG 0ag o Onola NepIoxn KENIWV BENETE.
27. Na anoBnkeUoeTe TO apxeio aTov PAkeAd oag, Ye To ovopa School Program.xlsx.

28. Na TepuaTiosTe kal TNV €QAPUOYN UNOAOYIOTIKWV QUAA®V.

ApaocTnpIOTNTEG yia TO ZNiTI

29. Na avagepete dUO AOYOUG yia TOug onoioug Ba XpnoiPonolouoaTe XPWHA (POVTOU I
€1IKOVA yIa POVTOo ot £va PUANO £pyaociacg oag;
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®YAAO EPraziAzZ M.4.1.M5
Ta&ivopunon ka1 ®IATpapiopa AsdopEvev

Ti 6a padoupe onpepa:
© Na Ta&vopoupe dedopeva e noAAanAa kpitnpia
© Na QIATpapoupe dedopeva Pe NoAAanAd kpitnpia.

ApaoTnpioTnTeCG EUnédmwong

1. Na €vepyornoInoEeTE TNV EQAPUOYH UNOAOYIOTIKWV QUAAWV.
2. Na avoi&eTte To apxeio Tourists.xlsx and Tov pakeAd oac.
3. Na Ta&§IVOPNOETE TIG XWPEG 0T 0TAAN A, woTe va napouacialovtal pe auéouoa oeipa
ano To A £w¢ To Z.
4. Twpa, va Ta&IVOMNOETE TIC AQIEEIC TOUPIOTWV KaTA To 2015, £T01 WOTE NpwTA vd
napoucialovTal ol XWPES PE TOV PJEYAAUTEPO apIBUO aPiEewy.
[ (0T Yo e U 35 4 T X 1Y [
5. Na aAM\a€ete Tov TpONO TA&IVOUNONG, £T0I WOTE va napoucialeTal NpwTn N Xwpa e
TOV MIKPOTEPO apIBud aiewv 10 2016.
[ (0T Yo e U 35 4 T X 1Y [
6. Na anoBnkeUoEeTE TO Apyeio oTov PAKENO 0ag e To Ovopa FES.xIsx kal va To KAEioeTe.
7. Na avoifeTte To apyeio Customers.xlIsx ano Tov PpAkeAd oac.
8. Na evepyonoinoete TO @IATPO, yia va PBPEiTE TIC ETAIPEIEC MOU €XOUV AYOPACE!
EKTUNWTH).
(@150 {121l ale [V (el > 1Y/ [N
9. Na evepyonolnoeTe To PIATPO, yia va BpPeiTe TIG ETAIPEIEG MOU £XOUV NANPWOEI YETAEU
TV 400 kai 600 gupw.
(O]8ox o [[oYol el e [V £ alf 1V | R PP
10. Na kAcioete Twpa To apyeio AIXQS va To anobnkeUoETE.
ApaoTtnpioTnTeg ASI0AOYNONG
11. Na avoiTe To apxeio Expenses.xlsx ano Tov @pake\o oac.
12. Na Ta§IVOUNOETE Ta OTOIXEIA TOU nivaka Twv €E00wWV, WOTE va Tagivounbouv Ta £€oda

KaTa katnyopia, o€ @Bivouoa ogipd anod To Z €wg To A.

H KATNYOPIA QUTI] EIVAL coiieieieiee e e e e e e e e e e e e e e e s e e e e e e e e e e e e e e e e e e e e e e e e e e e aeeas
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13.

Na anobnkeUosTe TO apyeio oTov (AKENO o0ag, pe To Ovopa FESa.xlsx kai va To
KAEIOETE.

“+ Eninpoo0eTec ApaoTnpioTnTEC

14.

15.

16.

17.

18.

19.

Na avoi&ete Eava To apyeio Customers.xlsx and Tov pakeAd oac.

Na evepyonoinosTe To PIATPO, yia va BPEITE TIC ETAIPEIEG TWV onoiwv To dvoua &ekiva
ano To ypdauua A.

(@158 £ 11l ale [V s (el > 1Y/ N

Na evepyonoinoeTe To QPIATPO, Yia va BPEITE TIC €TAIPEIEC NOU NANPWOAV NAvw ano
9.000 gupw.
Ol ETAIPEIEG AUTEG EIVAL 1vvviiiiiiiiiiiiiiiiiissssssssssssesssssssstsseestseeseesesaeteretteerterererereereeeeereee

Na evepyonolnosTe To PIATPO yia va PPEITE TIG ETAIPEIEC NOU ayopacav eKTUNWTR Kal
TauToxpova nNAnpwaoav Aiyotepa and 600 eupw.

Ol ETAIPEIEG AUTEG EIVAL 1vvvviiiiiiiiiiiiiiiiisssissssssssssssssessssseesetteeeteeeeetereeerertererreeereeeereeeeee

Na kAsioeTe Twpa To apxeio AIXQZ va To anobnkeUoETE.

Na TEppATIOETE Kal TNV EQAPUOYT) UNOAOYIOTIKWV QUAAWV.

ApaoTnpIOTNTEG YIA TO ZNiTI

20.

Na ava@épete dUo AOYOUG yia TOucg omnoiou¢ Ba xpnoliponoiouodTte Tagivopnon 1
QIATpApIoHa dedopévwy OE €va PUANO Epyaciag oag;
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®YAAO EPraziAz N.4.1.M6
Ene€epyacia ApIOuNTIKOV AE3OHEVOV

Ti 6a padoupe onpepa:
© Na dnuioupyoUpe TUNOUG
© Na avTiypapoupe TUnouc.

ApaoTnpioTnTeCG EUnédmwong

1.

2.

10.

Na evepYONOINOETE TNV EQAPKOYH UNOAOYIOTIKMV QUAAWV.

Na avoi&ere 1o apyeio FE6_Empty.xlsx To onoio napoucialeTal no katw:

A B C D E F G
1 | Aladiktuakd kardotnua TechOnline
2
3 |Eibog Kéotog TipA rwinong ONA Tehwn tipr Képdog Képbdog %
4 |Tablet APPLE iPad 9.7" 32GB 330 449
5 |Tablet APPLE iPad Pro 64GB 12.9" 764 979
6 |APPLE iPhone X 64GB 900 1199
7 |APPLE iPhone 7 32GB 486 679
8§ |Tablet LENOVQ Tab 2 A10-30 10.1" 16GB 120 159
9 |Tablet MICROSOFT Surface Pro 256GB 1589 1999
10 | Tablet SAMSUNG Galaxy Tab A 7" 8GB 150 189
11 | Tablet SAMSUNG Galaxy Tab 52 9.7" 32GB 381 499
12 |Smartphone LG V30 LTE 674 809
13 |Smartphone SAMSUNG Galaxy Note 8 64GB 738 9499
14
15
16

Na anobnkeUoeTe TO apxeio oTov PAkeAd oag, He To ovoua FE6.xIsx.

>70 keAi D4 va ypayeTe Tov Hadnuatikod TUNo, yia va Bpeite To ®MA Tou Tablet APPLE
iPad 9.7" 32GB. To ®IA icouTail Je Tnv TipA nwAnong €ni 0,19 (=C4*0,19).

Na natrioete To nANkTpo ENTER kai va ypdyeTe TI NnapaTnpeite;

Na emAe€ete TO keAi D4 kal va ypAWeTe TI__NAPATNPEITE OTI YPAPEl OTNV
yEAUUN TUNOU (FOrMUIA BAK); ...oovvviiiiiei i eccctiise s e e e e e eeertaass e e e e s e e e e eeannann e e e e e eeeennnns

Na avTiypdyeTe Tov pabnuaTtikd TUNo nou BpiokeTal oTo keAi D4, aTnv neploxr KENWV
D5:D13.

>Tnv nepioxn kehiwv D5:D13 @aiveTal o idlo¢ apIBPOG nou Paivetal oTo keAi D4;

210 keAi E4 va Bpeite Tnv TeMikn TIMA nou 6a nwAsitar 7o npoiov. H TeAkn TIUA
IoouTal pe To abpoiopa TnG Tipng NwAnong kai Tou GIA.

Na avTiypayeTe Tov pabnuatikod TUno nou Bpioketal oto KeAi E4, oTnv nepioxn KeAImV
E5:E13.
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11.

12.

13.

14.

15.

>T0 keAi F4 va unoloyioete To kEPOOG yIa TO NPWTO NPOIOV. To KEPDOC IooUTal YE TNV
Tign n@Anong nAnv 1o KéoTtog.

>To keAi G4 va BpeiTe To NocoaTd kéEPdou (KEPSOG %). To NoocooTod KEPSOUC IooUTal
He To KEpdog dia Tnv TiuA nwAnong eni 100.

Na avTiypayeTe Touc pabnuaTikouc TUNouUG nou Bpiokovtal ota kehid F4 kai G4 otnv
nepioxn kehiwv F5:G13.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TeEppATIOETE Kal TNV EQAPUOYT UNOAOYIOTIKMV QUAAWV.

ApaoTtnpioTnTeg ASI0AOYNONG

16.

lMa va Bpolpe To ABpoIoHa Tou NepieXopEVOU Twv keAiwv B2 kar €2, ge noia ogipd Ba
Baloupe Ta oUPBOAa yia va €XOUME TO €MIBUPNTO ANOTEAEOWA nou Oa npokUyel ano
Madnuatiko TUNO:

(a) C2
B) +
) =
(0) B2
H owoTn oglpa sivar:

=+ Eninp6o0eTec ApaoTnpiéTnTES

17.

18.

19.

20.

21,

Na evepyonoINoETE TNV EQAPUOYH UNOAOYIOTIKWV QUAAWV.

Na avoifete To apyeio A§IoAdynon.xlsx and Tov pakeAd oac.

Na unoAoyioeTe Tov TOKO nMou divel pia Tpanela OTIC KATABECEIC Twv NEAATWV TNG
apou €QApuooTEi 0 HabnUaTikog TUNoG: Tokog=KepaAaio*EmTokio*Xpovog/365.

Na anoBnkeUosTe TO apxeio oTov (PAkeAd oag pe To Ovopa FE6a.xlsx kai va To
KAEIOETE.

Na TEppATIOETE Kal TNV EQAPUOYT) UNOAOYIOTIKWV QUAAWV.

ApaocTnpIOTNTEG yia TO ZniTI

22,

Ti npa&eic ektehoUv o1 akohouBol ApIOuNTIKOI TEAEOTEG O< £va YnoAoyioTiko DUAo;

+ - E S
/ N
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®yYAnO EPraziaz N.4.1.M7
Ap1OpunTIKEG ZUVAPTNOEIG

Ti 6a padoupe onpepa:
© Na dnuioupyoUue TUMOUG, XPNOILOMOINVTAG TN oUVAPTNON Tou aBpoiouaTtog (SUM)
© Na dnuioupyoUue TUMOUG, XPNOILOMOINVTAG TN OUVAPTNON Tou Hegou Opou (AVERAGE).

ApaoTnpioTnTeCG EUnédmwong

1. Na €vepyornoInoEeTE TNV EQAPUOYH UNOAOYIOTIKWV QUAAWV.

2. Na avoiete 71O apxeio Cyprus Tourists.xlsm and Tov @AkeAd oac.
(ExeTE unpoord oac Tic api&eic ToupioTwv ano 20 XwpeS, ava unva, Tnv rnponyouLEVn
Xpovid.)

3. Na anoBnkeUoeTe TO Apxeio oTov PAKENO 0ac, Pe To ovopa FEZ.xlsm.

4. X710 KeAi B24, va unoloyioete To GUVOAO TwV TOUPIOTWV Nou RPBav anod OAEC TIG XWPES
Tov Iavoudpio.

5. Z10 keAi B25, va Bpeite TOv HEGO OPO TOUPICTWV Nou NEBav and OAEC TIC XWPEG ToV
Iavouapio.

6. Na avTiypayeTte Toug dUO KadnuarikoUg TUMOUC nou OnUIoUpYNodTeE Mo navw, oTnv
nepioxn kehlwv C24:M25, 0OTE va EXOULE TA AVTIOTOIXA NMOCA YIa OAOUG TOUG HNVEG.

7. 210 keAi N3, va unoAoyioeTe To GUVOAO TWV TOUPIOTWV NMou npeav 0Ao Tov Xpovo ano
Tnv EAAGOG.

8. Z10 KeAi 03, va BpeiTe Tov HEGO OPO TOUPIOTWV Nou NpBav anod Tnv EAAGda.

9. Na avTlypayeTe Toug dUO KadnuarikoUs TUMOUC nou OnuIoUpYNodTe nio navw, oTnv
nepioxn keAlwv N4:022, wOTe va £XOUME TA AVTIOTOIXA MOOA YIA OAEC TIC XWPEG.
(Twpa ripenel va EXoULE nANpn EKOva Twv aPiéewv Twv TouploTwv ornv Kurnpo.)

ApaoTnpioTnTeG AE1I0AOYNONG

10. MNa va eAéy&ete TIC Npd&eic oacg, va NaTnoeTe Tov ouvduaopd nAnkTpwv [CTRL +l£l.
O1 anavtnoei nou BOa ed@avioToUv He KOKKIVO XPWHA YPAUHATOOEIpAg eival ol
AavOaopéveg. Na di0pBwOETE TNV NPWTN 0Ag ANAvTNON Kal va TNV avTlypayeTe OTIG
unoAoinec (opilovTiwg | KABETWC, avaioya).

Na ehéy&ete Eava kar &ava TiIC npa&eic oac We Tov idlIo OUVOUAOMO NARKTPWV
(ICTRL +{1!) HEXPI MOU Va PNV £XEl KAPIA andvTnon e TO KOKKIVO XpmUd.
11. 2710 keAi N24, va unoloyioeTe To GUVOAO TWV TOUPIOTWV, ETNOIWC, and OAEG TIC XWPEG.
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r.4.1.mM7 4 Aoyiopiko Eqpappoy®v

12.

13.

14.

>T0 keAi 024 va BpeiTe Tov HETO OPO, ETNOIWC, TWV TOUPIOTWV NoU RPOav anod OAeC TIG
XWPEC.

Na anoBnkeUoeTE TIC AAAAYEC NMOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEPUATIOETE KAl TNV EQAPUOYT UNOAOVIOTIKWV QUAAWV.

“+ Eninpoo0eTec ApaoTnpioTnTEC

15.

16.

17.

18.

19.

20.

Na EVEPYONOINOETE TNV EQAPHUOYN UNOAOYIOTIKWV QUAAWV.

Na avoi&ete To apxeio ApIOUNTIKEG ZuvapTROEIG.xIsX and Tov PAKENO 0dc.
Na anobnkeUoeTe TO apxeio oTov PAkeAOd oag Ke To ovoua FEZa.xlIsx.

>e OAd Ta QUAAG €pyaadiac va KAVETE TOUG unoAoylopoUg yia To oUVOAO 1 Tov HECO
0po, Onou XpelaleTal.

Na anoBnkeUoeTe TIC aAAAYEC NOU KAVATE GTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEPUATIOETE KAl TNV EQAPUOYT UNOAOVIOTIKWV QUAAWV.

ApaoTnpIOTNTEG yia TO ZNiTI

21,

22,

Na OnuIoupynoeTe €va UNOAOYIOTIKO (PUAAO ypa®ovTac KaTtakopupa Ta padnuara
nou dI0A0KEOTE auTn Tn xpovia (Nea EAAnvika, MaBnuarika, TAnpo@opikr, ...). AinAa
and To kaBe pdabnua va ypawete pia apidunTikr) BaBupoAoyia nou vopileTe OTI 0dag
avTINPOCWNEVEl yia KABE padnua (19, 12, 15 ...). TN OUVEXEIA, va UMOAOYICETE TOV
HE€oo0 0po TNC Babuoloyiag oac, XxpnoIKonoIwVTac Trn ouvapTnon nou padaTe onuepa.

Na ONUEIWOETE TO ANOTEAECHA NMOU BPNKATE MO KATW:

MEoog 0pOG: .........
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®YANO EPrazIAZ MN.4.1.M8
ZTATIOTIKEG ZUVapTNOEIC kal Zuvaprnon Keipévou

Ti 6a padoupe onpepa:

© Na dnuioupyoUue TUNOUG, XPNOILOMOIMVTAC TN ouvapTnon Tng katapErpnong (COUNT)

© Na dnuioupyoUue TUMOUG, XPNOIHOMOINVTAG TN OUVAPTNON TNG KaTapeTpnong eav (COUNTIF)
© Na dnuioupyoUue TUNOUG, XPNOILOMOIWVTAC T CUVAPTNON Tou aBpoiouatog eav (SUMIF)

© Na dnuioupyoUue TUNOUG, XpPNOoIJonolnvTag Tn ouvapTtnon Tng evwong (CONCATENATE).

ApaoTnpioTnTeg EUnédmwong

1. Na evepyonoInosTe TNV EQAPLOYA UNOAOYIOTIKWY QUAAWV.

2. Na avoiéete T0 apyeio EknaideuTikn Ekdpopn.xlsx ano Tov ¢pakeAo oac,.

3. X710 keAi D4 va KAveTe EVWON TWV NEPIEXOHEVWV TWV KEAIwV C4 kal B4. ZTn OUVEXEIQ,
va BeBaiwbeite OTI UNAPXEI KEVO PETAEU TOUC.

4. Na avTiypayeTe TOV TUNO Nou dnuioupynoate nio Nnavw, oTnv nepioxn kehiwv D5:D16.

5. X710 keAi M4, va unoloyioeTe To NAROOG TwWV PABNTWV Mou dNAWCAV CUUHETOXA 0TV
ekNaIdEUTIKN EKOPOMI).

6. X710 keAi M5, va unoloyioete To NAROOG Twv PaBNTWV nou €dwoav NPokaTaBoAn yia
TNV EKNAIOEUTIKI) EKOPON.

7. 210 keAi M6, va unoloyioete To MARGOG Twv PABNTWV Mou dnouciaogav and Tnv
EKNAIOEUTIKN EKOPOMI).

8. ZT1o keAi M7, va unoloyioeTe To NARBOG TWV HABNTWV Nou £dwWOoavV WG NPOKATaBoAn
50€ kal navw.

9. 370 KeAi M8, va unoloyioeTe To NAROOG TWV PABNTWV Nou £xouv UNodAoINo KATw and
70€.

10. 3T0 keAi M9, va unoloyioeTe TO @OpoIoCHa TwV XPNHATwV nou d0nkav wcg
npokataBoAr) aA\d fTav ioa r nepioodTepa and 30€.

11. 210 keAi M10, va unoloyioeTe To ABPOICHA TWV XPNUATWV NOU NPENEI Va ENIOTPAPOUV
OTOUC JaBnTEC NOU anouaiaoav eve gixav dwaoel NpokaTaBoAn.

12. Na anoBnkeUoeTe TO apxeio oTov pAkeANO oac, pe To ovoua FE8.xIsx.

ApaoTtnpioTnTeg ASI0AOYNONG
13. 310 keAi M11, va unoloyioeTe To @OpOICHA TwV XPNUATWV Mnou JOBNKav g

npokataBoAn and Toug pabnTe.
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r.4.1.Ms 4 Aoyiopiko Eqpappoy®v

14.

>T0 keAi M12, va unoloyioeTe To NARBOG Twv PadnTwv nou £dwaoav NpokaTaBoAn 0Ao
TO N0go0.

15. >10 keAi M13, va unoloyioete To NARBOG Twv PadnTwv nou AEN gE6pAncav To noco
TNV NHEPA TNG EKSPOUNG.

16. 310 KeAi M14, va unoloyioeTe To aBpoiopa Twv XpnuaTwv nou AEN eEo@AnBnke Tnv
NHEPA TNG EKOPOING.

17. 210 keAi M15, va unoAoyioeTe To NARBOG TwWV PABNTWV NOU TENIKA QUUUETEIXAV OTNV
EKNAIDEUTIKN EKOPOUN.

18. Na anoBnkeloeTe TIGC AAAAYEG NMOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

19. Na TeppaTioETE Kal TNV EQAPPOYN UNOAOVYIOTIKWYV QUAAWV.

“+ Eninpoo06eTec ApaoTnpioTnTES

20. Na evepyonoInoeTe TNV £QAPUOYN UNOAOYIOTIKWV PUAAWV.

21. Na avoifeTe To apxeio ZTATIOTIKEG ZUvapPTNOEIG.XxIsx and Tov PakeAd oag.

22. Na anoBnkeUoeTe TO apxeio aTov PpAkeAd oag, e To ovoua FE8a.xlIsx.

23. e OAd Ta QUAAG €pyaciag, va KAVETE TOUG UMOAOYIOHOUG yia TNV KATAMETPNON €AV 1)
Tou a@poiopaTog €av, onou xpeialeral.

24. Na anoBnkeUoeTe TIC AAAAYEG MOU KAVATE OTO APXEIO 0AG KAl VA TO KAEIOETE.

25. Na TeppaTioeTe Kal TNV EQAPUOY UNOAOYIOTIKWV QUAAWV.

ApaocTnpIOTNTEG yia TO ZNiTI
26. Na ava@epete dUO AOYoug yia Toug onoioug Ba XpnoidonoloUoaTe MWia onoladnnoTe

OTATIOTIKN OUVAPTNON 1] CUVAPTNON KEIMEVOU O€ £va PUANO £pyaociag oag;
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®yAano EPraziaz r.4.1.M9
AOYIKEG ZUVAPTNOEIG

Ti 6a padoupe onpepa:

© Na dnuioupyoUpe TUNOUC, XpnoidonolwvTac Tn Aoyikn cuvapTtnon Kai (AND)
© Na dnuioupyoUue TUMNOUG, XpnoidonolnvTag Tn Aoyikn cuvaptnon ‘H (OR)

© Na dnuioupyoUpe TUMOUG, XpnoidonolwvTac Tn Aoyikn ocuvaptnon Eav (IF).

ApaoTnpioTnTeCG EUnédmwong

1. Na €vepyornoInoEeTE TNV EQAPUOYH UNOAOYIOTIKWV QUAAWV.

2. Na avoitete To apyeio Cyprus Tourists 2.xIsm and Tov pakeAd oag,.
3. Na anoBnkeUoeTe TO Apyeio oTov PAKENO 0ac, Pe To ovopa FE9.xlsm.

4. 70 keAi B26, va avaypa@etal n Ae€n NAI, av To oUVOAO TwV TOUPIOTWV ano OAEC TIG
Xwpec (kehi B24) Tov Iavoudpio eival peyaAUtepo and 100000, os avTiBeTn nepinTwon
va avaypagetai n AeEn 'OXI.

5. Na avTiypayete Tov TUNO nou dnpIoupynoaTe nio Navw, otnv nepioxn kehiwv C26:M26,
WOTE VA £XOUKE TA AVTIOTOIXA AnoTEAEOUATA Yia OAOUC TOUG HIVEC.

6. ZT0 KeAi P3, va BpeiTe TIG XWPEG NOU NETUXAV KAl TOUG dUO OTOXOUG nou PBaAape
oTnv apxn Tou xpovou kal Ba epgaviCel Tnv Tiun TRUE (dnAadr, To OUVOAO TwV
TOUPIOTWV €TNOIWC anod Tnv EAAGda (kehi N3) va eivar yeyaAUtepo and 500000 kai,
TQuTOXPOVa, O MECOC OPOC TWV TOUPIOTWV ETNCIWG and Tnv EAAGda (kehi O3) va eival
heyaAuTepo and 15000).

7. Na avTiypayeTte Tov TUNO nou dnuIoUpYNoaTe Nio NAvw, oTnv nepioxn keAiwv P4:P22,
(WOTE VA £XOUKE TA AVTIOTOIXA AMOTEAECHATA YIA OAEG TIG XWPEG.
H XWpa nou NETUXE KAl TOUG DUO OTOXOUG EIVAL .uvveererrrrrrrrnsssseeseseersssssssssseeeeseeessssnnnnns

8. 2710 keAi Q3, va PpeiTe TIG XWPEG NOU NETUXAV TOUAGXIOTOV TOV £€vav OTOXO MOU
BaAape oTnv apxn Tou xpovou kai Ba epgavilel Tnv Tiu TRUE (dnAadr), To oUvoAo Twv
TOUPIOTWYV, £TNCIWG, and Tnv EANada (kehi N3) va eival peyaAuTtepo and 500000 R o
MECOC OPOC TWV TOUPIOTWV, ETNCIWG, anod Tnv EAAGda (keAi O3) va eival peyaAUTepo ano
15000).

9. Na avTiypayeTte Tov TUNO Nou dNMIOUPYROATE N0 NAvw, oTnv nepioxn keAlwv Q4:Q22,
WOTE VA €XOUME TA AVTIOTOIXA AMOTEAECHATA YIA OAEG TIG XWPEG.
O1 XWPEC NMOU NETUXAV TOUAAXIOTOV TOV EVAV OTOXO EIVAI vvvverererrrrrnnniieessereersssnnnneeeeeens

10. Na anoBnkeloeTe TIG AAAAYEG NMOU KAVATE OTO APXEIO 0AC KAl va TO KAEIOETE.
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ApaoTtnpioTnTeg ASI0A0YNONG

11.

12.

13.

14.

Na avoifete Eava To apyeio FE9.xIsm ano Tov pakeAd oac.
Na anoBnkeUoeTe To apxeio aTov PAkeAOd oac, Pe To ovoua FE9a.xIsm.

>10 keAi R3, va avaypdgetal n Aé€n NAI, av To oUVOAO TWV TOUPIOTWV, £TNCIWC, Ano
v EMGda (kehi N3) eivai peyaAUtepo and 100000, o€ avTiBeTn nepinTwon va
avaypageral n Ae€n 'OXI.

Na avTiypdyeTe Tov TUMO nou dnMIOUPYNOATE N0 NAvVw, OTnV neploxr keAiov R4:R22,
WOTE VA EXOUME TA AVTIOTOIXA ANOTEAEOHATA YA OAEG TIG XWPEG,

+ Eninpoo0erec ApaoTnpidTnTEG

15.

16.

17.

210 keAi N25 va avaypagetal n epdon KAAOYTZIKOZ O ®ETINOZ TOYPIZMOZ, av
To GUVOAO TWV TOUPIOTWV, £TNCIWG, ano OAeG TIG XWpPeC (keAi N24) eival peyaAuTepo
ano 1500000, og avTiBeTn nNepinTwaon va avaypagetal n ¢pacn XAAIA O ®ETINOZ
TOYPIZMOZ.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TeEppATIOETE Kal TNV EQAPUOYT) UNOAOYIOTIKWV QUAAWV.

ApacTnpIOTNTEG yia TO ZniTI

18.

19.

>TO UNOAOYIOTIKO (PUANO Mou dNUIOUPYNOATE O€ MPONYOUWEVO UAdnUa oTo ONiTl 0ag HE
Ta padnuarta kai TiIc Babuoloyieg, va Bpeite o noia pabnuarta n Babuoloyia oag sivai
IkavonoinTikr. AinAa and Tnv kaBe PabuoAoyia va epgavietar n @paon
IKANOMOIHTIKH BAGMOAOrIA, av o Babuodg eival peyahuTtepog ano 15, av oxi, va
epgavitetal n epacn MH IKANOMOIHTIKH BAOMOAOrIA.

To apxeio autd va To OTeiAeTe oOTov/OTNV kKABNYnTH/TPIG Oag pe E-Mail, yia va
BabuoloynBeiTe.
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®dyAn0 EPraziaz r.4.1.M10
OIKOVOHIKEG ZUVAPTNOEIG

Ti1 6a paboupe onpepa:

© Na dnpioupyoUpe TUMOUG, XPNOILOMOIWVTAG TN CUVAPTNON TN ONUEPIVNG agiag (PV)

© Na dnuioupyoUue TUMOUG, XPNOIHOMOINVTAG TN ouvapTtnaon TngG MeAovTikNnG agiac (FV)

© Na dnuioupyoUpe TUMOUG, XPNOILOMOINVTAG TN oUvVAPTNON TNG NANPWHNRG/d0ong (PMT)

© Na dnuioupyoUpe TUMOUG, XPNOILOMOINVTAG TN ouvapTNnon Tou enitokiou (RATE)

© Na dnuioupyoUue TUMOUG, XPNOIHOMOINVTAG TN ouvapTnaon Tou apiBpol Twv doccwv (NPER).

ApaoTnpioTnTeg EPnédmong

1. Na evepyonoInosTe TNV EQAPLOYN UNOAOYIOTIKWV QUAAWV.

2. Na avoieTe To apyeio Functions.xlsx ano Tov ¢pakeAo oag,

3. ZT0 KkeAi C8 Tou PUANoU epyaciag Payments, va unoAoyiosTe To Nogd NANPWUNAG/d00NG
(PMT) k@be pnva yia €va oTeyacTiko daveio Uyoug 180.000 eupw, unobnkelovTag
¢va oniTl yia 30 xpovia, Pe ETAOIO €MITOKIO 6%. H oTabepr) nAnpwyr) Ba yiverar oTnv
apxn Tou kde pnva.

4. X710 KeAi I8 Tou PUA\OU epyaciac Payments, va unoloyioeTe To nood NANpwung/doong
(PMT) k@Be prva yia pia mMOoT®TIKA KAPTa nou To unoAoind Tng eival 5.400 eupw kai
TO £TNOIO €MITOKIO 17%, €Gv ANONANPWOETE TO NOCO OE 2 Xpovia (Na uroBeoeTe 011 OV
Ba undpéer dAAn xpewon o€ auTov To Aoyapiacuo kard Tnv anonAnpwr Tou).

5. 210 kehi C17 Tou @UAoU epyaciac Payments, va unoloyioete TO nN00O
nAnpwung/doong (PMT) kdBs priva yia €éva Avelio auToKIViTou Uywoug 19.000 supw,
ME XpOvo anonAnpwing Ta 3 Xpovia Kal PE ETNOI0 ENITOKIO 2,9%.

6. 2710 keAi J17 Tou QUAMoOU epyaciag Payments, va unoloyioeTe To N00O ANOTAWIEUONG
(PMT) kd@Be pnva yia pia anorapieuon yia onoudeg Uwoug 60.000 cupw ot évav
TpaneQikd Aoyapiacpd, pe Xpovo anonAnpwpng Ta 18 xpovia kai Pe €TAAI0 ENMITOKIO 6%.
H onuepivn aia ivar undév kai n peAAovTikn agia 60.000 upw.

7. 210 keAi C8 Tou PUAou epyaciac Number of Periods, va unoloyioste Tov apiBud Twv
d06oewv (NPER) nou 6a XPeIAoTEITE yia va AnonAnpwoeTE £va NPOCWNIKO SAVEIO
Uyoucg 2.500 gupw, oTo onoio Ba NAnpwveTe 150 Eupw TOV WRvd, YE ETAOIO EMITOKIO 5%.

8. X710 KkeAi C8 ToU QUANoU epyaciag Present Value, va unoloyioeTe To Nood apxIKAG
kataBeonc (PV) nou xpeialeTal, woTe va anoTaieuoeTe 60.000 supw yia TIC OMOUDEG
Tou naidiou oacg, padi e kanolo Noco nou Ba BaAeTe gogic, oc 18 xpodvia, pe dooeig 100
EUPW TOV WNVa Kal ETACIO EMITOKIO 6%.

9. 310 KkeAi C8 Tou pUANoU epyaciac Future Value, va unoloyioeTe To nogd PeANOVTIKAG
agiac (FV) nou Ba &xete og 10 pnveg, eav &ekivnoeTe e 500 eupw oTovV Aoyapiacpod oag
Kal kataBéTete 200 €upw TOV PvVa, ME ETROIO €NITOKIO 6%, YIa va KAVETE TIC OIAKOMEG
TWV OVEIpWV 0ac.
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r.4.1.M10 4 Aoyiopiko Epappoy®v

10. Na anoBnkeUoeTe TO apxeio oTov (PpAKeNO oac, pe To ovoua FE10.xlIsx.
ApaoTnpioTnTeG ASI0AOYNONG

11. ZT10 keAi D8 Tou PUAoU epyaciag Payments, va unoAoyioeTe To nood nAnpwung/ddong
(PMT) kdBe pnva yia &va orteyaoTiko davelo Uywouc 180.000 eupw, unoBnkeuovTag
éva oniti yia 30 xpovia, Ye €TACIO EMITOKIO 6%. H oTaBepr) nAnpwyr) Ba vivetar oTo
TEAOG ToU KABE prva.

12. Z10 keAi K8 Tou UANOU epyaciac Payments, va unoAoyioeTe To Nogd nAnpwunc/déong
(PMT) kd@Be prva yia dia mIOTWTIKA KAPTA, Nou To undoino Tng sivai 5.400 supw Kai
TO €TNOI0 EMITOKIO 17%, €Gv ANONANPWOETE TO NOCO € 4 XPovid.

13. 210 keAi D17 Tou @UMouU epyaciac Payments, va UMoAoyioETE TO N0CO
nAnpwung/doong (PMT) kGBe prva yia eva daveio auTokiviTou Uyoug 19.000 supw,
ME XPOVO anonAnpwung Ta 5 xpovia kai Pe €TNOI0 ENITOKIO 2,9%.

14. Na anoBnkeUoeTe TIGC aAAayEG NoU KAvVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

+ Eninpoo0eTec ApaoTnpidTnTEG

15. Na avoi&ete Eava 1o apxeio FE10.xIsx ano Tov pakeAd oac.

16. Na anoBnkeloeTe TO apxeio aTov PAkeAO oac, pe To ovoua FE10a.xlsx.

17. Z10 keAi D8 ToU UANOU epyaciag Future Value, va unoloyioeTe To Nogd PUEANOVTIKAC
a&iac (FV) nou Ba &xete o 10 prveg, €av Eekivijoete e 0 eupw oTOvV Aoyapiacpod oag
Kal kataBéTete 200 eupw TOV MAva, ME ETNOIO ENITOKIO 6%, YIa va KAVETE TIC OIAKOMEG
TWV OVEIpWV 0ac.

18. 210 keAi I8 TOoU QUANOU epyaciac Present Value, va unoAoyioeTe TOo NogO ApXIKNG
kataBeonc (PV) nou xpeialeTal, woTe va anoTapieuoeTe 6.500 eupw yia TIC dIAKONEC 0ag
o€ 3 xpovia Je dooeig 115 supw Tov Wrva Kal ETROI0 EMITOKIO 6%.

19. Na anoBnkeUoeTe TIG aAAayEG Nou KAvaTe OTO APXEIO 0AC KAl VA TO KAEIOETE.

20. Na TeppaTioeTe Kal TNV EQAPUOYN UNOAOYIOTIKWV QUAAWV.

ApaoTnpIOTNTEG YIa TO ZNiTI
21. Na avagépete  yia noilov  Aoyo 6Ba  xpnoigonoioUodTe  pia  onoladnnoTe

XPNHATOOIKOVOHIKI ouvApTNOoN o< €va PUANO £pyaaiag oag;
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®vAnO EPraziaz N.4.1.M11
Anpoupyia ka1 Mopgonoinon MNpa@nuarewv

Ti 6a padoupe onpepa:
© Na dnuioupyoUUE ypa®nuarta
© Na Jop@onoIoUUE Kal va TPOronoloUUE ypagnuara.

ApaoTnpioTnTeCG EUnédmwong

—

Na evepYONOINOETE TNV EQAPKOYH UNOAOYIOTIKMV QUAAWV.

Na avoi&ete To apyeio Fpa@npaTa.xlsx anod Tov PAkKeAd odc.

Na anoBnkeUoeTe TO apxeio aTov PAkeAOd oag, He To ovoua FE11.xIsx.

Na unoAoyioeTe Ta ouvoAa oTnv nepioxn keAiwv, anod F4:F7.

Na avTiypayete To PUANO epyaciac Sheetl oTo pUAO epyaociac Sheet2.

Na peTovopdaoceTte To PUAANO epyaciac Sheet2 oc Fpagnua PaBdou kai ZTHANG.

Na dnuIoupynosTe €va ypagnua, sniléyovrag tnv nepioxr kellwv A3:E6, Ye Ta nio
KATW XAPAKTNPIOTIKA:

(@)
(B)
(v)

(6)

Na emAé€eTe TUNO ypapnuaToc PaRdou Bar (Clustered bar in a 2-D).

Na npooBeoeTe Tov TiTAO: Inter-company S.A.

Na epapupoceTe oTov TiTAO: ypauuaTtoosipd Tahoma, peyeboc 21 oTiyp®@V Kal
XpWHa 0Ta ypdupaTa PnAE oKoupo.

Na epappocete oto unouvnua (Legend): ypaupatoceipd Comic Sans MS,
peyeboc 11 oTIYH®V, XpWHA 0TA ypAuudTd HNAE OKOUPO Kal e oKiaon XpwudaTog
NOPTOKAAI.

Na HETAKIVAOETE TO YpAPNHa KATw anod Tov nivaka odg,

Na dnuioupynoeTe akoun €va ypa@nua, emieyovrag Tnv nepioxn kehiwv A3:ES, pe Ta
Mo KATW XAPAKTNPIOTIKA:

(@)
(B)
(v)

(%)

Na eniAé€eTe TUNO ypapnuaToc 3TAANG Column (3-D Clustered column).

Na npoofeoete Tov TiTAo: KardaoTaon Ayopmv kai MANcEwv.

Na epapuoosTe oTov TiTAO: ypauupaTtoosipd Verdana, peyeboc 16 OTIyHOV,
XpWHa 0Ta ypduuaTd MNAE OKOUPO Kal E OKiaon XpWUATOC NPACIVO AVOIKTO.

Na epappocete oto unouvnua (Legend): ypappatoosipd Comic Sans MS,
pEyebog 11 oTIYHAV, XpWHA OTA YpAuUaTd HNAE OKOUPO Kal [E OKiaon XpwUATog
NOPTOKAAI.

10. Na PeTaKIVAOETE To 2° ypapnua oTa €&1a Tou 1°° ypapruaToc.
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11. Z€ noIo TPIUNVO EXOUHE TIC NEPICOOTEPEC NWANTEIC;

12. 3£ NoIO TPIUNVO EXOUNE TIC NEPIOOOTEPEC AYOPEC;

13. Na anoBnkeloeTe TIC aANAQYEC NMOU KAvATE OTO ApXEIo 0ac.

ApaoTtnpioTnTeg ASI0AOYNONG

14. Na avTiypayete To pUANO gpyaciac Sheetl oTto pUANO epyaciac Sheet3.

15. Na petovopdosTe To GUANO epyaciac Sheet3 os Fpagnua Mitag kai FpappnG.

16. Na dnuioupynoeTe £va veo ypa@nua, eNAEyovTag Tnv nepioxn kehiwv A3:B6, pe Td nio
KATW XAPAKTNPIOTIKA:

17.

18.

(@)
(B)
(v)

(6)

(e)

Na emiAéEeTe TUNO ypaonuatocg Mitac Pie (Exploded pie in a 3-D).

Na aM\a€ete Tov TiTAO Oc: Katraoraon Ecodwv ka1 EE03wv A™ Tpipfnvou.

Na epappocete oTov TiTAO: ypauuaTtoosipd Tahoma, peyebog 12 oTiypwv Kai
XpWa oTa ypdupaTd MNAE oKoUpo.

Na e@appooete oto unopvnua (Legend): ypappatoosipd Comic Sans MS,
pEyebog 11 oTIyH®V, XpWHA 0TA ypapuaTa HNAE OKOUPO Kal € oKiaon XpwUATog
KiTpIVY.

Na aA\a&ete To oTuA Tou oxnuatog (Shape Styles), eniAéyovTag yia To kABe TUNEA
TOU YPpa®nHaTog kal €va dIapopETIKO OTUA.

(oT)Na yepioste (Shape Fill) To kGbe TUAUa Tou ypa®niuaTog We dIAPOPETIKO XpwHa

NG dIKNG oag enIAoync,.

Na HETAKIVAOETE TO YpAPNHa KAT® anod Tov nivaka odg,

Na dnuIoUpYNOETE €va veo ypa@nua, emAeyovrag Tnv nepioxn kehiwv A3:E6, Ue Ta nio
KATW XapakTnpIoTIKA:

(@)
(B)
(v)

(%)

Na eniAéEeTe TUNO ypanuaTog Mpapung Line (Line with Markers).

Na npooBsoeTe Tov TiTAO: AvaAuon NMwANocswv.

Na epappooeTe oTov TiTAO: ypaupaTtoosipd Verdana, péyebog 24 oTIYH®OV, XpwUd
oTa ypduuata HNAE okoUPO Kal e OKiaon XpwpaToc MMAE.

Na epappocete oto unouvnua (Legend): ypaupatoceipd Comic Sans MS,
pEyebog 11 oTIYH®V, XpWHA 0TA ypapudTd HNAE OKOUPO Kal |E oKiaon XpwUaTog
NOPTOKAAI.

19. Na PeTAKIVAOETE TO 2° ypdpnua oTa d€&1a Tou 1°° ypapruaToc.

20. Na anoBnkeUoeTe TIC AANAYEC MOU KAVATE OTO APXEIo 0ac.
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“+ Eninpoo0eTec ApaoTnpioTnTES

21

22,

23.

24,
25.

. Na eniAé€eTe To ypagnua pe Tov TiTAo: AvaAuon NMNwARCEwWV.

Na npooBéoete Tov TiTAO: Year 2012 0TO KATW WEPOC TOU, KATA MNAKOG G&ova
(Primary Horizontal Axis Title).

Na epapuoosTe oTov TiTAO: ypaupaTtoosipd Comic Sans MS, péyefoc 12 OTIYH®V,
XpWua 0Ta ypaupuata HNAE okoUPO Kal e OKiaon XpWHATOC AVOIKTO NPAacivo.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEppATIOETE Kal TNV EQAPUOYT UNOAOYIOTIKMV QUAAWV.

ApacTnpIOTNTEG yia TO ZniTI

26.

Na enNé€eTe Tnv kaTAMnAn A€EN 1 NpdTACN KAl va OUUNANPWOETE TA KEVA OTIG
napakaTw npoTdcelg, Je Tn Ponbeia Twv ypauudTtwy (a, B, Y, 8, € oT, ) Tou Mo KATW
Ypapnparog:

[IEPIOXT} VPaPUATOC, MEPIOX OXEOIaonc, déovacg, unouvnua, TiTAOG, ETIKETA OE00OUEVWY,
onuEia OEOOUEVWY, OEIPd OEOOUEVWV

@ @Im)\ﬂoatg Avatolwkng Aciag
35.000 T;gxg\(:;;@
®

(a) H

(B) H TOU YPAPAHATOC.

(y) Ta ™G nou
oxedialovTal oTo ypapnua.

(d) O opifovTiog (kaTnyopia) kal 0 kKaTakopuPog (TIKNA) KaTa PAKOG TWV
onoiwv oxedialovtal Ta dedopEVaA aTo ypapnua.

() To TOU yPapnuaToc.

(oT)'Evag YPa®AKaTog kal a&ova nou WMOPEITE va XPNOILOMOINOETE
OTO YPAPNHA.

(O) Mia Mou WMOpPEITE va XPNOILOMOINCETE, yia va

NPOCJIOPICETE TIC AENTOUEPEIEG EVOC ONHEIOU DEDOUEVWYV OE Hia OeIpa OEDOPEVV.
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®YAAO EPrazIAZ M4.1.M12
Anpoupyia ka1 Mopgonoinaon Npa@nuarenv

Ti1 6a padoupe onpepa:

© Na puBpifoupe TIC NAPAPETPOUG YPAPNHATWOV

© Na aA\aloupe Tov TUNO YPAPrUATOC

© Na aA\aloupe To péyedog Kal Tn B£on TwV YpapnuaTwy.

ApaoTnpioTnTeC EUnédmwong

10.

11.

12.

13.

14.

15.

16.

17.

18.

Na evepYONOINOETE TNV EQAPKOYH UNOAOYIOTIKMV QUAAWV.

Na avoifete To apyeio Charts.xlsx and Tov ¢akeAd oag,.
Na anobnkeUoeTe TO apxeio aTov (PAkeAd oac, Pe To ovoua FE12.xlIsx.
Na eniAéEeTe To [pdenua 1 kal va To avTiypayeTe o1o GUANO epyaciag ZEAIAA 1.

Na aA\d&eTe TIC SIAOTACEIG TOU YPAPNHATOG, £TOI WOTE VA KAAUNTEI 00O MEPIOCTOTEPO
KEVO XWPO YIVeTal.

Na aA\aG&eTe Tov TiTAO TOU ypagpnuatog ano Mpagnua 1 oc ZuvoAikég NMwANCEIG.
Na kavete To unopvnua va MHN spgaviletal oTo ypagnpua.

Na aMa€ete To oTul Tou ypapnuatog (Chart Styles) o€ eva Tng apeokeiag oag,.

Na epapudosTe XpWwHATa TNG apeokeiag oag otnv Nepioxn >xediaong (Plot Area) kai
otnv Nepioxn Fpagnuarog (Chart Area).

Na petaBeite Twpa oTo PUAO epyaciac APXIKH.
Na ermAéEeTe To [pdgnua 2 kai va To avTiypayeTe o1o QUANO epyaciac ZEAIAA 2.

Na aAAa&eTe TIC B1IAOTACEIG TOU YPAPNHATOC, £TOI WOTE va KAAUNTEI 000 NEPICOOTEPO
KEVO XWPO YiveTal.

Na aA\a&ete Tov TiTAO Tou ypagpnuaToc and Fpagpnua 2 os Karaoraon Ayopmv Kai
MNwANRocewv.

Na aMda€ete Tn O€on Tou UMOWVAUATOC, £TOI WOTE va €PPAVIETAl KAT®W and To
ypaenua kai ‘'OXI ota de&id 6nou BpiokeTal.

Na aM\a&ete Tov TUNO Tou ypagnuatoc o€ 3-D Clustered Column.

Na eppavioeTe Twpa TIC ETIKETEG (Data Labels) Tou ypagripaToc.

Na aMagete To oTUA TV eTIKETWV (Shape Styles) o€ £éva Tng apeokeiag oag.

Na anoBnkeUoeTe TIC aAAAYEC NOU KAVATE GTO APXEIO 0ac.
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ApaoTtnpioTnTeg AEI0AOYNONG

19.

20.

21,

22,

23.

24.

25.

26.

Na petaBeite Twpa aTo PUAO epyaciac APXIKH.

Na enmAé€eTe TO TeheuTtaio CPAPNUA Kal va TO AVTIYPAWETE OTO QUANO €pyaaiag
ZEAIAA 3.

Na aA\GEeTe TIC B1IAOTACEIG TOU YPAPKATOC, £TOI WOTE va KAAUNTEI 60O MEPICTOTEPO
KEVO XWPO YIVETal.

Na npooBéoeTe yia TiTAO Tou ypagruatog To Karaoraon Ecodwv kai EE03wv.
Na aA\aGEeTe To HEYEBOG TNG YPAPMATOOEIPAG TOU TITAOU O€ 28 OTIYHEG.

Na aA\GEeTe kal TO XPWHA TOU TITAOU 05 OKOUPO HNAE.

Na EpPAVIoETE TWPA TIC ETIKETEG TOU YPAPAHATOG.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO 0aC,

“+ Eninpoo06eTec ApaoTnpioTnTES

27.

28.

29.

30.

31.

32.

Na petaBeite Twpa oTo PUAO epyaciac EMINMPOZOETH.

Na dnuIoUpyNoETE €va VEO ypa@nua, enAeyovtag Tnv nepioxn keAiwv C4:D7, Tunou
Clustered Column.

Na kavere To unopvnua va MHN spgaviletal oTo ypagnpua.
Na npooBeoeTe yia TiTAo Tou ypagruatog To EEOMNAIZMOZ AIOOYZAZ.

Na enAeEete MONO To npwTo onpeio dedoPEVWV Nou Napoucialel TIC KAPEKAEG,.

‘Eneita, va ePPavioeTe TIG 1I010TNTEG Tou (A&&i kAik kar peTta Format Data Point...) kai
va gUPNANPWOETE TIG IDIOTNTEG, ONWG PaAiveTal MO KATW OTNV €IKOVA:
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33. MNa ewTtoypagia, va eniAéEeTe Tnv eikova Chair.png nou €ival kal To NPWTO ONWEio
OedoUEVWY TOU YPAPRKATOG, anod Tov PAKeAd oac.

34. Me Tov idlo Tpono, 6nwc ota BApara 30 pEXP! 32 nio Navw, va TPOMOMNOINCETE TIC
ID10TNTEG Kal TWV UNOAOINWV Onueiwv ODOPEVWV (Bpavid, EKTUNWTES, UMOAOYIOTEC),
avTigToixa:

Twpa To IKOVOypaua 6a rpenesl va LoIdee! nePIou onwce To 1o KaTw.

35. Na anoBnkeUoeTe TIG aAAAYEC NOU KAVATE OTO APXEIO 0AG KAl va TO KAEIOETE.

36. Na TepuaTiosTe kal TNV €QAPUOYN UNOAOYIOTIKWV QUAAWV.

ApaoTnpIOTNTEG yia TO ZNiTI

37. Na ava@epeTe dUo AOYOUG yia Toug onoioug Ba xpnoidonoiouoaTe ypa@nuara oc va
(UAN\O epyaociag oag.
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®yano EPraziaz r.4.1.Mm13
Anpioupyia Zevapinv

Ti 6a padoupe onpepa:

© Na dnuioupyoUE €va osvapio

© Na npoBdaAhoupe, va d10pBwvoue kal va diaypdpoulE Eva oevapio
© Na dnuioupyoUpe pia ékBean oegvapiou.

ApaoTtnpioTnTeG EPnédmong kai AZIoAoynong

1. Na €vepyornoInoEeTE TNV EQAPUOYH UNOAOYIOTIKWV QUAAWV.

2. Na avoiéete To apxeio Mnviaiog npoinoAoyiopoc.xIsx anod Tov PAKeAd adc,

3. Na anoBnkeUoeTe To apyeio oTov PpakeAd oac, Ye To ovopa FE13.xlIsx.

4. Na dnuIoUpYNOETE Eva OEVAPIO yia TNV nepioxn keAlwv B4:B7 (Ta keAid Ta onoia Ba
heTaBaMovTal yia Ta didgopa oesvapid) yia TOV TPEXOVTA Mnvidio npolnoAoyiopo
Aeiroupyiag Tng ABC Company Ltd, pe To 6voua TpEXwv npolinoAoyioHOoG.

Znueinon: AnuioupywvTag dia@opa oevapia, Ba dlanioTWOETE NWE ennpealeTal o
AEITOUPYIKOG npoUnoAoyiopoc and Tnv aAlkayrn) Tou nooooToU XPpewong O1apopwv
UNNPECIWV NPOG TOUG NEAATEG TNG TAIPEiag oag,

5. Na OnuIoupynoeTe €va VEO OEvVAPIO yia Tnv nepioxn kehliwv B4:B7, pe 1O Ovopa
AUENnON €pyaTikwy, e véa TR To €12400, oTo nAaiolo Epyaoaia.

6. Na OnuIoUpynoOeTE €va VEO OEVAPIO yia Tnv nepioxn kehlwv B4:B7, pe 1O Ovopa
AUENnon UAIK®V, e vea TIPn To €250, oTo nAdiolo YAIKA.

7. Na OnuIoupynosTe €va VEO OEVAPIO Yid Tnv neploxn keAiwv B4:B7, pe 1o Ovopa
AUEnon napaywyng, K véa Tiun 1o €150, oTo nAaicio Napaywyn.

8. Na dnuioupynoeTe €va vEéo OevaAplo yia Tnv nepioxn kehiwv B4:B7, pe To Ovoua
AUEnon odoinopikwyv, e véa TIUA To €500, oTo nAaiolo Odoinopikd.

9. Na dnuIoUpYNOETE pia ouvonTiKr €KOEON OAWV TWV CEVAPIWV 0AC, YId VA OUYKPIVETE
£T01 TNV €NidOPACT TWV CEVAPIWV MOU EXETE OTO PUAANO £pyaciag oac, o€ €va JOvo pUANO
€pyaoiag.

10. Na anoBnkeloeTe TIC aANAYEC MOU KAVATE OTO APXEIO 0AC KAl va TO KAEIOETE.

11. Na TepATIOETE KAl TNV EPAPUOYT) UNOAOYIOTIKWV QUANWV.

“+ Eninp6o0eTec ApaoTnpioTnTES

12. Na evepyonoInoETE TNV EQAPHOYN UNOAOVYIOTIKWV QUAAWV.

13. Na avoi&eTe Eava 1o apxeio FE13.xIsx ano Tov ¢pakeAd oac.
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14.

15.

16.

17.

18.

19.

Na anoBnkeUoeTe TO apxeio oTov PAkeAOd oag, Ke To ovoua FE13a.xlsx.
Na diaypdyeTe TO OEVAPIO LE TO OVoua TPEX®WV NPOUNOAOYICHOG.

Na d10pBwoseTE TO OEVAPIO e TO Ovopa AUENON UAIK®V, PE vEa TP To €258, oTo
nAaiolo YAIkd.

Na OnuIoUpYNnOETE akOWn Hia OuvonTiKy €kOgon OAwv Twv Cevapinv odc, yia va
OUYKPIVETE £TOI TNV €NIdPACN TWV CEVAPIWV MOU EXETE OTO PUANO £pyaciag oac, os &va
MOVO (PUANO epyaaiac.

Na anoBnkeUoeTe TIC AAAAYEC NMOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEPUATIOETE KAl TNV EQAPUOYT UNOAOVIOTIKWV QUAAWV.

ApaoTnpIOTNTEG yia TO ZNiTI

20.

Na ava@epeTe dUo Adyoug yia Toug onoioug Ba XpnoidonolouodTe &va OEVAPIO O€ €va
QUAN\O epyaociag oag;
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®YAAO EPrazIAzZ MN4.2.M1
AnoOnkeuon Apxeiwv os pdf popen

Ti1 6a paboupe onpepa:

© Na Onuioupyoups apxeio PDF and u@IOTAPEVO apyeio €ne€epyaciac KEIMEVOU, UMOAOYIOTIKOU
(PUAN\OU Kal Napouciaocewv

© Na pubuifoupe diagpopec enihoyec dnuioupyiac pdf apxeiwv.

ApaoTnpioTnTEG EPnédmong

1. Na oupnAnpWOETE OTOV Mivaka nou akoAouBei, To Npoypauua nou Ba xpnoiyonoindei yia
TO Avolypa Tou kaBevog and Ta akoAouba apyeia.

Apxeio Mpoypappa Nou avoiyel To apyeio

2. Na avoiete To apyeio Ergasia.docx. lMoio npoypappa €xel evepyonoinbei katd To
avolyua Tou;

3. Na anoBnkeloeTe To apxeio pe To ovoua Ergasial, oc TUno pdf, otov ¢pdkeAd oac.

4. Na petaBeite oTov PAKEAd oac. TI NapaTnpeite 6oov apopd OTo €IKOVIOIO TOU apxeiou
rMou €XETE anobnkeUoel;

5. Na avoifete 10 apxeio Ergasial.pdf kal va ypdyeTe To Ovoua Tou NpoypdupaToc nou
XPNOIKOMOINONKE yia TO AVOlyHa Tou.

6. Na avoifeTe To apxeio pe ovopa Parousiasi.pptx. Molo npoypappa €xel evepyonoindei
KaTa 1o avolyua Tou;
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7. Na anobnkeloeTe To apyeio e ovopa Parousiasil, oc TUno pdf, oTov @akeAd oag kai
va KaBopioeTe To PEYEDOC TOU APXEIOU, ETOI WOTE va €ival To eAayioTo (minimum size).

8. Na avoiEeTte kal nahi To apyeio pe ovoua Parousiasi.pptx. Na anobnkeloeTe To apxeio
pe ovopa Parousiasi2, oc Tuno pdf, oTov (PAKEAO 0aC Kal va €MAEEETE ONWG TO
MEYEBOC TOu apyeiou va sival Baoiko (Standard).

9. Na peraBeite otov @AkeAd o0ac. Na OuykpiveTE TO MEYEBOC TWV  aApXeEinvV
Parousiasi.pptx kal Parousiasi2.pdf. Ti napatnpeite;

10. Na kAcioeTe 0AoUC TOuC (PAKEAOUG Kal OAa Ta apxeia.

ApaoTnpioTnreg ASI0A0YNONG

11. Na avoi&ete TO apyeio Students.xlIsx. kai va ypdweTe To Ovoua Tou NpoypdupaToc nou
XPNOIKONOINONKE yia TO AVOIyHa Tou.

12. Na anoBnkeloeTe To apyeio Ye To ovoua Studentsl, oc TUno pdf, oTov pakeAd oac.

13. Na avoifeTe kal NaAl To apxeio pe ovoua Students.xlsx kal va To anoBnkeUoeTe o€
TUNO apyeiou pdf, ye ovopa Students2, BETovTag wG PEYEBOC TOU apyeiou To eAAXIOTO
(minimum size).

14. Na petaBeite oTtov @AkeAd0 oac. Na ouykpivete Ta apxeia Studentsl.pdf «kai
Students2.pdf w¢ npog To PEYEBOC TOUG Kal va KATaypAWeTE TIG NApATNPROEIG 0ac.

=+ Eninp6o0eTec ApaoTnpiéTnTEG

15. Na avoi&ete To apxeio Newspaper.docx ano Tov gpakeAd oac.

16. Na anobnkeuoeTe To apxeio pe ovoua Newspaperl, os TUno pdf, BETovTag wg pEyebog
TOU apxeiou To Baoiko (standard).

17. Na ava@épete Toug AOYOUG Yid TOUG OMoioug Kanolog Xpnotng 6a emBupouce va
METATPEYEI TO apXeio Tou o€ Tuno pdf.

ApaoTnpIOTNTEG YIA TO ZNiTI

18. Na ava@epete napadeiypata and S1IApopouc enayyeEAUATIKOUC TOMEIC, Nou €ival EPIKTO
va xpnoigonoin®ei n peratponn apxeinv og Tuno pdf.
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®YAAO EPraziAzZ N4.2.M2
AnoOnkeuon Apxeiwv os pdf popen

Ti 6a padoupe onpepa:

©

@

Na onuioupyouus apxeio PDF and u@ioTayevo apyeio ene€epyaciag KEIYEVOU, UMOAOYIOTIKOU
(PUAN\OU Kal Napouciaocewv

Na puBuiloupe JIGPOPEC eMIAOYEC, ONWC HEYEOBOC TOU MAPAYOUEVOU dapyeiou Kal ouvenuaTiko
npooBaanc.

ApaoTtnpioTnTeG EPnédmong

1. Na avoieTe To apxeio Newspaper.docx.

2. Na anobnkeloeTe To apxeio pe ovoua NewNews, o TUno pdf, 6étovrac wg péyedog
Tou apyxeiou To Baacikd (standard).

3. Na petaBeite kar naM oto apxeio Newspaper.docx, va To anobnkeUoETE e OVOUa
NewNewsl, oc TUno pdf, kaBopilovtac w¢ oOvopa Tou ouyypagéa (Author) TO
ovouaTenwVUPo oag kal we TiTho (Title) «Néa €kdoan epnuePIdacy.

4. Ze auto To onpeio, Ba npenel va €xeTe PNpooTd oag To apxeio NewNewsl.pdf. Na
peTaBeite otnv kaptéha Document properties. Ti napatnpeite 60ov agopa oTIg
NANPOPOPIEC NOU EXETE KATAXWPIOEI OTO NPONYOUKEVO EPWTNHA;

5. Na petaBeite kai ndA\i oto apyeio Newspaper.docx kai va To anobnkeUoETE PE OVOUa
Newspass, oc TUno pdf, kabBopilovrag ouvenuaTikd npocpacng (password).

6. Na kAcioeTe OAa Ta apxeia.

7. Na pertaBeite oTov @AkeANd0 oag kal va avoifete TOo apyeio Newspass.pdf. Ti
napaTnpeiTe;

8. Na kAcioeTe OAa Ta apyeia kal OAEG TIG EPAPHIOYEG.

ApaoTnpioTnTeG AZIoAGYNnONG

9. Na avoi&eTe TO apyeio Students.xlIsx.

10. Na anoBnkelosTe To apyeio pe 1o Oovoua StudentsNew, os TUno pdf, oTov QPAKEAO
0ac, BETOVTAG WG PEYEBOC TOU apyeiou TO EAAXIOTO.

11. Na petaBeite kai ndhl oto apyeio Students.xlsx, va To anobnkeloeTe Pe Ovopa

Students3 kai TUno pdf, pe dvoua Students3, kabopilovTac we Ovoua Tou GuyypaPEa
TO OVOMUATENWVUHO 04C Kal WG TITAO «YMOAOYIGTIKO DUAAO».
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12. Na kAcioete OAa Ta apxeia kal OAEG TIC EPAPHOYEC.

*+ EninpooBerec ApacTnpioTnTEC

13. Na avoieTe To apyeio pYe ovoua Cyprus.pptx.

14. Na anofnkeuoete To apxeio o€ Tuno pdf, ye To dvopa CyprusNew, oTo QAkeAd oag,
BETOVTAC WG PEYEBOC TOU apxeiou To BACIKO.

15. Na petaBeite kai nahl oto apxeio Cyprus.pptx, va To anoBnkeUoeTe pe Ovopa
CyprusNew «kai Tuno pdf, kaBopilovTac w¢ Ovoua Tou ouyypa®Ed TO OVOUATENWVUHO
0ag kal wg TiTAo «Mia napouaiaon yia Tnv Kunpo».

16. Na kAeioeTe OAa Ta apyeia kal OAEG TIG EPAPHOYEG,

ApaoTnpIOTNTEG YIA TO ZNiTI

17. Na ava@epeTe TIG DIAPOPEC ENINOYEC MOU €XEI O XPROTNG OO0V aPopa OTNV PETATPOMN
TV apxeiwv o€ Tuno pdf.
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®yYAnO EPraziAz MN4.2.M3
Anpioupyia Apxeiou Zupnisong

Ti 6a padoupe onpepa:
© Na dnuioupyoUue veo apyeio (Archive) ano ugioTapeva apxeia f/kar pakeAouc.

ApaoTtnpioTnTeG EPnédmong

1. Na BaAete vV OTIC €QAPUOYEC MOU XPNOILOMOIOUVTAl yia TV OUMMIEoN/anocupnieon
apXEiwV Kal PpakéAwv.

Microsoft Word Adobe Reader
WinRAR 7Zip
WinZip Bit

2. Na petaBeite oTov QdakeAd oag kai va avoi&ete Tov pakelo LordoftheRingsPictures.
T TUNOU apyeia unapyouv anoBnKEUPEVA OTOV (PAKEAO QUTO;

4. Na dnuioupynoeTe éva apyeio oupnieong e ovoua LordoftheRingsPictures.7z yia Tov
¢pakeho LordoftheRingsPictures, xpnoiponolwvTag To npdypaupa gupnieong 7Zip.

5. Na petaBeite oTOV (PAKENO 0AC KAl VA OUYKPIVETE TO MEYEBOG TOU (PAKEAOU Kal TO
MEYEOOC TOU oupniECEVOU apxeiou. Na kaTaypayeTe TIC NapaTnproeig oac.

6. Na kAcioeTe OAa Ta apyeia kal OAEG TIG EPAPOYEC.

ApaoTnpioTnTeg AEIoAGYNONG

7. Na petaBeite oTov PAKEAO 0AG Kal va evTonioeTe Tov pakeho StarWarsPictures.

9. Na dnpIoupyROETE £va apyeio oupnieong yia Tov @akeho StarWarsPictures, | dvopua
StarWarsPictures.7z, xpnoiJonoiwvTag To npoypaupa cupnieong 7Zip.
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10.

Na peTaBeite oTov @AKEAO 0AC KAl va OUYKPIVETE TO HEYEOOC TOU (PAKEAOU Kal TO
MEYEBOG TOU CUMMIEoHEVOU apxeiou. Na kaTaypdWeTe TIG NApATNPNOEIC OAC.

. Na k\eioeTe OAa Ta apxeia kal OAEC TIC EPAPHOYEC.

“+ Eninpoo0eTec ApaoTnpioTnTEC

15.

16.

. Na petaBeite oTov pakeAOd 0ag kai va evTonioeTe Tov ake o HarryPotterPictures.

Na dnuioupynosTe €va apxeio oupnieong yia Tov @akeho HarryPotterPictures pe
ovopa HarryPotterPictures.7z, xpnoigonoiwvTtag To Npoypaupa cupnieong 7Zip.

Na oTeINeTE PEOW TOU NAEKTPOVIKOU TAXUDPOMEIOU TO CUMMIECHEVO APXEIO OTOV/OTNV
kadnynTn/kabnynTpia oac.

Na kAcioeTe OAa Ta apxeia kai OAEC TIC EPAPHOYEG.

ApaoTnpIOTNTEG yia TO ZNiTI

. Na ava@epeTe TN XPNOIMOTNTA TWV NPOYPARHATWV CUUMIEDNC.
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®YANO EPrazIAZ M.4.2.M4
Anpioupyia Apxeiou Zupnisong

Ti 6a padoupe onpepa:
© Na dnuioupyoUuE veo apyeio (Archive) ano ugioTapeva apxeia rn/kalr AakeAoug
© Na xpnoigonoloUE TIG dIAPOoPEC EMIAOYEG KATA TN dnUIoupyia apyeiou.

ApaoTnpioTnTeg EUnédmong

1. Na avoi&eTe Tov PAkeAd 0ag kal va evtonioeTe Tov pakelo LordoftheRingsTrailers.

2. Na kataypdyeTe To pEYEBOC TOU PAKEAOU auTou.

3. Na dnuioupynoeTe éva apxeio oupnieong pe ovoua LORTrailers.7z 1o onoio va éxel
Hop@onoinon apxeiou (Archive Format), Zip.

4. Na kaTaypayeTe To PEYEDOC TOU ApXEIOU NOU NPOKUNTEI YETA Ao T CUMNIEDT.

5. Na dnuioupynoete éva deUTEPO apyxeio oupnieonc e ovouya LORTrailersPass.7z yia
Tov (akeho LordoftheRingsTrailers, yia To onoio va KATAXWPIOETE OUVONUATIKO
(Password).

6. Na avoiéete TO apxeio LORTrailersPass.7z. Ti napartnpeite O0cov agopd OTo
NEPIEXOMEVO TOU;

7. Na kAeioeTe OAa Ta apxeia.

ApaoTnpioTnTeG AEIOAGYNONG

8. Na avoi&eTe Tov pakeAOd 0ag kai va evTonioeTe Tov @akeho HarryPotterTrailers.

9. Na kataypayeTe To PEYEBOG TOoU PpdakeAou auTou.

10. Na dnuioupynoeTe éva apxeio oupnieong pe ovoua HPTrailers.7z, 1o onoio va exel
popgonoinon apxeiou (Archive Format) Zip.

11. Na kaTtaypayeTe To PYEYEDOC TOU apXEIOU NMOU NPOKUNTEI YETA TNV CUHNIEDN.

12. Na OnuioupynosTe éva OeUTEPO apxeio oupnieong Ye ovopa HPPass.7z yia Tov (PAKENO

HarryPotterTrailers, yia To onoio va kataxwpioete ouvOnuaTikd (Password).
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13.

14.

Na avoi€ete To apyeio LORTrailersPass.7z. Ti napatnpeite 6cov a@opd oTo
NEPIEXOMEVO TOU;

Na kAcioeTe OAa Ta apxeia.

“+ Eninpoo0eTec ApaoTnpioTnTEC

15.

16.

17.

18.

19.

Na avoi&ete Tov pAkeAd 0ac kal va evtoniosTe Tov (pakeho StaWarsTrailers.

Na kaTaypayeTe To PEyeBOC Tou (PAKEAOU aUTOU.

Na OnuIoUpYNOETE €va apxeio oudnieonc pe ovopa STTrailers.7z, To onoio va £xel
pop@onoinon apyeiou (Archive Format) Zip. EninpocBeta, va kabopioeTe w¢ HEYIOTO
HEyeBoG apxeiou (Split Volume Types) 3Mb.

TI napaTnpeite oov apopda oTn dNUIOUPYIA TOU GUKMIECHEVOU APXEIOU;

Na kAcioeTe OAa Ta apxeia.

ApaocTnpIOTNTEG yia TO ZNiTI

20.

21.

Na ava@epeTe dIAPOPEG EMAOYEG NOU €xEl TN duvaToTNTa va B€0El 0 XPRoTNG KaTa Tn
dnMIoupyia GUUNIECHEVOU APXEIOU.

Na e&epeuvnoeTe Tnv kapTéha Add To Archive Tou AoyiopIkoU 7zip, yia va evToniosTe Kal
AAMAEG eNINOYEG MOU E€XEl 0 XPNOTNG KaTda Tn dnuioupyia GUUMIECHEVOU apXEiou.
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®YANO EPrAZIAZ N.4.2.M5
MpooOnkn/Aiaypapn ApXEiwV O apXEio CUHNIEDNC

Ti 6a padoupe onpepa:
© Na npooBgToups kal va dlaypapoupE apxeia og/anod UPICTAUEVO apxeio.

ApaoTtnpioTnTeG EPnédmong

1. Na avoi&eTe Tov PAkeAd 0ag Kal va evTonioeTe To apxeio pe ovopa HP.jpg.

2. Na npooBeoeTe TO apxeio auTo oTo cupnieouévo apxeio HarryPotterPictures.7z.

3. Na avoiéete To apyeio HarryPotterPictures.7z. Ti napatnpeite 6oov agpopd OTO
NEPIEXOUEVO TOU;

4. Na evronioete To apyeio HarryPotterTrailers.7z nou BpiokeTal anoBnkeUPEVO OTOV
(PAakeAd oag,.

5. Na Odiaypawere 710 apxeio Trailerl.mp4 and TO OUMMIEOPEVO  ApXEiO
HarryPotterTrailers.7z.

6. Na kAcioeTe OAa Ta apxeia.

ApaoTnpioTnTeG AEIoAGYNONG

7. Na avoifeTe Tov (pAKENO 0AC Kal va EVTONIOETE TO apyeio e ovoua ST.png.

8. Na npooBeoeTe To apxeio autd oTo cupnieopEvo apyeio StarWarsPictures.7z.

9. Na avoi€ete TO apxeio StarWarsPictures.7z. Ti napaTtnpeite O6cov agopa OTo
NEPIEXOUEVO TOU;

10. Na evronioete To apxeio StarWarsTrailers.7z nou BpiokeTal anoBnKEUPEVO OTOV
(PAakeAd oag.

11. Na Oiaypdyere TO apxeio Trailer8. mp4 and TO OUMMIECUEVO  aPXEIO
StarWarsTrailers.7z.

=+ Eninp6o0eTec ApaoTnpidTNTEG
12. Na avoieTe Tov QakeAd oag kai va evtonioeTe To apyeio LordOfTheRingsTrailers.7z.
13. Na kataypayeTe To PEyeBOC Tou apxeiou auTou.




r.4.2.M5 4.2 Merarponn Aedopévwv kal Zupnieon Apxeiov

14.

15.

16.

Na npooBéoete TO  apyeio  trailerAdd.mp4 oOTO  OupPnIECUEVO  APXEIO
LordOfTheRingsTrailers.7z.

Nwg peTaBaileral To péyebog Tou oupnieopévou apyeiou LordOfTheRingsTrailers.7z
META TNV Npoodnkn Tou apxeiou trailerAdd.mp4;

Na kAcioeTe OAa Ta apxeia.

ApacTnpIOTNTEG yia TO ZniTI

17.

Na XpnoiJonoInoeTe kal aAAa AoyIoPIKG oupnieonc, yia va OnNMIOUPYNOETE CUMMNIECHEVA
apxeia kar va kataypdyeTe TIG NapaTnpnoeig aag.
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®YAAO EPraziAz IN.4.2.M6
Anocupnigon Apxeiou Zupnisong

Ti 6a padoupe onpepa:
© Na anooupniefoupe u@ioTayevo apyeio (Archive).

ApaoTtnpioTnTeG EPnédmong

1. Na avoieTe Tov PAkeAd 0ag kal va evtoniosTe To apxeio HP.7z.

2. Na anooupniéosTe To apyeio HP.7z.

3. T napartnpeite 6000V a@opd OTOV XWPO TOU UMOAOYIOTH) OTOV Oroio €UPAVIOTNKE TO
QrNOCUMNIECHEVO apXEio;

4. Na anooupniécsTe kal nNaM To apxeio HP.7z, xpnolponoiwvrag Tnv KAaTtaAAnAn
01adikaacia, €TOlI WOTE TO ANOCUMMIECHEVO APXEIO VA anodnKeUTEI oToV (PAKEAO OAC,.

5. Toia enmAoyn Tou AoyIOUIKOU 7Zip EXETE XPNOIKONOINTEl;

6. Na kAcioeTe OAa Ta apxeia.

ApaoTnpioTnTeG AEIoAGYNONG

7. Na anooupniéoste To apyeio StarWarsPictures.7z otnv enipdaveld €pyaciac Tou
unoAoyioTn oag,.

8. Na anooupniécete To apxeio StarWarsTrailers.7z kal Ta anocupniecpéva apxeia va
anoBnkeuTtolVv oTov PAKeA 0ac,.

9. Na Bpeite To PYEYEBOC TOU CUUNIECUEVOU apyeiou StarWarsTrailers.7z kal To peyebog
TWV ANOCUMNIECUEVWV APXEIWV Kal va KATAypAYeTe TIC NApATnPnoEIG oag,.

=+ Eninpoo0eTec ApaoTnpioTNTEG

10. Na avoi&eTe Tov pdakeAd oag kai va evtonioeTe To apxeio LordOfTheRingsTrailers.7z.

11. Na anoocupniecete To apyeio LordOfTheRingsTrailers.7z kal Ta anocupnieopeva
apxeia va anobnkeuTouv oTov (PAKENO OdC.

12. Na anooupniecoete To apyeio LordOfTheRingsPictures.7z kal Ta anocupniecuéva

apxeia va ugavioTouv oTnV ENIPAVEIa Epyaaciacg Tou UNoAoyIoTr odac.
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r.4.2.M6 4.2 Merarponn Aedopévwv kal Zupnieon Apxeiov

ApaoTnpIOTNTEG YIa TO ZNiTI

13. Na OnuIoUpynOETE £va VEO APXEIO CUMMIEONC TO OMOIO va MEPIEXEI OAA TA ApXEia nou
EXETE ONUIOUPYNOEI yIa TNV evoTNTA «YNoAoyloTikd ®UANG» Kal va TO anooTeIAETE HEOW
TOU NAekTpovikoU Taxudpoleiou aTov/aTnv kabnynTr/Tpid oac.
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®yYAAO EPTrAZIAZ .4.3.M1
Baogikég AsiTtoupyieg EneEepyaaiag 'Hyou

Ti 6a padoupe onpepa:

Na dnuioupyoUpE £pyo

Na anobnkeloupe £pyo

Na gl0ayoups rixo and apyeio nxou

Na eEayoupe apyeio nxou

Na dnuioupyoUuE KavaA

Na xpnoigonoloUpe Ta epyaleia: perakivnong, diaypadpnc kai dinAaciacpou.

©OOOOd

ApaoTnpioTnTeCG EUnédmwong

ApacTnpioTnTa A

>Tn dpacTnpIOTNTA auTr 6a evwoeTe dUO JIAPOPETIKA apxeia NXOU dNUIOUPYWVTAC €va
eviaio apyeio. MpwTa 6a akoUyeTal TO NPWTO KOMUATI Kal META Ba akoAouBei To AAAo.

1. Na avoitete To AoylopIkO enegepyaaiac nyou Audacity, evroniovrag To €lkovidlo
oTnv enipaveia epyaoiac i avalnTwvTac To oTo pevou Start .

2. Na sioayayete 1o apxeio How You Remind Me Part 1.mp3 (File->Import->Audio).

3. Na akoUoeTe PEPOG TOU TPayoudioU Kal M0 CUYKEKPIPEVA WEPIKA OeUTEPOAENTA
oTNV apxn kai aTo TEAOC Tou.

4. Na sioayayete 1o apxeio How You Remind Me Part 2.mp3

5. Na akouoeTe &ava Tnv apxn Tou Tpayoudiou.

6. Na xpnoiponoinocete To gpyaAeio Time Shift Tool , YIO va PETAKIVAOETE XPOVIKA TO
TpayoUdl How... Part 2, €101 woTe va &kiva Tn XPOVIKN OTIYHR MOU TEASIWVEI TO
Tpayoud! How... Part 1.

7. Na akoUOETE TO PEPOC TOU TPayoudioU GTO ONUEI0 OMOU TEAEIWVEI TO NPWTO TPAYOUDI
kal Eekiva To deUTEPO.

8. Na anobnkeloeTe TO €pyo (File Save Project As...).

9. Na eEayayete TO apyeio og poppr) .mp3 (File Export Audio... kai va eniBeBalwOETE OTI
oTnv nepioxn Save as type: ypagel mp3).

10. Na kAecioeTe To Aoyliopikd ene€epyaaiag fxou Audacity.
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r.4.3.Mm1 4 Aoyiopiko Eqpappoy®v

ApaocTnpioTnTa B

>Tn dpaocTnpioTNTa auTn 6a ene€epyacTeiTe £va apyeio nXou XPNOILOMOINVTAC Ta £pYaAEia
oiyaonc MEpouc Tou apyeiou (Silence), avTiypapnc HEpoug Tou apyeiou (Duplicate),
dlaypaPng evog pepoug (Delete), kar Xpovikng petakivnong (Time Shift).

11. Na avoieTe 10 Audacity, va sioaydayete 1o apyeio Martin Luther King, Jr. I Have A
Dream Speech.mp3 kal va To akoUOETE.

12. Na &vTonioeTe TO XEIPOKPOTNHA OTNV apxn TOU NXOU, va TO €MIAEEETE Kal va UNOevioeTe
iy

TNV €vraon Tou fxou (

13. Na evronioeTe, Aiyo PETA TO OeUTEPOAENTO 12, TN PWVN HIAC yuvaikag nou akoUyeTal
ano To nAnBog kai va Tn diaypaywete (emAoyn->MAnkTpo Delete).

14. Na evronioeTe, Aiyo PETA TOo deuTepOAEnTO 17, Tn ¢pdon «I have a dream» kal va Tnv
enAeete. Na xpnoidonoinoste Tov dinAaciacud, yia va dnUIOUPYNCETE Eva avTiypago
NG ppaong o veo kavahl (Edit->Duplicate).

15. Na evtonioeTe, Aiyo YETA TO OeuTepoAenTo 32, Tn ¢pdon «that all men are created
equal» kar va Tnv enmAé€eTe. Na xpnolponoinoeTe Tov OINAAciacpo, yia va
ONMIOUPYNCETE avTiypa®o TnG ppaong o€ veo kavall (Edit->Duplicate).

16. Na METAKIVAOETE Xpovikad TOo avTtiypapo TnG ¢pdonc «I have a dream» nou
ONUIoOUPYNOATE OE MPONYOUKHEVO BRua, €TOI WOTE va AKOUYETAl OTO TEAOG, META TO

' 4+
X€lpokpoTnua ( ).

17. Na PETAKIVAOETE Xpovika To avTiypapo TnG ¢paong «that all men are created equal»
nou OnuIoUPYNCATE O NPONyoUHEVO BAKA, £TCI WOTE va AKOUYETAl OTO TEAOG, WETA TN

¢pdon «I have a dream» ( il ).
18. Na anoBnkeloeTe To €pyo (File Save Project As...).

19. Na &ayayete 10 apyeio o poppn .mp3 (File Export Audio... kai emBeBaiwoTe OTI OTNV
neploxn Save as type: ypagel mp3).

20. Na kAeioete 1o Audacity.

ApaoTtnpioTnTeg AEI0AOYNONG

21. Na avoifete TOo Audacity kal va sioayayete 1o apxeio Scent of a Woman (Al Pacino
Speech).mp3

22. Na evtonioete (Aiyo peta To 2:25) Tn ¢paon «but not a snitch» kal va agaipeoste 6o
TOV NXO0 MOU UNApXEl NpIv anod auTr) Tn epdaon.

23. Na evronioeTte kai va diaypdyeTe Tn ¢ppdacn nou &ekiva pe 1o «I don’t know who went to
this place» (nepinou 1:05) kai TeAeiwvel pe TN ppaocn «What a shame» (nepinou 1:36).
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24,

25.

26.

27.

28.

29.

Na evTtonioeTe To Kevo dlaoTnua (Xwpic NXo) kanou oto 1:44. Na diaypdyeTe oTIONNOTE
undapxel Yeta and auTo.

Na evronioeTe Tn @paon «Are you finished Mr. Slade. No I'm just getting warmed up»
(nepinou 1:00 pexpr 1:05) kal va dnUIOUPYNOETE £va avTiypago O€ VEA YPAuun.

Na YETAKIVAOETE TO avTiypago, £TOI WOTE va €ival n TEAeuTaia ¢ppacn Tou fXou.
Na anoBnkeUoETE TO €pYO.
Na e€ayayete To apxeio o€ PopPpr .mp3

Na kAeioeTe To Audacity.

+ Eninpoo0erec ApaoTnpiéTnTES

30.

31.

32.

33.

34.

35.

Na avoi&ete To Audacity kal va eioayayete 1o apxeio DOGS BARKING.mp3

Na evtonioeTe To deUTEPO yauyiopa (Pitbull) kar va diaypawete 6Aa Ta unoAoina ekTog
ano auto.

Na JETAKIVAOETE TOV NXO, £TCI WOTE va EkIva and Tn Xpovikr oTiyun O.

Na dnMIOUPYROETE TOUAAXIOTOV TEOOEPA AVTIypAPA TOU NXOU KAl va TA WETAKIVAOETE
XPOVIKA, £TO1 WOTE OAA va EEKIVOUV O DIAPOPETIKEC XPOVIKEC OTIYHEG.

Na anoBnkeUoETE TO €pYO.

Na EaydayeTe To apyeio o€ JopPr .mp3

63




®DYANO EPTrAZIAZ .4.3.M2
Baogikég AsiTtoupyieg EneEepyaaiag ‘Hyou

Ti1 6a padoupe onpepa:

©OeOOd

Na dnuioupyoUpE £pyo

Na anoBnkeloupe £pyo

Na eEayoupe apyeio nxou

Na dnuIoupyoUpE Kaval

Na nxoypagoupe rixo

Na xpnoigonoloUpe Ta epyaieia: Metakivnong, Aiaypanc kai AinAaciacuod.

ApaoTnpioTnTeCG EUnédmwong

>T0 (PUANO €pyaciac nou akoAouBei Ba nxoypapnosTe KAMNOIEC PPATEIC KAl OTN OUVEXEID Ba
TIC €NEEEPYATTEITE, ONUIOUPYWVTAC VEEC (PPACEIC, XPNOIMONOIWVTAG AEEEIC and TNV apyikn
0ag nxoypagnon.

1.

Na avoieTte To Aoyiopikd eneEepyaaiag nxou Audacity, evronifovTag To €IKovidio
oTnv enipaveia epyaaiac i avalnTwvTac To oTo pevou Start .

Na XpnOIHOMOINCETE TO HIKPOPWVO, YIA VA NXOYPAPNAOETE TN @PACH «AOKIUN
MIKpo®wvou. AUTH €ival pia doKIJaoTIKA nxoypagnon.» °-.

Na anobnkeuoete To €pyo (File Save Project As...).

Na €Eayayete To apyeio oc pop®ry .mp3 (File Export Audio... kal va eniBeBaiwosTe OTI
oTnv nepioxn Save as type: ypagel mp3).

Na evToniosTe Tov avenBbuunTo X0 GTNV apxr TN NXoypdapnaong kai va Tov diaypayeTe.

Na evronioeTe Tn @paon «AuTn €ival Wia», va Tnv €NIAEEETE Kal va OnUIOUPYNOETE Eva
avTiypago TG ¢pacng autng o€ véo kavahl (Edit->Duplicate).

Na evTonioeTe Tn GPAcn «JOKIUN MIKPOPWVOU», va TNV €MIAEEETE Kal va dNMIOUPYNOETE
€va avTiypago Tng ppacng auTng oc veo kavaAl (Edit->Duplicate).

Na xpnoiponoinoete To Mute, yia va KAEIOETE Tov X0 GTNV NPWTN NXOypapnan.

Na peTakivioeTe kaTaMnAa Ta avtiypapa oTta dUo GAAa kavaAia, €TGI WOTE va
OnuioupynBei n @pacn «AuTn €ival pia doKIUN HIKPOPWVOU.

10. Na anobnkeloeTe To £pyo (File Save Project As...).
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.4 Aoyiopiko Eqpappoymv r.4.3.mM2

11. Na €&ayayete To apyeio oe popen .mp3 (File Export Audio... kal va eniBeBaliwoeTe OTI
oTnv nepioxn Save as type: ypapel mp3).

ApaoTnpioTnTeG ASI0AOYNONG

ApaocTnpioTnTa A

12. Na OnMIOUPYROETE TN PPACT «AOKIJAGTIKI NXOYPAPNON HIKPOPOVOU>».
13. Na anoBnkeUoETE TO €pYO Kal va €EAYAYETE TO ApXEio0 O€ JopPn .mp3
14. Na kAciosTe To AoyloUIKO ene€epyaaiac rixou Audacity.
ApaoTnpioTnTa B

15. Na avoi&eTe To Audacity o€ éva véo pyo.

16. Na XpnoIJONOINCETE TO HIKPOPWVO, YIA VA NXOYPAPNOETE TN PPAcn «ZTn OOUAEIG Gou
va gioal TpeANOC kai otn {wry oou coBapoc.».

17. Na anoBnkeUOETE TO €pYO Kal va €EAYAYETE TO ApXEi0 O€ HopPn .mp3

18. Na dnuioupynoeTe Tn @pdacn «ZTn OOUAEIG gou va eioal coBapog kai atn {wn oou
TPENOG».

19. Na anoBnkeUOETE TO €pYO Kal va €EAYAYETE TO ApXEi0 O€ Hop®n .mp3

+ Eninp6o0eTec ApaoTnpiéTnTEG

20. Na avoi€ete To Audacity kal va sicayayeTe To apxeio Phrase.wav
21. Na aM\a&ete Tn epdon os «Do you judge me by my size?».

22. Na anoBnkeUoETE TO £pYO.

23. Na eEayayeTe TO apyeio o€ pop®prn .mp3

24. Na kAeioeTe T0 Audacity.
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®DYANO EPTAZIAZ .4.3.M3
BeATtioon Tng NoioTnrag Hxoypapnong

Ti1 6a padoupe onpepa:

© Na BEATIOVOUUE AKOUGTIKA TNV MoIOTNTA Wiag NXoypapnong

© Na avayvwpifoupe kai va apaipoUpe Tov «Aeukd @dpuBo» e nxoypapnon

© Na evtoni{oupe ONTIKA /KAl akouaTIKG avenBUPnNTouG fXouUG s nXoypapnon.

ApaoTnpioTnTeC EUnédmwong

ApaocTnpioTnTa A

2TNn

dpaoTnpioTnTa autn, 6a agaipeceTe Tov BOPUPBO anod &vav NXo Mou nXoypa@ndnke To

1887, BeATiwvovTag €Tl TNV NoIOTNTA TOU.

1.

10.

11.

Na avoieTte To Aoyiopikd ene€epyaaiag nxou Audacity, evronifovTtag To €IKovidio
oTnv enipaveia epyaoiac i avalnTwvrac To oTo pevou Start .

Na eioayayete TO apxeio Alexander Graham Bell's Voice 1887.mp3
(File>Import->Audio).

Na akoUOETE ToV NXO0 0 onoiog nxoypapndnke To 1887.

Na evTonioeTe Ta ONUEId TOU NXOU OTA OrMoid PMNOPOUME va AKOUGOUME HOVO AEUKO
B0puBo kai va enIAEEETE To PeyaAUTepPO (o€ didpkela) anod auTd.

Na epappocete TO npwto oTadlo Tou €Pe Noise Reduction (Effect->Noise
Reduction...>Get Noise Profile).

Na enIAeEETE OAOKANPN TNV NXOYPAPNON.

Na epapuooete TO OcUTeEpo oOTAdI0 Tou e@é Noise Reduction (Effect->Noise
Reduction...>0K).

Na akoUoeTe Eava Tnv nxoypapnon.
Na anobnkeuoete To €pyo (File Save Project As...).

Na eEayayete 1o apxeio os popopn .mp3 (File Export Audio... kar va emBeBaiwosTe OTI
oTnv nepioxn Save as type: ypager mp3).

Na kAcioeTe To AoyIoHIKO eneEepyaaiag nxou Audacity.
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r.4.3 Eng&epyaocia "Hyou r.4.3.mM3

ApaocTnpioTnTa B

>Tn dpacTnpIOTNTA auTr), 6a SIaypAYETE KAMOIOUG aveniBUPNTOUC NXOUG MouU €U(avioTnkav
KaTa Tn dIdpKela TNG NXoypapnonc.

12. Na avoifete To Audacity, va eiocayayete To apyeio Mic Noise.mp3 kal va To akoUOETE.
O nxoc eivar PEPOGC TOU NXOU €VOC aywva TEVIC, OTOV OMoio E€UPAVIOTNKE KAMOIO
npoBANMAa Ke €va anod Ta PIKPOPVa.

13. Na evtonioeTe (akouoTIka) TIC OUO (POPEC NMou euPavileTal o aveniBUPUNToC nXoc Tou
MIKPO(WVOU Kal va TIC ONUEIWOETE, KUKAWVOVTAG Ta KATaAANAa onpeia, otnv nio Katw
eikova.

14. Na diaypayete TIG OUO POPEC Nou euavideTal o aveniBuPnTog NXOC, XWPIC va UEIWOETE
TOV OUVOAIKO XpOvo TNnE nxoypapnong (enidoyn-> I ).
15. Na anoBnkeuoeTe To €pyo (File Save Project As...).

16. Na eEayayete 10 apyxeio o poper .mp3 (File Export Audio... kal va eniBeBalwoeTe OTI
oTnVv nepioxn Save as type: ypagpel mp3).

17. Na kAcioeTe To Audacity.

ApaoTnpioTnTeG AEI0AOYNONG

>1n OpacTnpioTNTa autn 6a agaipeceTe BOpuPBo and nxoypagpnon kai Ba dlaypdyeTe
KAMoIoug aveniBuuNTouUG NXOUG Nou ePgavioTnkav katd Tn 8IapKeia TNG NXoypapnaong.

18. Na avoifete To Audacity, va sicayayete 1o apyxeio Now we are Masters of Our
Fate.mp3 kal va akoUoeTe TNV nxoypaenon. MapatnpnoTe Tov B0pUB0 Nou akouyeTal,
Kabwg €niong Kal Kanoia KTunnuaTa.

19. Na evtonioeTe Tov NXO Mou MoIGlel PE KTUMNWA OTO MIKPOPWVO Kal eP@aviferal 5
OUVOAIKA (OpEG 0Tn BIAPKEIa TNG NXOYPAPNONG.

20. Na JdiaypAyeTe TIC MEVTE (POPEC MOU edgavileTal o aveniBuunToG NXOC, XWwpIC va
MEIWOETE TOV GUVOAIKO XPOVO TNG NXoypapnaong.

21. Na spapuooste To £@e Noise Reduction, yia va agaipeoste Tov B0puBfo and Tnv
nxoypagnon.

22. Na anoBnkeUoETE TO £pYO.
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23. Na €EayayeTe To apyeio og popepn .mp3

24. Na kAsioeTe TO Audacity.

“+ Eninpoo0eTec ApaoTnpioTnTEC

25. Na avoi€ete TO Audacity kar va eioayayete 10 apyeio Old Christmas Vinyl
Record.mp3

26. Na epapuoocete To @€ Noise Reduction, yia va agaipéoste Tov B0puBfo and Tnv
nxoypagpnan.

27. Na «kabapioeTe» TNV NXoypapnaon ano ornolovonnoTe nXo BewpeiTe aveniBupunTo.
28. Na anoBnkeUoETE TO £pYO.

29. Na eEayayeTe To apyeio og popepn .mp3
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®YAAO EPraziAz N.4.3.M4
Ens€epyaoia Hyoypapnong

Ti 6a padoupe onpepa:

© Na BEATIOVOUUE AKOUGTIKA TNV MoIOTNTA Wiag NXoypapnong

© Na avTiypa@oupe PEPOG TNG NXOYPapnong

© Na somialoupe o onUEio TNG NXoypapnaong

© Na yxpnoigonoloUpe Tn diadikaaoia TnG EMKOAANGNG NXOU OE GNHEI0 TNG NXoYypadnong.

ApaoTnpioTnTeg EUnédmwong

ApaocTnpioTnTa A

2TNn

dpaoTnpIOTNTA auTh Ba EVWOETE NEVTE PEPN ANO €va avekdOTO MoU €ival anobnkeupeva

oc OIaPOpPETIKA apxeia. ‘ETol Ba dnUIOUPYNOETE €va €viio ApXEI0 MOu NEPIEXEl OANO TO
avekdoTo.

1.

Na avoieTte To Aoyiopikd eneEepyaaiag nxou Audacity, evronifovTtag To €IKovidio
oTnv enipaveia epyaoiac i avalnTwvTac To oTo pevou Start .

Na eioayayete Ta apxeia Avékdoto P1.mp3, Avékdoto P2.mp3, AvékdoTo P3.mp3,
AvékdoTo P4.mp3 kal AvékdoTo P5.mp3 (File->Import->Audio).

Na natnoeTe Tautoxpova Ta nAnktpa Ctrl + Shift + F yia va npooappooTei To UPog Twv
KavaMiwv WoTE va Ta BAENETE OAQ.

Na akoUOETE PEPOG TOU NXOU Kal MIO OUYKEKPIPEVA HEPIKA DEUTEPOAENTA GTNV APXN.

Na emAeEeTe oAOKANPO Tov N0 OTO KavaAl AveékdoTo P2 kali va Tov avTlypayeTe
(Edit>Copy).

Na natnoeTe akpiBwG OTO TEAOG TOU MPWTOU NYou oTo kavaAdl Avekdoto P1 kal va
EMIKOANCETE TOV NXO MOU avTiypayate oto nponyoupevo BrAua (Edit->Paste). Ztnv
NEPINTWON NMOU NATAOATE OE KAMOIO onpeio nmo Oe€a, PNOPEITE va XPNOILOMNOINCETE TO

epyaieio Time Shift Tool yla va PETAKIVAOETE XpovIKa (NPOG Ta apioTepa) Tov nXo
AvekdoTo P2, £TO1 woTe va EeKiva apeowg HOAIG TEAEIwvEl 0 fxog AvekdoTo P1.

Na enavaAdBete Ta OUO nponyoUpeva PhAuarta, €101 wOTE OAd Ta Kavalia va
avTiypagoUuv oTo NPWTO Kal va akoUyovTal To €va JETA TO AAAO XwpiG Keva PETAEU TOUC.
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8. Na diaypayeTe Ta AA\a TEooepa kavaAia kal va KpaTAOETE JOVO TO NPWTO.

9. Na akoUOETE To avékDOTO Kal va KAVeTe BIOPOWOEIC, €Av XpelaleTal.
10. Na anoBnkeloete To €pyo (File Save Project As...).

11. Na e&ayayete 10 apxeio oe poppr) .mp3. (File Export Audio... kal va eniBeBalwOETE OTI
oTnv nepioxn Save as type: ypagel mp3). Na dwoeTe To Ovopa AvékdoTo.mp3

12. Na kAciosTe To AoyloHIkO ene€epyaaiac rixou Audacity.

ApaocTnpioTnTa B

>Tn OpacTnpioTNTA auty Oa ouvdudoeTe dUO apxeia OnuioupywvTac &va Tpito. Mo

OUYKEKPIMEVA, and To NpwTo apxeio Ba diaypayeTte pHOvo To ovopa Johny kal oTn B€on Tou

Ba BaAeTe To dvopa Mary nou Ba napete anod To deUTEPO apyeio.

13. Na avoi&Te T0 Audacity, va eicayayete To apxeio Johnny.mp3 kai va To akoUOETE.

14. Na sioayayeTe To apxeio Mary.mp3 kal va To aKoUOETE.

15. Na evronioeTe Tn A€EN «Johnny» kai va Tnv diaypayete. (Emidoyn->NAnkTpo Delete). MNa
nio akpiBn emAoyr TNG AEENG PNOPEITE va XpNOIKONOINOETE TN peyEBuvan ( » ).

16. Na evtonioeTe Tn A€EN «Mary» kai va Tnv avtiypayete (EmAoyn->Edit->Copy).

17. Na enikoAARoeTe Tn A€EN «Mary», £€TOI WOTE va Yivel N npwtn AEEN oTO Kaval
Johnny.mp3

18. Na diaypayete 1o kavaAl Mary.
19. Na anobnkeloeTe To €pyo (File Save Project As...).

20. Na e&ayayete To apyeio oc pop@n .mp3 (File Export Audio... kal va eniBeBaiwosTe OTI
oTnv nepioxn Save as type: ypagel mp3).

21. Na kAeioeTe T0 Audacity.

ApaoTtnpioTnTeG AE1I0AOYNONG

ApaocTnpioTnra I
>Tn dpaoTtnpioTnTa auTn Ba diaypayeTe SIAPOPOUC aveniBUPNTOUC NXOUC.

22. Na avoifete To Audacity, va sicayayete To apxeio Raul.mp3 kal va To akoUGCETE.
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23

24,

25.

26.

27

. Na evtonioeTe Tn Qpdon «Hey Johnny come to supper» kai va Tnv diaypayeTe.

Na evTonioeTe T KTUMNAPATA OTO MIKPOPWVO Kal KAMOIoUC NApa&evouc NXOouc Tou
OMIANTN Kal va Ta dlaypayeTe.

Na anoBnkeUoETE TO £pYO.
Na e€ayayeTe To apxeio o€ popPpr) .mp3

. Na kAeioete T0 Audacity.

ApaocTnpioTnTa A

>Tn dpaoTtnpioTnTa auTr Ba diaypayeTe SIAPOPOUC AveniBUPUNTOUC NXOUC.

28

29.

30.

31.

32.

. Na avoieTe To Audacity kai va eicayayete To apxeio Hillary Coughing.mp3

Na evToniosTe Ta onueia oTa onoia n opIAATPIA BAXEl kKal va Ta dIaypAaYETE e NPOCoxH,
€TOI WOTE VA PNV aQaipeTETE KANOIO PEPOG and TNV opIAia TN,

Na anoBnkeUoETE TO £pYO.
Na e€ayayete To apxeio o€ HopPr .mp3

Na kAcioeTe To Audacity.

+ Eninpoo6eTec ApaoTnpioTnTEC

33.

34.

35.

36.

37.

Na avoi€ete TO Audacity kai va e€loayayete To apxeio Avékdoro.mp3 nou
OnuIoupynoaTe og nponyoUpEVn AoKNaon, kabwg eniong kai To apxeio Beep.mp3

Na evronioeTe TN A&EN AvTwvng O0EG POPEG EMPAVICETAl KAl VA TNV AVTIKATAOTNOETE E
TO Beep.

Na anoBnkeUoETE TO €pYO.
Na e€ayayeTe To apxeio o€ Yoppr .mp3

Na kAcioeTe To Audacity.
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®YAAO EPraziAz M.4.3.M5
Xpnon EmnpoaBsTwv EpyaAsinv

Ti1 6a padoupe onpepa:
© Na yxpnoigonoloUue To epyaieio dakehog (Envelop)
© Na dnuioupyoUue Podcast.

ApaoTnpioTnTeC EUnédmwong

ApaocTnpioTnTa A

XpnoigonolwvTag onueia eAéyxou, Ba au€oPEINOETE TNV €VTACN TOU NXOU O€ KAMoIa onueia
€vOg Tpayoudiou.

1.

8.

Na avoieTte To Aoyiopikd eneEepyaaiag nxou Audacity, evronifovrag To €IKovidio
oTnv enipaveia epyaoiac i avalnTwvrac To oTo pevou Start .

Na eioayayeTe 1o apxeio Pirates Of The Caribbean.mp3 (File>Import->Audio).

—
Na enAEEETE To epyaleio pakeAog = |,

Na OnuIoupynoETE €va onueio EAeyxou oTo OeuTEPOAENTO 15 TOU fXOU, NATWVTAC OTO
avTioToIXO ONMEIO PE TO APIOTEPO KAIK Tou MovTikioU. Av NaTtnoeTe o€ dinAavi nepioxn,
KPATAOTE NATNUEVO TO APIOTEPO KOUWMI Kal YETAKIVAOTE TO MovTikl O€Ia N apioTepd,
MEXPI TO onueio va BpiokeTal oTo 150 OeuTePOAEnTO. Av aANAEETE TNV £vTAon TOU NXou,
naTnoTe oTn AaBn TOU ONMEIOU €AEYXOU Kal OUPETE TNV HAKPIA and TO KEVTPO TNG
YPAPIKNG NAPAcTAcnG, HEXP! N EvTaAon va GTAcel 0To YNAGTEPO ONWEIo TNG.

Na akoAouBnoeTe Tov 10 TPONO ONWC NPONYOUUEVWE Kal va OnMIoUpYnosTe AAa Tpia
ONMEIa EAEYXOU OTIC XPOVIKEG OTIVMEG 16, 29, 30.

Na METAKIVAOETE TO ONueio eAeyxou nou BpiokeTal oTo 160 JeUTEPOAENTO MPOG TO
KEVTPO TNG YPAPIKAG NapdoTaong, HEXP! va GTACEI N €vTAon OTO KIOO TNG KAVOVIKAG.

Na enavahaBete Tn diadikacia Tou napandvw PAMATOC yia TO ONUEI0 EAEyXOU OTO
deuTepOAENTO 29.

Na dnUIoUPYNOETE aKOMa Tpia onUEia EAEYXOU OTIC XPOVIKEG OTIYHEG 45, 51,5 kail 59.
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4.3 Ens&epyacia "Hyou r.4.3.M5

0.

10.

11.

12.

Na METAKIVAOETE TO ONueio €Aeyxou nou PBpiokeTal oTo deutepoAenTo 51,5 nmpog TO
KEVTPO TNG YPAPIKAG NapdoTaong, HEXP! va GTACEI N €vTaon 0To Y4 TNG KAVOVIKAG.

Na anoBnkeuoeTe To £pyo (File Save Project As...).

Na e€ayayete 1o apxeio os popopr) .mp3 (File Export Audio... kai va emBePalwoeTe OTI
oTnv nepioxn Save as type: ypagel mp3). Na dwoeTe To Ovopa AvekdoTo.mp3

Na kAcioeTe To AoyIopIkO eneEepyaaiag nxou Audacity.

ApaoTnpioTnTa B

3’ autn Tn dpaocTnpidTNTa E£XeTe OUO OIAMOPETIKA TPAyoudid. XpnoidonolwvTac onueia
eAeyxou, Ba enekepyaoTeite Ta Tpayoudia auTd, WOTE GE KAMOIQ ONUEIQ va EXEl TO &va WnAN
€vTaon kai To a\\o XapnAn, evw o€ aAa onyeia To avtioTpogo. ‘ETal Ba emiTUXeTE WiEn Twv
duo Tpayoudiwv.

13.

14.

15.

16.

17.

18.

Na avoi&ete To Audacity, va eiocayayete Ta apxeia Madame.mp3 kai Padam.mp3

Na akouoeTe To TpayoUdl Madame kai va evToniosTe To onueio ONoU akoUyeTal n GpAcn
«Madame, Madame, Madame».

Na npooBeoeTe dUO onueia eAéyxou oTo onueio auTtd (Npiv and Tn ¢ppdocn «Madame...),
£TOI WOTE VA WNOPECETE VA HEIWOETE OTO EAAXIOTO TNV €vTaon Tou Tpayoudiou Madame
anod auTtd To oneio Kal KETA.

Na npooBeoeTte, avrioToixa, OUo onueia eAéyxou oTo Tpayoudl Padame, €101 woTe va
MMNOPECETE va KPATNOETE TNV €vTacn Tou TpayoudioU OTo €AAXIOTO anod Tnv apxn MEXP!
TO ONUEio auTd Kal OTn OUVEXEID va OUVAUWOEL.

Na evTonioeTe To TEAOG TNG Ppacng «Padam, Padam, Padam» oTov fjxo Padam.

Na npooBeoeTe dUO onpeia eAéyxou 0To onueio auTtd (MeTd anod Tn ¢paon «Padame...),
£TO1 WOTE VA PMNOPECETE VA PEIWMOETE OTO EAAXIOTO TNV £vTaon Tou TpayoudioUu Padam
ano auTtd To oneio Kal KETA.
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r.4.3.M5 4 Aoyiopiko Eqpappoy®v

19. Na npocoBéoeTe avrtioToixa dUo onueia eAéyxou oTo Tpayoudl Madame €10l wOTE va
MMOPEDETE VA KPATNOETE TNV £VTAGHN TOU TPAyoudioU OTO €AAXIOTO anod TO NPONYOUUEVO
ONMEIO MEXPI TO ONUEIO AUTO KAl OTN CUVEXEIA VA OUVANWOEI.

20. Na enavaAaBere Tn Oiadikacia yia TIC AAAeC OUO (POPEC NMOU aKOUYETal n (ppdaon
«Madame, Madame, Madame» kal «Padam, Padam, Padam».

21. Na anoBnkevoete 10 £pyo (File Save Project As...).

22. Na eEayayete 10 apyeio oc pop@n .mp3 (File Export Audio... kai va eniBeBaiwosTe OTI
oTnv nepioxn Save as type: ypagel mp3).

23. Na kAeioeTe T0 Audacity.

ApaoTnpioTnTeG AEI0AOYNONG

ApacTnpioTnra I

>’ autn Tn dpaocTnpidTNTa £XeTe OUO OIAMOPETIKA TPayoudid. XpnoidonolwvTac onueia
eAeyxou, Ba ensepyaoTeite Ta Tpayoudia auTd, WOTE O KAMOIQ CNHEIQ va EXEI TO Eva WNAN
EvTaon kal To aAo XapnAn, evw o€ aAa onueia To avtioTpogo. 'ETal Ba eniTUXeTE MiEn Twv
dUo Tpayoudiwv.

24. Na avoifete To Audacity, va sicayayete Ta apxeia With Or Without You 1.mp3 «ai
With Or Without You 2.mp3

25. Na evronioste oTo apxeio With Or Without You 1 To onueio onou &kiva To Tpayoudl
(puwvn).

26. Na XpnoIJOMOINOETE TOV (PAKEAO KAl VA (PPOVTIOETE £TCI WOTE WEXPI TO GNMEIO Mou
evronioate OTI &kivoUv Ta Aoyia Tou TpayoudioU va pnv akouyetal To With Or Without
You 1, va akouyetal To With Or Without You 2.
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4.3 Ens&epyacia "Hyou r.4.3.M5

27.

28.

29.

30.

21N OUVEXEIQ, MEXPI Kal TNV Xpovikn oTiyun 1:11 va akouyetal To With Or Without You 1,
EVO) PEXPI TO TEAOC va PeiwBei oTo ghayioTo n €vraon Tou With Or Without You 1 kai va
duvapwaoel Tou With Or Without You 2.

Na anoBnkeUoETE TO €pYO.
Na e€ayayete To apxeio o€ popPpr) .mp3

Na kAeioeTe To Audacity.

+ Eninpoo0erec ApaoTnpiéTnTES

31.

32.

33.

34.

Na avalnThoeTe kal va kaTeBAcETE oTov UnoAoyioTrn oag and To d1adikTuo, Eva Tpayoudi
o€ OUO JIaPOPETIKEG EKTEAETEIC. ZTN OUVEXEI, VA NPOOTNIAONCETE va KAVETE Wia MiEn Twv
OUO eKTEAEOEWYV, WOTE O KAMola Xpovika diacTipata 6a duvapwvel n pia ekTEAEON Kal
0€ Kkanoia AAa n aAAn exTeAeon.

Na anoBnkeUoETE TO £pYO.
Na EaydayeTe To apyeio o€ HopPr .mp3

Na kAeioeTe To Audacity.
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®YANO EPrAziAz N.4.3.M6
Xpnon EmnpoaBsTwv EpyaAsinv

Ti1 6a padoupe onpepa:
© Na yxpnoigonoloUue To epyaieio dakehog (Envelop)
© Na dnuioupyoUue Podcast.

ApaoTnpioTnTeC EUnédmwong

>’ auTtd To PUAAO £pyaciac, Ba XpnOILONOINCETE ONUEIa EAEYXOU YIa AUEOUEIWON TNG EVTACNG

TOU

AXOU Kal Ba ouvOUAOETE apyeia PE POUOIKN Kal OMIANIA WOTE va ONUIOUPYNOETE €va

Podcast.

1.

Na avoieTte To Aoyiopikd eneEepyaaiag nxou Audacity, evronifovrag To €IKovidio
oTnv enipaveia epyaoiac i avalnTwvrac To oTo pevou Start .

Na eicayayete T1a apxeia iPhone 7 Jet Black.mp3 ka1 iPhone 7 Sound.mp3
(File>Import>Audio).

Na evronioete oTo kavaAl iPhone 7 Jet Black xpovikéc nepiddoug 6mou dev UNAPXE!
OpMIAia.

Na peTaBeite oTnVv nNpwTN NeEPIodO MOU EVTOMICATE KAl XPNOIMOMNOIWVTAG TO €PYAAEIO
(pakehoc, va dnuioupynosTe dUo onueia eAéyxou oTo kavaAl iPhone 7 Sound nou va oag
EMITPENOUV va QUVAPWOETE TNV EVTACT TOU NXOoU, HOAIC oTapaTta n opiAia.

Na onuioupynoste dA\a duo onueia e\éyxou oTo kavaMl iPhone 7 Sound nou va oag
EMITPENOUV VA HEIWOETE TNV EVTACN TOU fXoU OTav n opiAia &ekiva Eava.

Na enavaAdBete Ta nponyoUpeva o OAEG TIG XPOVIKEG OTIYHEG NMOU evTonioaTe OTI dev
unapyel opiAia.

Na anobnkeuoeTe To €pyo (File Save Project As...).

Na e€ayayete To apxeio os popery .mp3 (File Export Audio... kal va emBeBaiwoeTe OTI
oTnv nepioxn Save as type: ypagel mp3).

Na kAcioeTe To AoyIopIKO eneEepyaaiag nxou Audacity.
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.4 Aoyiopiko Eqpappoymv r.4.3.M6

ApaoTtnpioTnTeg AEI0AOYNONG

10. Na avoi&ete To Audacity, va sioayayete Ta apxeia Background Music.mp3 kai Ricky,
Steve and Karl.mp3

11. Na XpnOIMOMOINOETE TO €PYAAEio TNC XPOVIKNG METATOMIONG, YIA VA MWETAKIVOETE TO
kavaMi Ricky, Steve and Karl, €101 woTe va Eekiva nepinou oTo 150 deuTEPOAENTO.

12. Na XpnoIHJOnoINCETE TOV (PAKENO KAl VA (PPOVTIOETE ETCI WOTE WEXPI TO GNMEIO Nou Eekiva
To kavahl Ricky, Steve and Karl va akoUyetar og uwnAn évraon To kavaAi Background
Music, evw POAIC EEKIVOOUV 01 OJIANTEC, N £VTAON va XAUNAQVEL.

13. Na enavalaBete Tnv idia diadikacia o€ kABe Navon TWV OJIANTWV.

14. Na anoBnkeUoETE TO £pYO.

15. Na eEayayeTe 1o apxeio o€ HopPry .mp3

16. Na kAcioete To Audacity.

+ Eninp6o0eTec ApaoTnpiéTnTEG

17. Na avoiéete 1o Audacity kai va sicayayete Ta apxeia iPhone 7 Jet Black.mp3 «kai
iPhone 7 Sound.mp3

18. Na evronioeTe oTo kavaMl iPhone 7 Jet Black xpovikéc mepiOdoUG OMou Oev UMNAPXEI
ouiNia. Tia autég TG NePIodouG va QUVAPWOETE TNV €vTaon Tou NXOU TOU KavaAiou
iPhone 7 Sound, evw yia Tnv unodloinn XPovikn nepiodo Mou Undpxel OodiIAia va
KPATNOETE TNV €vtacn Tou kavaAiou iPhone 7 Sound g€ noAu xaunAo eninedo.

19. Na anoBnkeUoETE TO £pYO.

20. Na eEayayeTe To apyeio o€ popepn .mp3

21. Na kAeioeTe T0 Audacity.
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®YAAO EPraziAz IN.4.3.M7
Xpnon EmnpoaBeTwv EpyaAsinv

Ti1 6a padoupe onpepa:
© Na xpnoigornoloUpe Ta epyaisia diaxwpiopou KavaAioU anod oTePEOPWVIKO (Stereo) o€ HOVOPWVIKO
(Mono) kai avTioTpo®a, Yid va agaipoUpe Ta Adyia anod €va Tpayoudl.

ApaoTnpioTnTeC EUnédmwong

>T0 QUAAO gpyaciac auTto Ba apaipeosTe Aoyia ano Tpayoudl.

1. Na avoifeTe To AoylopIkO ene€epyaaiac fxou Audacity, evroniovrac To €ikovidlo
oTnv enipaveia epyaaiag i avalnTwvTag To aTo pevou Start .

2. Na sioayayete 10 apyeio I Won't Give Up.mp3 (File-> Import->Audio).

3. Na akouoeTe MEPOC Tou TpayoudioU, €IOIKA OTNV apxn kai OoTo TEAOC, yia va
eMPBeBaIWOETE TNV UNApEN TNG PWVNAG TOU TPAyoudIioTH.

4. Na diaxwpioete To kavahl o€ dUo EexwploTd kavahia. Avaloya e Tnv €kdoan Tou
Audacity nou xpnoiyonoleiTe, ynopei va unapyel eninpocBeta n emioyn Split Stereo to
Mono. Av dev unapyel, eNINEETe TNV nidoyn Split Stereo Track.

5. Na eniBeBaiwoeTe 0TI Kal oTa dUo kavaAia gival emAeypevn n emidoyn Mono. Av Oev eival,
va enAeEETE Mono kal aTa dUo kavaAia.

6. Na emAEEeTe 0AOKANPO TO €va and Ta dUo kavaAia.
7. Na avmioTpéyete To kavahl (Effect - Invert).

8. Na akoUoeTe pEPOG Tou Tpayoudiou, €I0IKA OTNV apxn kal oTo TEAOG, yia va
ENBERAIWOETE TNV APAIPECN TNG PWVAC Tou TpayoudioTr. MNa va e\eyEeTe nou unnpxe
(PWVN NPONYOUHEVWC, UMOPEITE VA AKOUOETE OVO TO £va KAVAAI.

9. Na oulnTAOoETE TO ANOTEAECKA E TOV KaBnynTh/Tpia oac.

10. Na anoBnkeloeTe To €pyo (File Save Project As...).
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4.3 Eng&epyaoia Hyou r.4.3.mM7

11.

12.

Na e€ayayete To apxeio os popopn .mp3 (File Export Audio... kal va emBeBalwoeTe OTI
oTnv nepioxn Save as type: ypagel mp3).

Na kAcioeTe To AoyIopIKO ene€epyaaiac rixou Audacity.

ApaoTtnpioTnTeg ASI0AOYNONG

13.

14.

15.

16.

17.

Na avoi&eTte To Audacity, va eicayayete To apxeio Ouuapal.mp3
Na aQaipETETe TN WV TOU TPayoudioTr anod To apxeio.

Na anoBnkeUoETE TO £pYO.

Na e€ayayeTe To apyeio o€ popPpr .mp3

Na kAeioeTe To Audacity.

“+ Eninpoo0eTec ApaoTnpioTnTEC

18.

19.

20.

21.

22,

Na kaTeBAcETE €va apxeio HOUOIKNG anod To d1adikTuo.
Na apaipEgeTe TN PwvN Tou TpayoudioTn anod To apxeio.
Na anobnkeUoETE TO €pYO.

Na e€ayayeTe To apxeio o€ YopPpr| .mp3

Na kAeioeTe To Audacity.
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4.4 EneEepyaocia Eikovag
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®vAn0 EPraziaz N.4.4.M1-M2
Baogikég AsiTtoupyiec EneEepyaaiag Eikovag

Ti 6a padoupe onpepa:

© Na dnuioupyoUpe pia gikdva

© Na anoBnkeUoupe/eEayoupe pia eikova

© Na eil0dyoupe pia gikdva

© Na dnuioupyoUpe diapdaveia

© Na aA\aloupe TIC anoxpwael§ Piag eIkovac,.

ApaoTnpioTnTeg EUnédwong

2710 QUANO epyaciag auto, Ba PETATPEWETE Hia €1KOVA O AoNpOPaupn, OMWE Ba KpaTroeTe
kanola onueia eyxpwpa. a va 1o NETUXETE AuTO, NPENEl va EXETE dUO avTiypagpa Tou idlou
layer Tng eikovacg. To layer nou eival pnpoota BOa yivel aonpopaupo evw To nicw 6a
napapeivel &yxpwpo. Aiaypdgovrtac oto npwTto layer (aonpduaupo) kanoia onpeia, Oa
eugavitetal To layer nou Bpiokeral and niow, kai €ival n idla €ikova pe Xpwpa. ETol Ta
onueia nou Ba diaypageTe Ba yivovTtal eyxpwpa. Eniong Ba xpeiaoTei va aAAgeTe To XpwHa
KAMoIwV avTIKEILEVWV.

1. Na evronioete TO npoypappa GIMP oTov unoAoyioTi 04a¢ kal va To
EVEPYOIOINOETE.

2. Na avoi&ete Tnv eikova Hill.jpg (Ano To pevou File emA&ETe Open).
3. Na avTiypayete To Layer Tng eikovag (Layer->Duplicate Layer).

4. Na petatpeyete To véo Layer o aonpopaupo. (Colors->Desaturate...). AokIJAoTe va
aMa&ete TG emAoyeg Lightness, Luminosity, Average kal kpaTnoTe auTrh nou divel TO
KaAUTEPO anoTEAECa.

5. Na npoob¢éoete diapavela oTo aonpopaupo Layer (Layer->Transparency->Add Alpha
Channel).

6. Aev avapeveral va deiTe kanoia alayn otnyv €ikova. H diapaveia yiverar avtiAnnTr oTav
OlaypAWeTe €va MEPOC TNG €lIkOvac. TOTe, avti va eugavioTei 0 kapPag (m.x. A€ukn
KOAAQ), ep@avifovTal TETpaywvakia nou dnAmvouv To Kevo. AuTO 0dg emiTpénel va JeiTe
(av unapyel) Tnv ikdva nou BpiokeTal oTo Niow HEPOC,.

83
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7.

10.

11.

12.

Na xpnoiponoinosTe diapopa epyaleia yia va diaypdyweTe Tov oupavo oTnv aonpouaupn
eikdva, £TO1 WOTE va PaiveTal 0 oupavog TNG EYXPWHNG
€lkdvag nou BpiokeTal nNiow ano Tnv acnpopaupn.

MnopeiTe va XPNOIKOMNOINOETE TO «ORNOTNHPI» & xai

va KAveTe KAIK aTnV nePIoxn nou BEAETE va diaypayeTe

N Ta epyaleia emAoyng  yia va enmIAEEETe  pia

HEYAAUTEPN MEPIOXN Kal, OTN OUVEXEIA, va Tn dlaypdyeTe Xpnoigonolnvrag To Delete
0TO NANKTPOAGYIO OaG.

3TNV nepinTwon nou OlaypAWeTe KATI kaTtd AGOOC, WMOPEITE va TO ENAVAPEPETE
emAeyovrac avaipeon (Edit>Undo) | av Oev eival PIKTO/BOAIKO, HMNOPEITE va
XPNOILOMOINCOETE TO «OBNOTHPI» O OUVOUAOHO ME TO MARKTPO alt oTo nNAnkTpoAdylo
0ag, yia va avaipeoeTe Tn diaypagr).

MnopeiTe, akOua, NaTwvtag navw oTa «PaTakia» nou Bpiockovral oTo napdbupo Twv
Layers va euQAavioeTe ) va KPUWETE kanolo Layer, yia va eAeyEeTe Tn OOUAEIG oac.

Na avoi&ete Tn deUTepn eikdva Car.png (Anod 1o pevou File emAEETe Open).

Ano Tn deUTepn AUTN €IKOvVa €vOIAPEPEl TO AUTOKIVATO Kal Oxl TO PpOvTo. Oa npéEnel,

AoInov, va xpnolhonoinosTe Ta epyaleia eniAoyng , YO va emAEEeTE
TO AUTOKIVNTO I VA aQaIpECETE TO POVTO.

M£6030c¢ 1: MNopeiTe va eMNIAEEETE TO QUTOKIVITO, XPNOIMONOIGVTAC TO «Adoo» & . To
epyaleio auTtd odg enmiTpénel va emINEEETE ia nepioxr), oxedialovtag Tnv aTnv obovn.
Mnopeite, Aoindv, va oxedIAoETE TO NEPIYPAMA TOU AUTOKIVATOU, YIQ VA TO EMIAEEETE.
AuTo Oev €ival avaykn va yivel pe dia npoondbeia. Mnopeite va eMAEEETE pia nepioxn,
Kal, 0TN OUVEXEId, NATWVTAC TO NANKTPO Shift 0To NANKTPOAOYIO 0AG va NPOCHECETE Wia
OeUTEPN N KaI TPITN, MEXPI Va EMIAEEETE OAOKANPN TNV NEPIOXN MOU BEAETE. Z€ NePinTwon
AGBouc, PnopeiTe va xpnoiPonoinoeTe To NANkTpo Ctrl,

YIa va a@aipEcETe Wia emAoyn.

M£B8odoc¢ 2: MnopeiTe NANI Pe Ta epyaleia emAoyng va

EMNEEETE TO KOMWATI Mou AEN OéANeTe kal va To

dlaypayeTte pe To NANKTpo Delete oTo mANKTpoAOyIo

oac. Evvoeital 0T pnopeite va diaypa®eTe £va npog Eva

MIKPG KOMMATIA MEXP!I va (QTACETE OTO OnMeEio nou

BENETE. ZTNV NEPINTWON MOU KAVETE AABOG Kal OIayPAYETE €va KOUUATI Mou OEAETE,
MMOpEITE va Xpnoidonoinoete Tnv avaipeon (Undo).
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4.4 Ens&epyaocia Eikovag r.4.4.M1-m2

13. Na avTiypdyete Tnv eikova (Edit->Copy).

14. Na Tnv enikoAAROETE GTNV NpwTnN €ikova pe To Adgo (Edit->Paste as>New Layer).

15. Na aA\GEETe TO XpwHa TOU QUTOKIVATOU OE XpwHa TNG EMIAOYNG 0ac.

16. MNa va 1o KAveTe auto, Ba npeEnel va XPNOILOMOINCETE TO €PyaAsio i Foreground
Select. Mpiv &kiviioeTe Tn diadikacia, eMIBEPAIWOTE OTI EXETE €MIAEYPEVO TO Layer nou
NEPIEXEI TO AUTOKIVNTO Kal OXI OTIOANOTE AAAO.

17. To epyakeio auTd Aeiroupyei o€ dUo Bruara.

270 NPWTO PBRHAa, npénel va oxedIdOETE €va nepiypagpa nou va nepikAeiel (0x1 He
akpipeia) To PEPOC TNG €IKOVAC Nou BENETE va aAMNAEETE. Ma TNV CUYKEKPIMEVN AOKNON,
Ba npenel va nepikAgiel OAa Ta KOKKIVA PEPN TOU QUTOKIVITOU.

270 deUTEPO BRHA, Npenel va BoupToioeTe (LUAUPIOETE) TO PEPOG TOU AVTIKEIUEVOU TOU
ornoiou To xpwHa BéAeTe va aMa&ete. Ma Tnv OUyKekpipévn dAoknon, 6a npénel va
BoupTaioeTe PEPOG TNG KOKKIVNG MNOYIAG. Av HE TO NPWTO BoUPTOIONA WHEIVOUV KAMOIES
NEPIOXEC EKTOC, DOKIPAOTE Kal OeUTEPN Ppopd To BoupTaioua.

18. ZTnV NePINTWON Mou €nIAeyei PEPOC Nou dev XPeIGleoTe, WMOPEITE VA XPNOIKOMNOINOETE
Ctrl ka1 BoUpTOIOWa, YIa VO APAIPECETE Wia NePIOXN.

19. 'OTav TeAelwoeTe, NATAOTE TO Enter oTo NANKTPOAOYIO 0ac.
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r.4.4.M1-m2 4 Aoyiopiko Eqpappoy®v

20. Anod T0 pevou Colors eniAéETe Hue Saturation kai aAAadovTtac TIG TIHEG oTO nNapdbupo Ba
O€iTE TO XPWHA TOU AUTOKIVATOU va aAadgl.

21. Na anoBnkeUOETE TNV €IKOVA OTOV (PAKEAO 0AC.

ApaoTnpioTnreg ASI0AOYNONG

22. KaAeioTe va dnUIOUPYNOETE Wia €IkOva
yla €va npoidv kabapiopou micivag. Zag
divetar pia @wToypagia (GreenPool)
giag npaoivng nioivag kai n douAeld oag
gival va avadei&eTe TO Mpoidv kal Tnv
IkavoTnTa Kabapiopou Tou vepoU nou
Ola6eTel. To TeAkO anoTéAeopa Ba
npénel va Molalel Pe TNV nNapakaTw
eikova.

“+ Eninpoo0eTec ApaoTnpioTnTEC

23. Na avoifete Tnv eikova sunflower.

24. Na aA\G€eTe Ta xpwpaTa oTnv €IKOVA, ETOI WOTE va
g€ival aonpopaupn €KTOC anod To KiTPIVO PEPOG, TO
0noio va aA\GEeTe o XpwHa TNE EMNIAOYNG 0dc,
Onw¢ 0To Napadelyla.
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®yYArO EPraziAz N.4.4.M3
MoioTnTa ka1 Méyebog Eikovacg

Ti 6a padoupe onpepa:

© Na avayvwpifoupe Tn dlapopd PETAEU NoloTNTAC Kal JEYEBOUC EIKOVAC

© Na avayvwpiloupe TNV ENNTWON Nou €XEl N NoIOTNTA Kal TO PHEYEBOC avaloya PE Tn Xpron
© Na eniAéyoupe kaTaAnAn noloTnTa-peyebog eikovag avaloya pPe Tn Xpion

© Na aA\aloupe To péyedog €1kOvac,

ApaoTnpioTnTeg EUnédmwong

1. Na avoi&ete Tov @akeAo FE3 kal va ouunAnNpwaoETe Tov Mo KATw nivakd. Ma va OeiTe TIC
nANPoQopiec nou {nTouvTal, NaTtnoTe Oe&i KAIK NAvw OTO KABE €va anod Ta apxeia Kai
BpeiTe To péyeboc oTnv kKapTeAa General kal TIG dIA0TACEIC oTNV kapTéAa Details.

'Ovopa Apxeiou Meyebog (MB) MAaTtog (Pixels) "Yyog (Pixels)

Sunsetl.png

Sunset2.png

Sunset3.png

Sunset4.png

2. TNoia eikova ep@avileTal aTnv 000vn PE TO HIKPOTEPO (PUOIKO) HEyEDOC;
(a) Sunsetl.png

(B) Sunset2.png
(y) Sunset3.png
(0) Sunset4.png
(e) 'OAeg 1o idI0
3. MMoia sikova €xel TO HIKPOTEPO HEYEDOG apyeiou;
(a) Sunsetl.png

(B) Sunset2.png
(y) Sunset3.png
(6) Sunset4.png
(e) 'OAeg 1o idI0

4. Moia eikdva spgaviletal oTnv 000vn 0ag Ke Tn XEIPOTEPN NOIOTNTA;
(a) Sunsetl.png

(B) Sunset2.png
(y) Sunset3.png
(6) Sunset4.png
(e) 'OAeg 1o idI0

87




r.4.4.M3 4 Aoyiopiko Eqpappoy®v

5.

10.

11.

Av peyaAwOoEeTe Pe Zoom TIG €IKOVEG £TOI WOTE va (aivovtal OAeg aTo idlo (nepinou)
PuUOIKO pEyeBOC, noia spgavileTal oTnv 000vn 0ac e Tn XEIPOTEPN NOIOTNTA;
(a) Sunsetl.png

(B) Sunset2.png
(y) Sunset3.png
() Sunset4.png
(g) 'OAec 1o idI0

Av cixate pia 08dvn oTo PEYEBOC TOU ToiXoU TNG TAENG oac kal BEAaTte va BAAETE wG
€1KOvVa (pOVTOU TNV Mo Navw PwToypadia, noia 8a ATav n KataAAnAoTepPnN;

(a) Sunsetl.png

(B) Sunset2.png

(Y) Sunset3.png

() Sunset4.png

(e) 'OAeg 1o idI0

2ag nTNOnke anod To OXOAEIO va PEPETE Wia pwToypaPia o€ NAEKTPOVIKN Hop@n, Yia va
xpnolponoinBei yia Tnv €kdoon kapTag Aew@opeiou. Moia puBuion Ba enIAéyaTte oTn
(PWTOYPAPIKN MNXaVA/KIVNTO Nou agopd oTnv availuon TnG pwToypapiac;

(a) 2MP

(B) 3MP

(y) 4MP

(6) 5MP

(e) TN MeyaAUTepn duvatn

>ac {NTNOnNKe and TO OXOAEI0 va QEPETE Mia pwToypa®ia and KAmnoia ekOpPOoUr Tou
OXOAEiOU OTNV 0nNoia CUMMETEIXATE KAl €0€IC, yIa va el wG 0AOCEAIDN pwToypaPia aTo
nePIodIKO Tou oxoAciou. Moia puBuIon Ba enIAéyaTe oTn GWTOYPAPIKN PNXAVH/KIVNTO
nou agopa oTnv avaiuon Tng GwToypagiagc;

(a) 4MP

(B) 8mP
(y) 12MP
(6) 16MP
(e) Tn peyaAUTepn duvatn

Na avoifeTe To AoyIopIko eneEepyaaiag ikovag GIMP.
Na avoifeTte Tnv €ikova C76.png

Na al\a€ete To peyebog TG €ikovag kai and 1680X1050 nou eivali, va TO KAVETE
1024X640. MNa va To KAveTe auTo, €MAEETE and To Wevou Image Tnv emidoyry Scale

88



4.4 Ens&epyaocia Eikovag r.4.4.M3

12.

13.

14.

15.

16.

Image. ZTn ouvéxela, dlopBwaTeE TIC TIHES Yia Ta nedia Width kar Height kai natnoTe oTo
Scale.

Na anoBnkeuoeTe TV €ikdva pe ovopa C76_1.png

Ano 1o pevou Edit eniAéEte Undo Scale Image, yia va enaveldel n €ikOva oTo apxikod
NG péyedoc.

Na aMda€ete 1o péyeBoc TnG eikovac kal and 1680X1050 nou e€ival, va TO KAVETE
420X263.

Na anoBnkeuoeTe TNV €ikdva pe ovoua C76_2.png

‘Eva kivnTd TNAEPwVOo €xel 00ovn pe avaiuon 1080x1920. Moia sikdva and Tic duo Ba
ATav n kKataAAnAGTEPN, yia va XpnoihonoinBei wg eikova (povTou;

ApaoTnpioTnreg ASI0A0YNONG

17.

18.

19.

Na avoi&ete Tnv eikdva Sam.jpg

Na Tng aMagete To peyebog oe 480X480, yia va pnopei va Tunwbei we pwToypagia
TQUTOTNTAC.

Na Tnv anobnkeloeTe e ovoua Sam_1.jpg

+ Eninp6o0eTec ApaoTnpiéTnTEG

20.

Na avoiete TOov (pdkeho oTov onoio anobnkeloate TIG ekoveg C76_1.png Kai
C76_2.png kai va anavtnoeTe oTIG Mo KATW EPWTNOEIG:

(a) Moia sikova epgavieTal peyaAuTepn oTn 000vn;

(B) Moia sikOva &xel TO HIKPOTEPO pEYEDOC O€ Bytes;

ApaoTnpIOTNTEG YIA TO ZNiTI

21.

22,

Na eAéy&ete TNV 000vNn Tou unoAoyioTh 0ag kai va PBpeite TN WEyloTn availuon nou
MMOpPEi va unooTnpiel.

Na Bpeite pia pwToypagia oTo diadikTuo, yid va xpnoidonoindei wg eikdova povTou, nou
va eKPETAAEUETAl OAEG TIC OUVATOTNTEG TNG 000vVNG. Av BpeiTe elkdva peyallTepn, TOTE
va TNG aAaEeTe To PEyEBOC, yia va CUMNINTEI JE AUTO TNG 0BOVNG.
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®YAAO EPraziAz M.4.4.M4
EmnpooOereg Asitoupyiec EneEepyaaiag Eikovacg

Ti1 6a padoupe onpepa:

© Na xpnoigonoloUpe To epyaisio NpooBrkng Kelpévou

© Na gpgavifoupe/anokpUnToupe Ta enineda (Layers)

© Na enIAéyoupe YEPOC TNG GwTOYPAPIag Ye Baon To Xpwua

© Na avTiypd@oupE Kal va enikoANOUHE PEPOC TNG pwToYpaAPiac,.

ApaoTnpioTnTeg EUnédmwong

1. Na avoieTe Tnv eikova CoffeeBeans.jpg

2. XpnoigonolwvTag To epyaieio Text Tool A, va ypayete To keigevo «Coffee House».

To epyaieio Text Tool dOnuioupyei éva veéo Layer oTo onoio MPOCTIBETAl TO KEIWEVO.
MapaAAnAa, avoiyouv duo napabupa enidoywv. To €va akpiBwg navw and To KeipeVo
nou NANKTPOAOYEITE Kal To OeUTEPO OTA ApIOTEPQ.

3. XpnolgoroiNoTe TN YPAUMR €pyaleiwv nou epgavileTal navw and TO KEIYEVO MOU
NANKTPOAOYEITE, yia va aAAEETE TO HEYEDOC TWV YPAUMATWY Kal va EPAPHOCETE EVTOVN
kal nAdyia ypagn. Ynevlupiletal OTI yia va KAveTe aA\ayEC oTa ypauuaTta, Npenel va ta
EMINEEETE.

4. XpnolgonoInoTe TN YPAUKN €pYaAEiwv Nou ep@avileTal oTa apioTepd, yia va EPApHOCETE
oToixion oTo kévtpo (Centered).

5. XpnoigonoinoTte To €pyaieio Move Tool ‘%B’, yla va HETAKIVAOETE TO KEIPNEVO 0ag OTo
navw HEPOG TNG €IKOVAG. A va HPMNOPECETE va HETAKIVIOETE TO KEiPEVO, MpPENEl va
NaTnNoETE NAvw O€ KAMNOoIo anod Ta ypauuara.

6. Na avoifete Tnv eikdva CoffeeCup.jpg kal va aA\a&ete To peyeboc TN (Image->Scale
Image...) o€ 2028 X 1527.

7. Na avTiypayeTe Tnv €ikova.

8. Na Tnv enikoA\noTe wc¢ véo Layer atnyv eikova CoffeeBeans (Edit->Paste As>New Layer)
kal va kAeioeTe Tnv eikova CoffeeCup.jpg Xwpic va Tnv anoBnkeUOETE. Z€ AUTO TO ONHEIO
npénel va €xeTe Tpia Layers otnv eikova CoffeeBeans.jpg
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4.4 Ens&epyaocia Eikovag r.4.4.M4

9. XpnoIPONOIWVTAG TA «UATAKIA®», VA anokpUWETE Ta aAAa duo layers kal va apnoeTe va
(paiveral povo To Layer Coffee House.

10. Na enmiBepaiwoeTe OTI €XeTE enmAeyuévo To Layer Coffee House kal XpnoidonoimvTac To
epyaAeio Select by Color ~f , va enINe€eTe Ta ypappata Tne Ae€nc Coffee House.
To epyaleio Select by Color eniAéyel Un OUVEXOUEVEC MEPIOXEC MOU €XOUV TO idIO
Xpwia. Mnopeite va enAéEeTe €va and Ta ypdupaTa kal autopaTa 8a enAeyouv kai Ta
undAoina, agou OAa €xouv TO idI0 XpwHa.

11. ApoU eniAéEeTe OAa Ta ypdupara, va anokpuwete (Ye Ta patdkia) To Layer Coffee
House kai va gpgavioeTte 1o Layer CoffeeBeans.

12. Na eniBeBaiwoeTte 0TI £XeTe enAeypévo To Layer CoffeeBeans kal va avTiypdyeTte Tnv
emieypevn nepioxn (Edit->Copy).

13. An6 1O pPevou Select va eniAé€eTe None, yia va €EapavioTei TO NeEPiypappa TnNG
EMAEYHEVNG NEPIOXNG.

14. Na XpnoIhOMoINOETE Ta «PaTdkia», yia va kpuwete To Layer CoffeeBeans kai va
ed@avioete To Layer Clipboard (CoffeeCup).

15. Ano To Pevou Edit va eniAéEeTe Paste As->New Layer.

16. Na PETAKIVIOETE TO KEIEVO OE OMNOIO ONEio BEAETE €0EiG,.

17. Na anoBnkeloeTe Tnv €ikova pe ovopa Coffee House.jpg

ApaoTtnpioTnTeG AEI0AOYNONG

18. Na avoi&eTe TIG eIkOveG Sky.jpg kal Sea.jpg

19. Na aA\a&eTe TO péyebog TN eikdvac Sea.jpg £T01 WOTE va gival To id10 e To PEyeBog
NG eikovac Sky.jpg

20. XTnv eikova SKy.jpg va npoobeoeTe TO Keipevo «Deep blue...».
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r.4.4.M4 4 Aoyiopiko Eqpappoy®v
21. Na peyaAwOETE apKETA TO KEIMEVO 0AC yia va €ival euavayvwoTo Kal va epapuOCETE
£VTovn YPa®n Kai aToiXion oTo KEVTPO.

22. Na PETAKIVIOETE TO Keipevd oac navw oTo ypacidl TNG €IKOVAC £TOI ONWC (paiveral oTnv
Mo KATw €IKOva.

23. Na kavete OAa Ta anapaitnTa BAKATa 701 WOTE OTAV AVTIYPAWETE TO KEIPEVO 0AG OTNV
€lkova Sea.jpg va (paiveral onwe nio KATw.

24. Na anoBnkeUoETe TNV €IKOVA 0AC.

“+ Eninpoo6eTec ApaoTnpioTnTEC

25. 210 nAQiolo €vOg MpoypaupaTog nou AduBavel JEPOG TO OXOAEi0 0ag, €XeTe KANBei va
ONMIOUPYNOETE Hia ETIKETA yld €va WMOUKAAI TOo ornoio 6a OwoeTe wG dWPO OTOUG
KaAEOUEVOUC OaC.

(a) H eTikéTa Ba npénel va €xel unkog 10 ekatooTa kal nAAaTog 3.
(B) ©a npenel va deixvel pia pwToypagia Tng NOANG n Tou oxoAgiou oac.

(y) ©a npenel va ep@avifeTal To Ovopa Tou GXOAEioU 0ag kal n GXoAIKr Xpovia navw
oTNV €TIKETA

(0) Na Bpeite kataAnAn/eg €ikdva/ec and To OIadikTUO Kal va ONUIOUPYROETE TNV
ETIKETA.

(¢) 'Eva napadeiypa diveTal napakaTw.
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®yYANO EPraziAz N.4.4.M5
Eqappoyn @&

Ti 6a padoupe onpepa:
© Na xpnoigonoloUue To epyaAeio eAelBepnc emihoyn (Free Select Tool)
© Na epappoloupe e ot enineda (Layer).

ApaoTnpioTnTeCG EUnédmwong

2KOMOG TNG AOKNONG AUTNG €ival n agaipeon ateAeiwv anod €va npoowno. Ynapyouv dIApopeS
TEXVIKEC, YIO VA YiVEl aUuTO Kal Jia ano OAeG opilel va epappooTolv diIapopa PIATPa O PEPOC
Tou npoownou. O1 aA\ayeg nou Ba yivouv Ba npénel va Pnv €ival PQaveic, £T01 WOTE va Pnv
qaiveTal 0TI N pwWTOypaPia €xel unooTei ene€epyaania. ZTnv aoknon auTt 6a NapouciaoTEi
MEPOC TNC HEBODOOU, WOTE TO TEAIKO anoTéAeopa Ba ¢aivetTal aAnBivo We TNV NpwTn KaTia,
aAlAa av To del KAnolog NPOCEKTIKA Ba Pnopei va kataAdaBel 0TI N pwToypaPia Exel UNOCTEI
ene€epyaoia. Ma Tnv nAnpn HEBODO HNOPEITE va ENIOKEPTEITE TOV NAPAKATW OUVOECHO:
https://www.youtube.com/watch?v=FHu-Ao24Ixo

1. Na avoiTe TV eikova Girl.jpg
2. Na xpnoigonoinoete To epyakeio Free Select Tool ﬁj, yIa va €nIAEEETE TO NPOCWNO TNG
KonéAag,.

Me T0 epyakeio Free Select Tool pnopeite va oxedIQoeTe Eva Nepiypappa yupw and tnv
neploxn nou BEAeTE va eMIAEEETE 1) va nNaTaTe d1adoxIka O€ KOVTIVA onueia apioTePO KAIK
Kal va NPOoXWPEITE ENMIAEYOVTAG MIKPO KOUMATI KGO popd.

3. And Tnv emAoyr oac Ba npénel va agaipeCETE TA ONMUEId TOU NPOCMMOU MOU EXOUV
«ywvieg» N paANid kai ival Ta epudia, Ta PdTia, JEPOG TNG HUTNG Kal TO OTOMA.

4. A@oU TeAeIWOeTe PE TNV €mAoyr Tou npoownou (Bnua 2), 6a npenel, KpATWVTAG
natnuévo To nNANkTpo Ctrl, va oxedidoeTe £va nepiypapua yupw ano Tnv nePIOXn rnou
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https://www.youtube.com/watch?v=FHu-Ao24lxo

r.4.4.M5 4 Aoyiopiko Eqpappoy®v

BENETE va apaipeoeTe anod Tnv enidoyn oac. 'Evac deUTePOG TPOMNOG €ival va NATNOETE
oTo nAnkTpo Ctrl kal apioTepO KAIK OTO NPWTO ONMEI0 TNG EMNIAOYNAC 0AC, OTN CUVEXEIQ,
va apnoeTe 1o NANKTpo Ctrl kal va ouvexiosTe Pe apioTepd KAIK oTa unodloina onueia
MEXP!I VA OXNKATIOTEI N NePIOXN NOU BENETE va aPaIPECETE.

5. Na avTtiypawere Tnv €mAoyn Kal va Tnv €nIKOANAOETE w¢ veéo Layer (Paste As...>New
Layer).

Av pe Tnv €nmiIAoyn auTn To veo Layer eugavileTal JETATOMIOPEVO, AVAIPEDTE TNV EVEPYEIQ
0ag kai dokiydoTe anAr enikoAAnon (Paste) kai oTnv nepioxn Layers natnote Oe&i KAk
oTo «Floating Selection (Pasted Layer)» kai emA\eETe «To New Layer».

6. XpnolPonolwvTac Ta <«HATAKIa», va anokpUwete To Layer Girl.jpg kai agnoTte va
paivetal To veo Layer.

7. Na emBeBaiwoere OTI OTnV neploxn Layers &ExeTe eniAeydévo To véo Layer kai va
EQAPUOCETE 0€ auTo To PiATpo Gaussian Blur (Filters—>Blur->Gaussian Blur...).

8. Na aMd&ete TG pubpioeic yia Tnv emiAoyr| Horizontal kar Vertical o 20 kal va naTroeTe
OK.

9. Na epgavioete naM To Layer Girl.jpg kai va d&iTe TO anoTEAECHA.

10. Mnopeite (dokINAOTE) va epapupooeTe &ava To idlo @iATpo (Filters>Repeat “Gaussian
Blur”) kai deite To anotéAeopa. BePaiwBeite OTI (paivovral kai Ta dUo Layers, aA\d
€MAEYPEVO €ival To VEO Layer.

11. Na anoBnkeloeTe TN PwTOYPAPIa.

ApaoTnpioTnTeG AEI0AOYNONG
12. Na avoieTe To npdypaupa GIMP kai, 0Tn CUVEXEIQ, va avoiEeTe Tnv eikova Couple.jpg.
13. XpnolpgonoiwvTag Ta £pyaAsia €niAOynG , va €nMINEEETE TO ayopl
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r.4.4 Ens&epyaocia Eikovag r.4.4.M5
Kal TO KOPITOl NouU (paivovTal aTnv €ikova.

YnevBupileTal 0TI n emAoyn pnopei va yivel aradiakd, xpnoidonoiwvrac To Shift, yia va
nNpooBeoeTe neploxn kai To Ctrl, yia va apaipéoeTe.

14. Na eniNé€ete Select->Invert yia va avrioTpagei n enidoyn oac. (Exete ndn emAéEel To
ayopl kal To Kopitol onoTav pe Tnv emdoyn Invert B6a emAéEeTe OAa Ta unoloina. Asv
NePINEVOURE va aAAaG&el TinoTa aTnv eikova).

15. Na epappooete To QiATpo Motion Blur otnv emiAeypévn nepioxn (Filters=>Blur->Motion
Blur).

16. To @iATpo Motion Blur pag divel 81APopeG eNINOYEG. MMOPEITE va NEIPANATIOTEITE PE TIG
EMIAOYEC KAl va KpATNOETE TENIKA AuTn nou Ba 0ag apéoel NEPICOOTEPO.

17. Na emAeEeTe Select->None, yia va a@aipebei n SIAKEKOUMEVN YPAUKN EMIAOYNG.

18. Na anoBnkeUoeTE TNV €IKOVA.
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r.4.4.M5

4 Aoyiopiko EQappoywv

“*+ EninpooBerec ApacTnpioTnTEC

19. Na avoi&eTe TV cikdva face.jpg

20. Na npoonadnosTe va KAveTe NIYOTEPO EUPAVEIG TIC ATEAEIEG TOU NPOCWIOU.
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®YANO EPrAZIAZ M.4.4.M6
Xpnon Layers

Ti 6a padoupe onpepa:
© Na xpnoigonoloUpe Layers.

ApaoTnpioTnTeg EUnédmong

1. Na avoiTe Tnv ikdva Portrait.jpg.

2. Na dnpioupynoeTe éva avtiypa®o Tou Layer Portrait.jpg kai va eKTEAECETE TIG UNOAOINEG
evepyeleg oto Layer Portrait.jpg copy.

3. Na eniAéEeTe To epyaleio paintbrush zr‘ .

4. Ano TIC pubuioeic Tou gpyaleiou nmou gugavidovral oTo KATw WEPOC, va eMAEEETE pia
BoupToa KUKAIKN WE EEBWPIAOUEVEG AKPEG,.

5. Na emAeEeTe €va xpwua yia Ta JaANid, n.X. KOKKIVO. ZTr OUVEXEId, va XPWHATIOETE T
MaAAIG pe To Xpwpa nou enmAeéEaTe. Ma TIG AenTouEpeieg (KOVTA OTO NpOCWNo ) oTa
auTIA) MNOPEITE VA PEIWOETE TO PEYEBOG TNG BoupToac.

[scoect rato I 0wt £

6. Na emAEEeTE éva Xpwpa yia Ta PaTia, n.X. NpAacivo, Kal va XpWHATIoETE Ta YdTia.

7. Na emAéEETE €va XpwHa yia Ta XeiAn, n.x. MwpB, kai va XpwuaTiosTe Ta XEiAN.
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r.4.4.M6 4 Aoyiopiko EQappoywv

8.

Na aM\a&ete Tnv kataoTtaon (Mode) Tou Layer o€ Overlay kal va J&iTe To anoTEAETHA.

Na anoBnkeuoeTe TNV ikdva.

ApaoTnpioTnTeg ASI0AOYNONG

10.

11.

Na avoiéeTte Tnv eikova emilia.jpg

Na aA\aGEeTe To xpwpa oTa JaANid, oTa PdaTia kai oTa XeiAn.

+ Eninpoo0erec ApaoTnpidTnTEG

12.

Na Bpeite pia wToypagia and 1o d1adikTuo N va XpnoILonoInoeTe kanola JIkr oag Kal
Va EPAPHOOETE AANAYEC OTO XpWHA HAAI®Y, HATIOV, XEINWV KAl pOUXWV.
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®YANO EPraziAz N.4.4.M7
Xpnon Layers

Ti 6a padoupe onpepa:
© Na xpnoigonoloUpe Layers.

ApaoTnpioTnTeg Enédmwong

>konog TNG AoKNoNng auTng ival va ouvduacTolv dUo pwToypapies Kal va ¢aiveral o1 n pia
{wypa®ilel TNV GAAN.

1.

7.

8.

Na avoiéete Tnv eikova bird.jpg kai hand_and_paper.jpg, xpnoipgonoiwvrag tnv
emAoyn File>0pen As Layers.... Na eniBeBaiwosTe OTI n O€Ipd €U@EAvIONG Twv layers
eival npwTa 1o hand_and_paper kai, oTn guvéxela, To bird.

Na npooftoste diapaveia oTiC dUo pwToypagiec (Layer->Transparency->Add Alpha
Channel).

XpNoIJOMoIWVTAC TA «MATAKIA», va anokpUWeTe To Layer «bird» kal va enAEEeTE TO
Layer «hand_and_paper».

Na emAeEeTe TN Acukn) nepioxn (xapTi) kai va Tn dlaypayeTe.

Na xpnoiponoinote 1o Fuzzy Select Tool *. AndO TIG pubuicelg Tou epyaleiou va
aM\a&ete 1o Threshold pExpl va pnopeite Pe €va kAIK, 0€ KAMOIO ONUeEio TNG AEUKNG
nePIOXNG, va Tnv €mAEEETE OAn. Telog, va natnoete Delete oTo nAnkTpoAdylo Kal
Select->None.

XpNOIKONOoIOVTAG Ta «UATAKIa», va ePpaviceTe To Layer «bird» kal va To YETAKIVAOETE
o€ Bgon TnG emIAoyng oag.

XpNOIKONOoIOVTAG Ta «uaTakia», va anokpUwete To Layer «hand_and_paper» kai va
eMAEEeTE TO Layer «bird».

Na dnpIoupynoeTe £va avTtiypago Tou Layer «bird» (Layer->Duplicate Layer).
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r.4.4.M7

4 Aoyiopiko EQappoywv

9. Na anokpUyeTe To Layer «bird copy» kal va emAEEETe To Layer «bird».

10. Na e@appdoste To @iIATpo Edge Kkal va KpatrnoeTeE TIC MPOEMIAEYUEVEG TIHEG

(Filters>Edge-Detect>Edge...).

11. Na avTioTpeyTe Ta Xpwpata (Colors>Invert).

12. Na peTatpeyeTe TN QpwToypapia o acnpopaupn. (Colors->Desaturate)

13. Na OnuioupynoTe éva véo Layer (Layer->New Layer) kai va enmiAé€ete White otnv

nepioxn Layer Fill Type.

©1 New Layer

=  Create a New Layer
[ird] imporzd)-5

Layer name: | Layer
Width: 1280
Height: %60

Layer Fill Type
() Foreground color
(O Background color
® e
O Transparency

x

[

Cancel

14. Na PETAKIVAOETE TO VEO Layer nou dnuIoupynoaTe, £T0I WOTE va €ival To TEAeuTaio Layer

oTn ogIpda.

15. Na emAe€te (av dev eival eniAeypévo) To Layer «bird».

16. Na aM\a&ete Tnv 1016TNTa Opacity o 50% kai Tnv kataoTtaon (Mode) Tou o€ Dissolve.
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4.4 Ens&epyaocia Eikovag r.4.4.M7

17. Na gppaviote 0Aa Ta Layers kal va enBERAIWCETE OTI EXETE eMIAEyYUEVO To Layer «bird
copy».

18. Na emAEETe TO «ZBNOTRPI KAl va dIaypAWETE TO KATW HEPOC TNG PWTOYPAPIAC.

19. Na anoBnkeloeTe TN PwTOYPAPIa.

ApaoTnpioTnreg ASI0AOYNONG

20. Na dnuioupynosTe avtiypago Tou Layer «hand_and_paper».

21. Na eniAé€te kal va dlaypayTe Tn OKIA TOU XEPIOU Kal Tou nivéhou oTo layer
«hand_and_paper copy».

22. Na aA\a€ete Tnv 1810TNTa Opacity Tou layer «hand_and_paper» o€ 50%.

23. Na aMda&ete 1o Contrast oto layer «hand_and_paper copy» (Colors->Brightness -
Contrast), ye oToxo va pn diapepel TO00 NOAU N PpWTOYPAPia ToU XEPIOU WE AUTH TOu
nanayaiou.

“+ Eninpoo0eTec ApaoTnpioTnTES

24. Na avoifete Tnv eikdva car.jpg kal va ONMIOUPYNOETE Kal va anobnkeUCETE Tnv
napakaTw €ikova.
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®YANO EPrAzIAZ MN.4.4.M8
To epyaA&io kKAwvonoinong

Ti 6a padoupe onpepa:
@ Na xpnoiponoloUpe To epyaieio kAwvonoinang (Clone Tool).

ApaoTnpioTnTeC EUnédmwong

>konog Tou PUANOU epyaaiac auTtou eival va xpnoigonolnoeTe To epyaieio Clone Tool, yia va
avTIYPAYETE €va aVTIKEIYEVO O pia pwToypagia.

ApaocTnpioTnTa A

1.

Na avoi&ete Tnv sikova FireHydrant.jpg

Na eniAé€eTe To epyaleio Clone Tool & kal va avTIypAWETE TOV NUPOCRETTIKO KPOUVO
o€ dINAavo onpEio TNG EIkOvac. To TENIKO anoTEAECKa NpeENel va Poladel e To Mo KATW.

To epyakeio Clone Tool Asitoupyei o€ dUo Bruara:

(a) KpatwvTtag natnuévo To NANkTpo Ctrl oTo MANKTPOAOYIO, va NATNAOETE GE KAMOIO
ONMEIO TOU NUPOOREDTIKOU KPOUVoU.

(B) Na apnoete To nAnkTpo Ctrl kal va natnoeTe (kalr KPpATNAOTE NATNHEVO) TO APIOTEPO
KAIK TOU NOVTIKIOU OTO GnEio nou BEAETE va avTiypaei n €ikova.

Na JETAKIVAOETE TO NOVTIKI kal va O&iTe va eU@avifeTal To avTioToIXo ONHEIO TNG apXIKNG
€lkOvag. Na OUVEXIOETE PEXPI Va OXNKATIOTEI OAOKANPN N €IKOVA.

MPOZOXH: Mpenel va OnUIOUPYNOETE TO avTiypa@o HE €va KAIK TOU MOVTIKIOU. Av
aQnoETE TO Kouuni kal naTnoeTe &ava, Ba &kivnoel n avTiypa®n ano To NPWTOo onuEio.

Na anoBnkeUoeTE TN QwTOYPAPIa.

ApaoTnpioTnta B

6.

Na avoi&eTe Tnv eikdva Dog.jpg kal va apalpéseTe Tov 0KUAO ano Tn GpwToypagia.
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4.4 Ens&epyaocia Eikovag r.4.4.M8

7. Na xpnoiponoinoere 1o Clone Tool, yia va avTiypayete PHEpog Tou ypaoidiou dinAa and
TOV OKUAO Kal va TO PETAPEPETE NAVW OTOV OKUAO, £TOI WOTE va TOV KPUWEL. To TEAIKO
anoTeEAeopa Npénel va poladel PE TO MNio KATw.

MPOZOXH: Av eniINéEeTe pia nepioxn MOAU Pakpid and Tov OKUAO TOTE TO XPWHA TOU
ypacidioU meavov va ivai diapopeTikO Kal va @aivetal n diagopd aTn GpwToypadia.

8. Na anoBnkeUoeTe TN PWTOYPAPIa.

ApacTnpioTnra I
9. Na avoi&eTe TV €ikova Moles.jpg kai va a@paipecETe TIC ENIEC ano To NPOCWO.

MPOXOXH: EMIAEETE NEPIOXEC KOVTA OTIC ENIEC, £TOI WOTE TA XPWHATA va €ival KOVTIVA
Kal To TEAIKO anoTeAeopa va gaivetal akndivo. To TeAIkO anoTEAeGUa nNpenel va Holadel
ME TO Mo KATW.

10. Na anoBnkeloeTe TN PWTOYPAPIa.

ApaoTnpioTnTeG AEIoAGYNONG

11. Na avoiéete TnVv eikova funnypeople.jpg kal va agaipeosTe Tov Avrpa He Ta Hakpid
MaANIG ano Tn pwToypagia.
To TeAIKO anoTEAEOUA NPENEl va Poladel Je To Mo KATw.

12. Na anoBnkeloeTE TN PwTOYPAPIa.
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r.4.4.M8

4 Aoyiopiko EQappoy®v

*+ EninpooBerec ApacTnpioTnTEC

13. Na avoiéete Tnv ekova tourists.jpg kal va a@aipéCETE TOUC TOUPIOTEG and Tn

pwToypagia.
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ENOTHTAT5 AikTua YNOAOYIOT®WV
kai AiadikTuo

105






'5.1 E@appoyec Nepouc
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®YAANO EPrAzIAZ .5.1.M1 - M2
Anpioupyia ka1 Xprion ®oppwv (Google Forms)

Ti 6a padoupe onpepa:

OO HOH

Na dnuioupyoUue gpoOpua kai va Tnv avapToUue oTo d1adikTuo yia cupnAnpwaon ano ahhoug

Na dnuioupyoUpE EpWTNACEIC KAl va XPNoIKonoloUPE Toug diIagopouc TUMOUG

Na xpnoigonoloUpe TNV evToAr] AAayr @€uaTtog yia ahAayr TnNG ENEAviong Tng popuag

Na xpnoigonoloUpe Tnv EvroAn MpoBoAng ®oppag Zwvrtava (View Live Form)

Na kateBaloude TIG MANPOQOPIEG MOU £XOUV OUAAEYEl and Tn @OpUA HAC Yid MNEPETAIPW
eneEepyaoia.

ApaoTnpioTnTeG EUnédmwong

XpnoigonoliwvTag Tov NpPoownikd oac Aoyaplacyd oTtnv  unnpeoia  Gmail  kai
akoAouBwvTag TIC Mo KATw 0dnyieg, va PTIAEETE POpHa e To ovopa: «Modoopaipo -
MeyaAeg Modoopaipikeg MopPEG».

Na OwoeTe TO M0 KATW OXOANO WG nepiypapr: «H €peuva anookonei OTo va
e€akpIBwooupe METAEU Twv QIAWV KAl OUMPMAdNTWV Hag Tn yvwpn TOoug yid TO
nodoo@alpo Kal yia GNHAvTIKEG NOdOOPAIPIKEC MPOCWNIKOTNTEC.

Na emAeEeTe B€pa yia TN GOPKA 0ag To oroio va GXETICeTal e To Noddopalpo.

Na Onuioupynoete kaivoupia evoTnTa OTN QOPHA 04g, ME TITAO <«AnUOYPaAPIKEG
MAnpogopiec>.

ZNHEIOVOUHE OTO ONHEIO AUTO, NWG OAEG OI EPWTNOEIG, O OAEG TIG EVOTNTEG
nou akoAouBoUv, 8a npénel va £Xouv eMIAEYHEVN TNV UNOXPEWTIKN AnAvrnon.

>Tn evOTNTA AUTA va NPOCOETETE TPEIG EPWTAOEIC MOANANANG ENIAOYNAG:
(a) ZTv npwtn gpwTnon va dwoeTe Tov TITAO «®UA0» kal oTnv emioyn 1 va
NANKTPOAOYNOETE «AyOpI» Kal aTnv enAoyn 2, «KopiTai».

(B) Ztn deuTePn €pwTNON TNG EVOTNTAG AUTNG va dwaoeTe TiTAO «HAIkia». H gpwTnon
auTn Ba &xel TpeIg enAoyec: oTnv emidoyn 1 va nAnkTpoAoynoeTe «Katw Twv 16»,
oTnVv emioyn 2, «Ano 16 - 18» kai oTnv emioyn 3, «Mavw Ano 18».

(y) ZTnv TpiTn €pwTtnon va dwoeTe TiITAO «Tonog Alauovng» kal otnv enidoyn 1 va
NANKTPOAOYNOETE «MOAN» Kal aTnV €MIAoyn 2, «XwpIo».

Na OnuioupynoeTe Kaivoupia €vOTNTA OTn  QOpUA 0ac, KHeE TITAO «ZUuA\oyn
MANpo@opIV».

>Tn evOTNTA QUTH va NPOCHECETE TPEIC EPWTNOEIC MpappiknG KAipakag and 1o 1 peXpl To
5.

Kal oTIC TPpEIC EpWTNOEIC va €ival EvepyonoinNUéVN N €MIAOYN UMOXPEWTIKAG anavTnong.
EmnAéov, va npenel va NANKTPOAOYNOETE WG ETIKETA Yia KAOE EpwTNON, OTO onueio 1 T
AEEN «Aiyo» kal oTo onpeio 5 TIG AeEeig «Mapa MoAU».
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r.5.1.M1-m2 I'5 AikTua YnoAoyioTov kai AiadikTuo

10.

11.

12.

13.

14.

15.

16.

(a) ZTnv npwTn £pwTNON va dWOETE ToV TITAO «Zag Apeael To ModooPalpo;»

(B) ZTn OeUTepn €pWTNON TNG &vOTNTAC aUTAG va OWOeTe TITAO «[MOCO OuUYVa
NapakoAouBeiTe évav Nodoo@aipikd aywva €ite and To OniTI 0ag €iTe nnyaivovrag
oT0 yNnedo;».

(y) ZTnv TpiTn £pwTNON va dWOETE TITAO «[O00 0ac evOIAPEPOUV Ta EEva €upwNAiKa,
Kal OxI HOvov, NodooPpaipika NPwWTabARuaTa».

Na dnuIoupynoETE KaivoUpia evoTnTa oTn popHa oag Ke TiTAO «levikéG MANPopopiec.

Na OwOoeTe To MO KATW OXOANIO WC MEPIYpAPr): «XTnV €voTnTa auTr 6a BgAaue va
€EAKPIBWOOUKE KAMOIEG YEVIKEG NANPOPOPIEC YUPW and To NodOaPaipo».

H npwTtn €pwtnon otnv evotTnTa auTtn va &ival TUnou noAAanAng €mIAOYnG Kai va xel
TiTA0 «[Molov and Toug Mo KATW OEwpeiTe, WG TNV M0 oNUAavTikn nodoaPaipikn
NPOCWNIKOTNTA;»

XpnoigonolwvTag pnxavn avadnrtnong, va PBpeite and pia €ikdéva yia Toug nio KATw
nodoo@aipioTeg: a) Pele, B) Maradona, y) Zinedine Zidane kai 8) Johan Cruyff. Zmn
OUVEXEIQ, VA EI0AQYAYETE WE OMNoIa OEIpd BEAETE TIC EIKOVEG TwWV NOdOOPAIPIOTWV OTIC
TEOOEPIG EMAOYEG TNG EPWTNONG.

H OeUTepn €pwTnon oOTnV €vOTNTA AUTNA N omoia €ival, €niong, TUNou nOoAAAnANG
emAoync, €ival n akdhoudn: «Av eixaTte Tn duvaTtoTnTa, O Noia anod TIC MO KATW OPADEC
Ba enIAéyaTe va aywvioTEiTE;»

XpnoigonolwvTag kal na\l pnxavn avadntnong, va PBpeite and pia €ikova yia Toug nio
KaTw nodoopaipikoUc cUANOyouc: a) Manchester United, B) Bayern Munich, y) Barcelona
kal 0) Real Madrid. ZTn ouvéxela, va €l0ayayeTe e OMnola Oelpd BEAETE TIG EIKOVEG TWV
OMAdWV OTIG TEGOEPIC EMIAOYEG TNG EPWTNONG,.

MPWTOU KOIVOMOINCETE TN (POPUA OTOUG CUMHABNTEC 0aG, va KAVETE TIC NIO KATW

pubuioeic:

(a) Na evepyonolinOeTe TNV €MIAOYN, WOTE VA WMOPEITE va OUAAEYETE TIG dIEUBUVOEIG
NAEKTPOVIKOU Taxudpogiou 00wV Ba CUUETEXOUV OTNV €pEuva.

(B) Na evepyonoinoeTte TNV €MIAOYN, WOTE QUTOC NMOU CUMKETEXEI OTNV €PEUVA VA WMNOPEI
va A\apBavel, v To emBuyEi, avTiypa@o Twv anaviioewy Tou.

(y) Na evepyonoinoeTe TNV €NIAOyN, WOTE Ol CUMHETEXOVTEG OTNV EPEUVA VA KNopouv va
OUMMETEXOUV MOVO Wia gpopa oTn diadikaaia.

(0) Na evepyonoinoeTe TNV €niAoyn, WOTE AUTOI MOU ANavTouv va Pnopouv va douv Td
OTATIOTIKA OTOIXEIa TNG €pEUVAG.

(e) Na enmAéEeTe va ep@avileTal n ypauun npoddou 0 auTov Nou Ba GUPHETEXEI OTNV
£peuva.

Na KOIVOMOINOETE TN POPUA O TECOEPIG CUUHABNTEC 0ac. 2To B€ua Tou pnvUpaTog va
BaAete Tov TiTAO: «[Mpoownikn ‘Epeuva MNa To Moddopaipo» kai dinAa To Ovopa Kai To
€NiBeTO oac.
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https://www.google.com/search?client=firefox-b-ab&q=real+madrid&spell=1&sa=X&ved=0ahUKEwjn0f66qIXSAhUCIpoKHYcNCP0QvwUIGCgA

5.1 EpappoyEg NEpoug r.5.1.M1-m2

17.

18.

Na emAEEETE 01 aNAVTAOEIC va £PXOVTal O VEO UMOAOYIOTIKO (PUANO PEoa OTO google
drive oac.

'OTaV OUYKEVTPWOETE OAEC TIG ANAVTAOEIC and TOUC CUPKABNTEC 0ac, va KATERBACETE TO
unoAoyIoTIkO pUANO JEoa oTo onoio BpiokovTal oI anavTnoelc, and To google drive oTov
unoAoyioTn oac.

ApaoTtnpioTnTeG ASI0AOYNONG

19.

20.

21,

22,

Na OnuIoUPYNOETE Hia kaivoupia evoTnTa OTn QOpHA 0ac We TiTAo «[lodoogalpika
>Tadia».

H npwTn epwTnon oTnv £vOTNTA QUTH va €ival TUNOU oUVTOUNG anavTtnong, e TITAO «Z€
nolo eupwnaikd otadio Ba BENaTe va napakoAoubnoeTe Evav NodoaPaipikd aywva;»

H deUTepn epwTnon va ival Tunou NoAAanAnNgG emAoyng We Titho: «Molo and Ta nio KaTw
TEoogpa oTadla TnG KUnpou BewpeiTe Nwe ival To KAAUTEPO;»

XpnoigonolwvTag Pnxavn avaldnrtnong, va Bpeite anod Wia €ikova yia Ta nio katw otadia:
a) .zZ.N, B) Toipeio, y) AEK Apeva kai 8) Avtwvng Manadonouhog. ZTn Ouvexela, va
€10ayAyeTE PE ONoIa ocipd BENETE TIC €IKOVEC TwV OTAdIWV OTIC TECOEPIC EMIAOYEC TNG

€PWTNONG.

=+ Eninpoo®eTec ApaoTnpioTnTEG

23.

24,

25.

2TV evoTNTa HE TIG dNUOYPAPIKEG NANPOPOPIEC va dNMUIOUPYNOETE akOUa Hia €pwTnon
noAAanAnG emAoync, n onoia va €&Talel 7o eninedo pOPPWONG TOU NATEPA N TNG
pNTEPAG (AnuoTikO, M'upvaacio —Aukeio, KoAgylo, MavenioThpio).

>tnv evoTnTa Mevikeg MANPOPOPIEG va NPOCHETETE OTNV €PWTNON HE TIG NOOOCPAIPIKEG
NPOCWNIKOTNTEC TNV €MAOYN WE TNV €Ikova yia Tov Michel Platini.

>Tnv idia evOTNTA va NPOCBETETE OTNV EpWTNON ME TOUC N0d0aPAIPIKOUC GUADOYOUC TNV
eikdva Tng Liverpool F.C.

ApacTnpIOTNTEG YIA TO ZNiTI

26.

27.

Na dnuioupynoeTe kaivoupla evoTnTa oTn POpHa oag We TiTAo «MPoownikEG EKTIUNOEIG.

>Tnv evOTNTA QUTH va NpoocBeoeTe pwTNOEIC Mpappikng KAipakag and 1o 1 pExpl 1o 5.

2€ ONEC TIC EPWTNOEIC va €ival EVEPYONOINUEVN N €MIAOYN UMOXPEWTIKAG anavtnong.

EminAéov, va NANKTPOAOYNOETE WG ETIKETA yIa KABE €pwTnon, OTO onueio 1, Tn AEEN

«Aiyo» kal aTo onueio 5, TIG Ae€eig «Mapa MoAus».

(a) ZTnv npwTn £pwWTNON va OWOETE ToV TiTAO «I000 MIOTEVUETE NWG N KApTa PIAGBAoU
Ba nepiopioel Tn Bia oTa ynneda;»

(B) ZTn deUTepn €pWTNON TNG EVOTNTAG AUTAG va OWOETE TITAO «MIOTEUETE NWG AV O
KGBe piAabAoc €ixe Tn B€0n Tou pEoa oTo yANedO KAl v NTAV UMOXPEWHEVOC va
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https://en.wikipedia.org/wiki/Michel_Platini

r.5.1.M1-mM2 5 AikTua YnoAoyioTav kai AiadikTuo

(Y)

(%)

kaBioel povo og auTn Tn B€on, Ba ATav onuavTikog Aoyoc neplopiopoU TNG Biag kai
TOU XOUAIyKkaviopoU oTa ynneda;»

TNV TPITN €pwTNON va dWOETE TITAO «[MIOTEUETE NWC 0 NEPIOPITUOC TNG Biac oToug
abAnTikoUC Xwpoug Ba eival évag noAU onuavTikoG AOYoG yia NPOCEAEUON
nEPIOOOTEPWV PINABAwV oTa ynneda;»

TNV TETAPTN £pWTNON va dWOETE TITAO «[OCO MIOTEUETE NWC O NAPASEIVHATIKEG
TIHwpPieC Ba nepiopilav Tn Bia oTa ynneda;»

28. EKTOC ano TIC eVOEIKTIKEC TECOEPIC MNIO NAVW EPWTNOEIC, UMNOPEITE VA NPOCOECETE OOEC
EPWTNOEIC €MOUMEITE NMou va OIEPEUVOUV TOUG AOYOUC Kal TOUG NApayovTeg Mou
ennpealouv kal wOoUv NPoc Tov XOUAIYKaviopo kal otn Bia.
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®yYANO EPrazIAZ NL5.1.M3 - M4
Anpioupyia ka1 Xprion ®oppwv

Ti 6a padoupe onpepa:

OO HOH

Na dnuioupyoUue QpoOpua kai va Tnv avapToUue oTo d1adikTuo yia GUPNARPwWaon ano aA\oug

Na dnuioupyoUpE EpWTNACEIC KAl va XPNoIKonoloUPE Toug diIdgopouc TUMOUG

Na xpnoigonoloUpe TNV evToAr] AAayr @€uaTtog yia ahAayr TnNG ENEAviong Tng popuag

Na xpnoigonoloUpe Tnv EvroAn MpoBoAng ®dppag ZwvTtava (View Live Form)

Na kateBaloupe TIG NANPOMOPIEC Mou €xouv CUAANeysi and Tnv (GOPPA HaAG YId MEPETAIPW
eneEepyaoia.

ApaoTnpioTnTeG EUnédmwong

XpnoigonoliwvTag Tov NpPoownikd oac Aoyaplacyd oTtnv  unnpeoia  Gmail  kai
akoAouBwvTag TIC Mo KATW 0dnYieG, va dNUIOUPYNOETE POPHA HE To Ovopa: «Mouaikn —
EMNvIKA & Z€vn!!!»,

Na OwOoETE TO MO KATW OXOAMO WG NeplypaPn: «H Mo KATw €peuva €Xel WE OKONo va
OlEpEUVNOEI Ta HOUCIKA akoUo[aTa kal EpeBiopaTa Twv oupPKadnTwy pag.».

Na emAeEeTe BEpa yia Tn GOPUA 0ac To Onoio va OXETICETaAl JE TN HOUTIK).

Na OnuioupynoeTe Kkaivoupia &voTnNTa OTn @QOPHA 004G ME TITAO «AnuUOYPaAPIKEG
MAnpo@opiec».

ZNHEIOVOULE OTO ONHEIO AUTO, NWG OAEG O1I EPWTNOEIG, O OAEG TIG EVOTNTEG
nou akoAouBoUv, Ba npénel va £xouv eNIAEYHEVN TNV UNOXPEWTIKN andvrnon.

2Tn evOTNTA AUTN, va NPooBeceTe dUO EPWTNOEIC, N NPWTN va gival NOAAANANG eNIAOYRG

kal n deUTEPN va €ival TUNou guvTouNG andvTnong:

(a) Znv npwTn €pwtnon Ba dwoeTe Tov TiTAO «®DUAO» kal oTnv enmidoyn 1 Ba
NANKTPOAOYNOETE «AyOpI» Kal aTnv eniAoyn 2, «KopiTai».

(B) Ztn deuTepn €pwTNON TNG €VOTNTAG AUTHG Ba dwoeTe TITAO «MMANKTPOAOYROTE TNV
nAikia oag:».

Na dnpIoupynoeTe kaivoUpia evOTNTA OTN QOPUA 0ag Ke TiTAO «Ievikeég MANPoPOpPIES>.

(a) H npwTn €pwTNON OTNV €VOTNTA AUTN Va €ival YPAUMIKAG KAidakag and 1o 1 péxpl
To 5. QC €TIKETA OTNV €pWTNON, OTO ONEEI0 1 va NANKTPOAOYNOETE TN AEEN «Aiyo»
Kal oTo onueio 5 T Aé€eig «Mapa MoAu». Ta TiTAo oTnv epwTnon va Baiete «Moco
OUXVA aKOUYETE HOUTIKN;»

(B) H delTepn epwTnon oTnV €vOTNTA AUT va €ival NOAAAnNANG enAoynG ME TiTAO
«AKOUYETE MO ouxva &vn 1N eNnvikr poucikn;».  ZTnv emAoynp 1 va
NANKTPOAOYNOETE «EAANVIKN» oTnv €mdoyn 2, «Zévn» kal aTnv enmidoyn 3, «Aev
akoUw Mouaikn».

(y) H TpiTn €pwTNnON va gival Tunou cUVTOUNG andvrnong Kai va £xel TiTAo «MNdoa Aentd
KGOe pEPA, KATA PWECO OPO AKOUTE HOUTIKN;».
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r.5.1.M3-M4 I'5 AikTua YnoAoyioTov kai AiadikTuo

7.

10.

11.

12.

13.

14.

(0) H TéTapTn €pwTNON Va €ival TUNoU NOAAAnANG emAoyng Ke TiTAO «'EXETE NAEI NOTE
o€ ouvauhia;» Ztnv emioyn 1 va nAnktpoloynoete «Nai» kal oTnv €nmiioyn 2,
«'Oy1».

H néunTn kai €KTn €pWTNON OTNV €vOTNTA AUTN va gival TUNouU ouvToung anavtnong. O
TITAOC TNG NEWNTNG €pwTnonG eivar «Molov ‘EAAnva TpayoudioTn 1 EAAnvida
TpayoudioTpia OaupdaleTs;» kal TNG €kTNG «Molov =€vo TpayoudioTn 1 Zévn
TpayoudioTpia OaupaleTe;»

H TeAeuTaia epwTnOn TNG evOTNTAC AUTNAC va €ival TUNou NoAAanANG MIAOYNG Kai va EXEl
TiTAO «[olo and Ta mo KATw &Eva HPOUOIKA GUYKPOTNMATA Bewpeite OTI 0ag ekPppalgl
NEPIOTOTEPO; »

XpnoigonolwvTag pnxavn avafitnong, va Bpeite and pia €kova yia Ta no KATw
ouykpoTnuaTa: a) Beetles, B) Queen, y) Scorpions, d) Rolling Stones kai €) U2. ZTn
OUVEXEIO VA EI0AQYAYETE PE OMNOIa O€Ipd BEAETE, TIC EIKOVEG TWV MEVTE GUYKPOTNHATWV
OTIG NEVTE EMAOYEG TNG EPWTNCNG.

Ma okonoug NANPOTNTAG TNG €pWTNONG, BAATE Kal Wia €kTn emAoyn ME TiTAo «Kavéva
ano Ta nio Navw».

MpoTOU KOIVOMOINOETE TN (POPHUA OTOUG OUMHABNTEC 0ac, va KAVETE TIC MO KATW

pubuioeic:

(a) Na evepyonoinosTe TNV €nIAOyr, WOTE VA HMNOPEITE va OUAEYETE TIG OIEUBUVOEIG
NAEKTPOVIKOU TaxUOPOWEIOU 00WV Ba CUHHETEXOUV OTNV €peuva.

(B) Na evepyonoinoeTe TNV €MAOYR, WOTE AUTOC NMOU CUHUETEXEI TNV EPEUVA VA WMOPEI
va Aaypavel, eav To emBuyei, avTiypa®o Twv anavrnoswy Tou.

(y) Na evepyonoinoeTte TNV €NIAOYH, WOTE Ol CUUKETEXOVTEG TNV EPEUVA VA KNOPOUV va
OUMMETEXOUV HOVO Wia popd oTn diadikaacia.

(8) Na evepyonoinoeTe TNV €MAOyR, WOTE AUTOI NOU ANAvToUV va Pnopouv va douv Tad
OTATIOTIKA OTOIXEIQ TNG EPEUVAC,

(¢) Na emAéEeTe va spgavileTal n ypauun npoodou O€ auTov Mou Ba CUMPHETEXEI OTNV
EpeEuva.

Na KOIVOMOINOETE TN (POPUA O MEVTE CUPHABNTEC 0aC. 2To B€ua Tou pnvUPATOC va
BaAeTe Tov TiTAO: «Mouaikr) ‘Epeuva» kal 8inAa To dvopa kail To eniBeTo oac.

Na ermIAEEETE 01 anavTAOEIC va EpXovTal O VEO UMoAoyIoTIKO (UANO PEoa oTo google
drive oac.

'OTav GUYKEVTPWOETE OAEC TIC ANAVTNOEIC And TOUG OUMKAadNTEG oac, va KaTeBACETE TO
unoAoyioTikO UANO PECa OTO OMoio BpiokovTal oI anavTnoeic, and To google drive aTov
unoAoyioTr oag.
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5.1 Epappoyeg NEpoug r.5.1.Mm3-mM4

ApaoTnpioTnTeg ASI0A0YNONG

15.

16.

17.

18.

19.

20.

Na dnuIoupynoETE Wia kaivoupia evoTNTa 0Tn QOPHA 0ac KE TiTAO «Tpayoudia».
3TNV eVvOTNTA AUTI VA NPOCOECETE TECOEPIC EPWTHOEIC TUNOU CUVTOMNG anavTnong.

TNV NpwTN £€pWTNON va dWOETE TITAO «MANKTPOAOYNOTE OTOV XWPO NMOU AKOAOUBEI TO
ayannuévo oac eEAANVIKO Tpayoudi.»

>Tn OeUTEPN €pWTNON VA OWOETE TITAO «IMANKTPOAOYNOTE OTOV XWPO MOU AKOAOUBEI TO
ayannuévo oag EEvo Tpayoudis.

>TNV TPITN £pWTNON va dWOETE TITAO «IMANKTpOAOYNOTE £va TpayoUdi Nou €Xel OUVOETEI
0 Mikng ®£0dwpakng, av dev YVwpIleTe, va NANKTPOAoynoeTe: "Aev Mvwpidn>.

TNV TETAPTN €pwTNON va OWOeTE TITAO «[MANKTPOAOYNOTE €va TPAyoudl MOU EXEl
ouvBeael 0 Mavog Xatgidakic, av dev yVwpIleTe, va NANKTPoAoynoeTe: “Agv M'vwpilw”».

4+ Eninpoo®eTec ApaoTnpioTnTEG

21,

Na dnpIoupynoeTe kaivoupia evOTNTA OTN QOpHa oag Ke TiTho «KAaaikr Mouaikn».

(a) H npwTn gpwTnon oTnv evOTNTA AUTA va €ival YpauuIKNG KAipakag and 1o 1 Pexp!
To 5. QC €TIKETA OTNV €pWTNON, OTO onueio 1 va nNANKTpoAoynoeTe Tn A€EN
«KaBdhou» kal aTo anpeio 5, T Ae€eig «Mapa MoAu». Ta TiTAo oTnV £pWTNON VA
BaAeTe «I000 ouxva akoUYETE KAQGIKN HOUTIKH);»

(B) H 0delTepn epwtnon va eivar TUNOU OUVTOMUNG ANAVTNONG Kal va EXel TiTAO
«MANKTPOAOYNOTE €vav  OUVOETN KAQOIKAGC HOUOIKNG. Av  Jev  YVWPICETE,
nAnkTpoAoynoTe: “Aev M'vwpilw.

(y) H TpiTn €pwTnON Vva €ival kai aut TUNOU GUVTOUNG andavtnong kai va €xel TiTAo
«MANKTPOAOYNOTE TOV TITAO €VOG £PYOU KAQOOIKAG MOUCIKAG. Av Oev yvwpileTe
nAnkTpoAoynaoTe: “Aev M'vwpilw.

ApaocTnpIOTNTEG yia TO ZNiTI

22,

23.

Na dnuioupynoeTe kaivoupla evoTnTa oTn popHa oag Ke TiTAO «MPoownikeg ANOWEIC».

>Tn evOTNTa AuTn va npoaBéoeTe epwTnoelg Mpappikng KAipakag and 1o 1 pexpr To 5.

> ONEC TIC EPWTNOEIC VA €ival EVEPYOMOINKEVN N €MIAOYR UMOXPEWTIKAG aANAvTNnonc.

EminAéov, va nANKTPOAOYNOETE WG ETIKETA yia KABE €pwTNON OTO onueio 1 Tn AEEN

«Aiyo» kal aTo onueio 5, TIG Ae€eig «Mapa MoAus».

(a) ZTnv NpwTn €pwTNON va OWOETE TOV TITAO «OLWPEITE NWC N HOUCIKN Eival
anapaitntn otn {wn KGbs avBpwnou;»

(B) Ztn deUTepn gpwTNON va dWOETE TiTAO «IOCO NIOTEUETE NWG N POUCIKI NOU AKOUTE
ennpeadel Tn oupnepIPopd Kal eupUTEPA TN NPOCWNIKN 0dc {w;».
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r.5.1.M3-M4 5 AikTua YnoAoyioTav kai AiadikTuo

(y) ZTnv TpiTn £pWTNON va dWOETE TiTAO «MMOCO ouyVva PHECA OTO OMiTI 0a¢ Kal eUpUTEPA
N OIKOYEVEIQ 0ag akoUEl JOUTIKN;»

24. EKTOC ano TIC eVOEIKTIKEC TPEIC MIO MAVW EPWTNOEIC, UMOPEITE VA NPOOBECETE OOEC
EPWTNOEIG eniBupeite, nou va Odlepeuvolv kal va avadeikvlouv Tnv enidpacn Tng
HOUCIKAC 0N (Wi TwV CUPPAdNTWV oac.
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®YAAO EPrAZIAZ 5.1 M5
Xpnon AladiktuakoU HuepoAoyiou

Ti 6a padoupe onpepa:

©

@
©
@

Na dnuioupyoupe véo Zuppav (Event) aTo nueEPOAGYIO Kal va XpnoIKOMNOIOUKE TIC BACIKEG EMINOYEC
evog ZuppavTog

Na xpnoigonoioUpe kai va e€nyoupe Tnv emioyry EnavaAnwn (Repeat) yia éva ZupBav (n.x.
Repeats, Repeat every, Repeat on, Start on, Ends)

Na xpnoigonoloUpe TIG dIAPopeC MPOBOAEG TOU NUEPOAOYIOU

NG EKTUNMVOUPE TO NUEPOADYIO.

ApaoTnpioTnTeG EUnédmwong

1. Xpnolpgonoiwvrag Tov Mpoowrnikd o0ad¢ Aoyapiaopd otnv  unnpecia  Gmail kal
akoAouBwvTag TIG N0 KATW odnyieg, va PTIAEETE dIadIKTUAKO NUEPOAOYIO E TO Ovopa:
«Ta levebAia Kai O1 TopTteg Tawv Didwv Mou!!!»,

2. Na dwoeTe TO N0 KATW OXOAIO WG MeEPIypaPn: «HUeEpoUnVieg kal onuavTika yeyovoTtd
nou Ogv NpEnel va EExvw».

3. 210 nedio nepioyr) (Location) va NnANKTpoAOynoeTe To Gvoua TNG NOANG oac.

4. Na €nIAEEETE TO XpwHa NOU BEAETE yIa TO NHEPOAOYIO.

5. Apyifovtag ano Touc CUMNABNTEG 0ag kal, OTn CUVEXEI, E TOUG UNOAOINOUC (PIAOUG 0ag
va npooBeceTe oupPavTa OTIC NUEPOMNVIEG yeveBAiwv Toug. Ma peyaAUTepn €ukoAia
MMOPEITE va XpNOIUONOINCETE TNV NPOBOAr month.

6. ¢ Ovoua OTo OUMBAV PNOPEITE va OWOETE TO OVOUA TOU (PIAOU 0ag nou €xel Ta YevebAId
TOU €KEIVN TNV NUEPQ.

7. Na OwoeTe KOKKIVO XpWHA OTA OUMBAVTA HE TIG NUEPOMNVIEG YeVEBAIWV Twv
OUPMAaBNTWV 0ac kal UNAE o€ auTd Twv PIAWV 0ac €€w anod To OXOAEI0.

8. XpnoiponolwvTag TIG EVTOAEG eKTUNWONG, va anoBnkeUoeTe g€ poppn apxeiou pdf Tov
MAvVa PE Ta NEPICOOTEPA OUMBAVTA YEVEBAIWV.

ApaoTtnpioTnTeG ASI0AOYNONG

9. Na npooBeceTe GTO NUEPOAOYIO OAG TIC NUEPOMNVIEG ME TIC OVOUAOTIKEG YIOPTEC TWV
QIANOV  0aC. ZUYKEKPIPEVA, XPNOIMOMOIWVTAC Hnxavn avaldntnong, va Ppeite TIC
NUEPOMNVIEC Nou yiopTalouv, n.x. AnuNTpeNnG 26 OKTWRPIoU, Kal va NPOCHECETE oUPPAv
TN OUYKEKPIPEVN NUEPOUNVia.

10. To oupBdav va To OVOPAOETE PE TO OVOUA TOU ayiou N ayiag nou yiopTalel ekeivn Tnv
nHEpPQ.

11. MNa kaBe oupPav, oto nAaiolo Kelpevou description va NANKTPOAOYNCETE Ta ovopaTa Kal

Ta eniBeTa TV PIAWV 0ag nou yioptalouv.
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12. Na dwOoeTe XpwiUaTa Nou £0€ic eUBUEITE 0Ta ocupBavTa.

13. XpnolponoiwvTag TIC EVTOAEC eKTUNWONG, va anobnkeUoeTe o HopPr apxeiou pdf Tov
hrva otov onoio yiopTalouv ol NEPICOOTEPOI PiAoI 0ac.

=+ Eninpoo0eTec ApaoTnpioTnTEC

14. XpnoigonolwvTag pnxavn avalntnong, va BPeiTe TIC NUEPEC WE TIC OXOAIKEC apyieg onou
Ta OxoAcia €ival KAEIOTA KAl va NPOOOECETE GUUBAVTA YIA AQUTEC TIG NUEPEC (OIAKOMEG
XpioTouyevvwv kai Maoya, 28n OkTwRpiou, Tpiwv Iepapywv K.An.).

15. Qc ovopa oTo GUPPAv va dWOETE TO OVONA TNG OXONIKNG apyiac.

16. Na Hop@onoINoETE Kal va neplypAWeTe Ta CUKPBAVTA ONWG VOUIZETE €0€iG KAAUTEPQ.

ApaoTnpIOTNTEG YIA TO ZNiTI
17. Na npooBéoeTe oTo dIAdIKTUAKO NHEPOADYIO TIC YIOPTEG Kal Ta YEVEOAIQ TwV PEAWV TNG

OIKOYEVEIAc oac (natépac, UnTépa, adeAPia, EadEAPIa K.Am).
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®YANO EPrAZIAZ N.5.1 M6
Xpnon AladiktuakoU HuepoAoyiou

Ti 6a padoupe onpepa:

©

@
©
@

Na dnuioupyoupe véo Suppav (Event) oTo nuePOAdYIO Kal va XpnoIKOMOIOUKE TIG BACIKEG EMINOYEC
evog ZuppavTog

Na xpnoigonoioUpe kai va €€nyouue Tnv emAoyr) EnavaAnwn (Repeat) yia éva ZupBav (n.x.
Repeats, Repeat every, Repeat on, Start on, Ends)

Na xpnoigonoloUpe TIG dIapopec NPOBOAEG ToU nuepoAoyiou

NG EKTUNMVOUPE TO NUEPOADYIO.

ApaoTnpioTnTeG EUnédmwong

1. Xpnolpgonoiwvrag Tov Mpoowrnikd o0ad¢ Aoyapiaopd otnv  unnpecia Gmail kai
akoAouBwvTag TIG N0 KATW odnyieg, va PTIAEETE dIadIKTUAKO NUEPOAOYIO E TO Ovopa:
«To EBdopadiaio Mou Mpoypappal!!»,

2. Na dwoeTe TO M0 KATW OXONO WC NEPIYPAPH: «ZTO NUEPOAOYIO auTd, napouaialovTal a)
TO £Bdopadiaio Jou Npoypaupa aTo aXoA€io Kal B) oI anOyEUUATIVEG HOU UMOXPEWOEIG.>.

3. 210 nedio nepioyr) (Location) va NnANKTpoAOynoeTe To Gvoua TNG NOANG oac.

4. Na €nIAEEETE TO XpwHa NOU BEAETE yIa TO NHEPOAOYIO.

5. Na enAeE€eTe TNV NpWTN AcUTEPA ONOIOU WRva BEAETE Kal va KATaxwpioTe TO NPOCWIKO
0ac oxoANIkO NpOypaupa yia oAn tnv €Boopada. lMa kabe kaTaxwplion va KAVETE Kal TIC
anapaitnTeG NPooappoyeG oTnv wpad. Ma napadeiypa, av n npwtn NePiodog TEAEIWVEI
08:15, TOTE Ba npenel va KAVETE TIG avAAOYEC pUBIOEIC Yéoa and To NUEPOAdYIO OTnV
wpa evapeng kai ANgng yia kabe ouppav.

6. Ta kaBe oupBav va npooBeceTe oTo NAAioIo Kelpévou where, TNV TAEN 1 TO EpyacTnpIo
onou yiveral To pabnua. EninAfov, oto nAdiolo keipgévou description va npooBEceTe TO
ovopa Tou kabnynTn nou 81I0ACKEl TO PAbnua.

7. Z1a kUpla pabnuata va dwoeTe XpwHa KOKKIVO aTa cuuBavTa.

8. Na npoPeite oTIG kKaTAANAEG puUBUIoEIG, WOTE TO NUEPOAOYIO 0ag va enavaiauPaverai
kGOe Bdouada.

9. XpnolponoliwvTag TIC €&VTOAEG eKTUNWONG, va anobnkeuoeTe To €Rdopadiaio odag
NUEPOAOYIO O Hop®r| apxeiou pdf.

ApaoTnpioTnTeg ASI0AOYNONG
10. Na npooB£oeTe OTO NUEPOAOYIO 0AC TO AMOYEUMATIVO oac £B0ouadiaio nNpoypauua, n.x.

1010iTEPA, aBANTIKEC dpaCTNPIOTNTEC, MOUCIKEC dpacTnPIOTNTEG K.AM. 'OnNw¢ KavaTe Kal
OTO OXOAKO NMEPOAOYIO, YIa KABe KaATaxwpion va KAVETE Kal TIC anapaiTnTeg
NPOCAPHOYEC OTNV WPA.
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r.5.1.M6 I'5 AikTua YnoAoyioTov kai AiadikTuo

11.

12.

13.

Ma kabe oupBav va NpooHECETE OTO NAQICIO KEINEVOU where, TO PEPOG OMOU MNyaiveTe
yia Tn dpacTnpioTnTd oac. EmnAéov, oTo nAaiolo kelpEvou description va dwoeTe
oUVTOUN neplypa®ry TnNG AnoyeudaTiviig oag 0pacTtnpiOTnTag, n.X. TO €Ninedo Twv
ayyAikov, ndoa xpovia acXoAeioTe Pe Tov aBANTIOHO K.AM.

Na dWOETE XpwUaATa Nou £0€i¢ EUBUPEITE 0TA oUpBAvTa.

XPNOIKOMNOIWVTAC TIC EVTOAEG EKTUMWONG, VA ANOBONKEUOETE TO OAOKANPWHEVO NAEOV
€Bdopadiaio oac nuepPoAdylo o popPn apxeiou pdf.

=+ EninpooBerec ApacTnpioTnTEC

14.

15.

Na npooBeCETE OTO NUEPOAOYIO OAC ONUAVTIKEG OTIYMEC MOU MEPACAV TOV TEAEUTAIO
MAva f nou nNPOKeITal va €pOouv PECA OTOV ENOHPEVO WNVa.

Na Hop@OonoINCETE Kal va neplypAWeTE Ta CUKPBAVTA ONWG VOUIZETE €0€ic KaAUTEPQ.

ApaoTnpIOTNTEG yia TO ZNiTI

16.

Na o@Tia&ete TO J1AdIKTUAGKO NUEPOAOYIO Yyia KAnolo AAAO HEANOG TNG OIKOYEVEIAG 0ag
(adeA@OC, NnaTépac, UNTEPA K.AM.) Kal TN OUVEXEID, VA TO EKTUNWOETE. AV TO €NIBULEITE,
va NpooBEaeTe TOOO TIC NPWIVEG BOOUAdITIEC UNOXPEWTEIC OO0 Kal TIC ArNOYEUATIVEC,
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®YANO EPrAZIAZ N.5.2.M1-M2
Xpnon Koivavikawv AikTowv -Linkedin

Ti 6a paboupe onpepa:

© Na dnuioupyoUpe Aoyapiacpo oto LinkedIn

© Na eneEepyaldpacTe To NPOPIA pag

© Na dnuioupyoUpE Kal va CUKNANPWOVOUE TO BIOypa@IKO Hac onueinua.

ApaoTnpioTnTeg Eunédwong/A§ioAoynong/Na To oniTi

1. Na avoiete évav  QUANOMETPNTA 10TOU Kal va MeTaBeite oTnv  I0TOOEAIdA
www.linkedin.com

2. Na dnpioupynoete évav Aoyapiacud oto LinkedIn. Ma Tn dnuioupyia Tou Aoyapiacuou
apxIika 6a npenel va dWOoeTE:

(a) AiguBuvon nAekTpovikoU Taxudpopeiou (email).
(B) Kwdiko npooBaong.

(v) ‘Ovopa

(0) Enwvupo

() Xwpa

(oT) Taxudpopikd kwdika (NPoalpeTIKA)

3. Népa and autq, Ba xpelaoTei va dNAWOETE:
(a) 'OTI eioTe paABNTEG/POITNTEC.

(B) To oxoAcio/oxoAn oag, Tn xpovia vapeng kai ANEng Tng Ppoitnong odg.
(y) To kupiwg B£pa pe To onoio Ba acxoAnbeiTe.

4. Z1n ouvexela, va eniBeBaiwoete T Onuioupyia Tou AoyapliacpoUu 0ac MECW TOU
NAEKTPOVIKOU 0ag Taxudpopeiou.

5. 210 npo®iA 0ac va aveBAdosTe pia QwToypagia. Av Oev EXETE NPOCWMIKN OAG
PpwToypagia, va aveBaceTe pia pwToypa®ia OXETIKN HE TOV KAADO MouU 0ac evOIaPEPE!
(va Bpeite TNV pwToypaia autry ano To diadikTuo).

6. Na oupnAnpwoeTe To BloypaPikd oac. AvaAuTIKd, va KAVETE TA MNIO KATW:

(a) Mia pikpry nepiAnwn pe Ta Baoika oToixeia Tou PBloypadikoU oag nou Bewpeite OTI
0ag EKNPoownouv.

(B) ZTo nAdioio Tng nNpolnnpeaiac, va CUPNANPWOETE av €XETE €PYACTEl KANOU, £0TW
npoowpIvda, EEKIVWVTAC and Tnv nio nNpoo®aTn €pyodoTnor 0ac, akoAouBoUpevn
ano OAeG TIG nponyoUueveC. MNa kABe pia anod auTeG, va CUMNANPWOETE TO OVOUA TNG
€TAIpEiaC NMou oac epyodoTei N oac epyodoTolos, Tov TITAO €pyaciac oag oTnv
€TAIPEia AUTN Kal cUVTOUN NEPIYPAPR YIa TO TI AKPIBWG KAVATE.

(y) Na npooBéocte Q€EIOTNTEG NMOU MIOTEUETE OTI €XeTe (n.X. AV €IOTE KAAOI OTN
dlaxeipion €pyaciwv, OTOV NPOYPAUKATIONO KAMNoIAg YAwoodag K.Ar.).
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(8) ZT0 nAdiolo TNG ekNAIBEUONG va CUPNANPWOETE TA MO KATW:

e 'Ovopa oxoAr¢ (Aukeiakn, F'upvaaoiakn, AndoTIkn eknaideuon).
e Ano noTe PEXpP! NOTE POITHOATE OE KABE pia anod auTec,
e Me noiov BaBud anogoITioaTte anod Tnv KAe pia and auTeg.
() EnminAéov, oTnv €knaideuon va nNpooBECETE Kal TUXOV AMOYEUNATIVA Pabnuata nou
moavov va €xeTe NapakoAouBnoel, TIC AVTIOTOIXEG EEETATEIC MOU EXETE NAPAKABIOEI
Kal Tn BaduoAoyia nou ExeTe NeTUXEL.

(oT) ZT0 NAGIOIO TWV YEVIKWV NANPOPOPINV TOU BIoypaPikoU VA GUHNANPWOETE:

e AN\ evlIa@EpPovTa Nou EXETE (M.X. ABANTIONO, HOUOIKN), X0pO K.An.)
e Huepopnvia yévvnong
() ZT0 NAGiolo TV YAWOOWV VA CUUNANPWOETE MOIEG YAWOOTEG YVWPICETE.
(n) ZT0 nAdiolo BpaBeiwv kal dlakpioewv va NPooBEoETE TUXOV BpaBeia r dIaKpPICEIC nou
EXETE AMOKOWITEI.

7. A@oU oAOKANPWOETE TO BIOYpaPIKO 0ac, KAAEOTE TOv KABNyNTR 0ac va To eAEyEel Kal
META va npaypaTonoinoste €£000 anod Tov Aoyapiacuo odag.
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®YAAO EPrazIAZ .5.2.M3-M4
Xpnon Koivavikawv AikTowv -Linkedin

Ti 6a padoupe onpepa:

©
@
@

Na napakoAouBouUpe £Talpeieg 1 opyaviouoUg yia avelpeon pyaociag r) anAd yia evnuépwan
Na npooBEToUE ENAPEC AvaAOYWC TwV EVOIAPEPOVTWY 1 TOU KAAOOU
Na avraAhaoooupe pnvupata (aclyxpovn €nikoIvwvia) Je AToa &iTe nou BPIioKovVTal OTIC ENAPECG

 oxl.

ApaotnpioTnTeg Epnédmwong/A&ioAoynong/Na 1o oniTi

10.

Na avoifete évav  QUA\opETPNT 10TOU KAl va HETABEITE OTnNV  10TOOEAIDA
www.linkedin.com

Na npaypaTonoinoeTe €icodo oTov Aoyaplacuod odag.

'Onwc¢ €xoupe avagepel, oTo LinkedIn €xoupe Tnv duvaToTNTa Va WYAEOUNE ETAIPEIEG N
OpYAVICHOUG OTOUG OMNoiouG HNOPOUHE va EpyodoTnOoUE.

Na petaBeite oTo onueio Tou LinkedIn nou pnopeite va To NETUXETE AUTO Kal va YAEETE
yia eTaipeie  MNMANPOPOPIKAG.  ZUYKEKPIYEVA, VA OUMNANPWOETE TA N0 KATW
XOPAKTNPIOTIKA:

(a) TonoBeoia eTaipeiac: Kunpog

(B) Eninedo EpyodoTnong: Apxapiog

(y) Topéag: Ano TIC emAoyEG nou divovTal EMIAEETE TOV TOMEA I TOUG TOWEIC Mou oag
evOIAPEPOUV VA DOUAEYETE.

Na enavaAdaBete Ta idla BAKATa yia va evroniosTe niBaveg BECEIC Epyaciag o€ ETAIPEIEG
Kanolou aAAou KAGdou nou oag evOIaPEPEL.

Mia ano TIG €TAIpEIiEC NoU 0ag evOIAPEPEl va NAPAKOAOUBEITE Kal va eVNUEPWVEDTE Eival
n Microsoft. Na kavete Ta anapaitnTa BrpaTta nou xpelidlovral, WOTE va UMOpPEITE va
EVNUEPWVEDTE YIa OTIONNOTE OXETIKO HE TN OUykekpidevn etaipeia  (Interests-
Companies).

Na enavalaBete Tnv aoknon 4, avalnTovTag kanoia aAAn €Taipeia ) opyaviopo nou 6a
0ag eVvOIEPEPE va NAPAKOAOUBEITE Kal va eVNUEPWVEDTE.

Na waEete yia va Bpeite oTo LinkedIn 000 ouppabnTeC oag ol onoiol €X0UV Kal AUTOI
Aoyapiaopo oto LinkedIn kai va Touc NpooBECETE OTIC ENAPEC OAC,.

Na dnAwoeTe and nou Toug yYVwPIlETE Kal 0TNV CUVEXEIQ Ba anooTaAei N NpookAnon oTa
aropa auta.

Na emAeEeTe pia ano Tig enageg oag ato LinkedIn kal va oTeiAeTe To NApAkAT® PRvuua:
«'Exw kavel pia npoondabeia avelpeong epyaaciag oTov Topea TnG MANPOPOPIKNAG».
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11. 210 idI0 GTOMO VO ANOOTEIAETE, €niong, kal pia PpwToypagia evoc NAEKTPOVIKOU
unoAoyioTn, Tnv onoia va Bpeite anod To diadikTuo.

12. 'OTav OAOKANPWOETE, KAAEOTE TOV KABNYNTH 0AC yia va €AEyEEl O0a E£XETE KAVEl Kal
npayuaronoinoTe €€0d0 anod Tov Aoyapiacuod oac.
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®YAANO EPrazIAz '.5.2.M5-M6
Xpnon Koivavikawv AikTowv -Linkedin

Ti 6a padoupe onpepa:
© Na avapToUUE GUOTATIKEC EMNICTOAEG O AAAa ATopa
© Na epapuoloupe anapaitnteg pubpiosic Aoyapiaopou (n.X. PUBUICEIC anoppriTou, PUBICEIG

vAwooac).

ApaoTnpioTnTeG Eunédmong/A&ioAoynong/Na To oniti

Na avoiete €vav  QUANOPETPNTA 10TOU Kal va WeTaBeite oTnv  10TooEAIDa
www.linkedin.com

Na npaypaTonoinoeTe €icodo oTov Aoyapiacuod odag.

'Onw¢ avapépape oto LinkedIn, €xoupe Tn duvaToTNTa va AvAPTAOOUME Wid OUOTATIKN
€MOTOAN yia kdnolo atodo. Eniong, AGMa dartopa e Ta onoia mbavov  va
OUVEPYAOTNKAKE EXOUV TN duvaToOTNTA VA AVAPTHOOUV CUCTATIKEG EMIOTOAEC YIa EUAC,

Na evronioete oTIC enaP&EG oac oTo LinkedIn kanoiov ouppadbnTry oac Pe Tov onoio
OUVEPYAOTNKATE YIA KAMOIA £pyaAcdia Kal va TOU OTEIAETE TO €EAC PRVUMA: «Mnopeig o
napakaAw va avapTnoeig Yia oUoTaon yia Péva OXETIKA JE TNV €pyaacia Mou €iXape KAvel
0TO Padnua TnG duoikng pag;»

Na enavaAaBete Tnv daoknon 4, YOvo nMou auTn Tn @opd va WAEETE va €EVTOMIOETE
KAMOIOV HE TOV OMoio EXETE DOUAEWEI £0TW KAl MPOCWPIVA KAMOU Kal va Tou {nNTnoeTe va
OUVTGEEl pia ouoTaTikn €NIOTOAR yia €04G,.

Na evToniosTe OTIG €NAQEG 0AG KAMOIOV HE TOV OMOI0 EXETE OUVEPYAOTEI Kal vd

OUVTAEETE Wia ouoTaTikn €NIOTOAR yI' auTdv. AVaAUTIKA:

(a) ZTo npwTo NAGiclo, va ypAyeTe OAEG TIG CUCTACEIG OXETIKA E TA NPOCOvVTA yia T
onoia NpoTEiVETE TO ATOUO AUTO.

(B) ZTo deUTepo MAdiclo, va ypAWETE €va WAVUMA HE TO OMoio va anseuBbuveoTe GTO
ATOMO YIa TO 0Moio €TOIPAlETE TN OUCTAGK, YIA VA TOV EVNHEPWOETE YI' QUTO.

(y) ZTO TPiTO, TETAPTO KAl NEPNTO NAQICIO, VA CUUNANPWOETE TN OXEON MOU EXETE PE TO
artopo auto (n.X. av €ioTe CUPPABNTEC, CUUQOITNTEC, av doUAEwaTe pad, T B€on
€ixe 0 kabevag k.An.)

(®) Na emAe€eTe Send, yia va yivel avapTnon TNG CUOTATIKAG EMIOTOANG.

>TIC pubuiosic anoppiTou Tou Aoyapiacuou oac oto LinkedIn va kavete TIC €ENC
al\ayeg:

(a) Tic diapopeg evepyeleg nou kavete aTo LinkedIn va Tig BAENETE POVO EOEIC,

(B) 'Otav emiokepBeiTe TO MNPOPIA €vOC GAAOU aTOMOU, OTO MAVUMA nou 6a Tou
anooTaAei and Tov Aoyapiaopd Tou, va €PPavideTal To OVOPA 0ac Kal O TITAOG
€pYaociag oag i To €ToC OTO OMNoIo POITATE KATA TNV TPEXOUTA Xpovid.

(y) Tn owToypagia Tou npo@i\ oac va Tn BAENOUV YOVO ol ENAPEC oac.
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8. Ano TIC pubuioelc enikovwviag va opioeTe TI email va AauBAveTe 0TO NAEKTPOVIKO 0ag
Tayxudpopeio oxeTika We To LinkedIn (n.x OTav kanolo¢ BéAel va oac NpooBECEl OTIC
ENAPEC TOU).

9. AnoO TIC pUBIOEIG ENIKOIVWVIAG VA OPICETE, €NiONG, OTI PNOPEITE va AAUBAVETE PnvUuaTa
Kal €100MoINCEIC anod OAOUG.

10. ZTIc puBuioeic Aoyapiaopou va emAEEETE yAwooa: EAANVIKA.

11. 'OTav oAOKANPWOETE, Va KAAEDETE TOV KABNyNTNH 0ac va eAéyEel Tnv dOUAEIG 0ag Kal OTn
OUVEXEIQ va eNINEEETE €6000 and To ouoTNUA.
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®YAANO EPrAazIAZ .5.2.M7-M8
Xpnon Koivavikav AikTuwv -Twitter

Ti 6a padoupe onpepa:

© Na dnuioupyoUue Aoyapiacpuo oto Twitter

© Na eneEepyalopacTe To NPOPIA pag

© Na spappoloupe anapaiTnTeG pubuiceic anopprTou Aoyapiaopou.

ApaoTnpioTnTeg EUnédmwong

1.

Na avoiete €vav  QUANOPETPNTA 10TOU Kal va WeTaBeite oTnv  10TooEAIDa
www.twitter.com

Na dnpioupynoeTe évav Aoyapiacud oto twitter. MNa Tn dnuioupyia Tou Aoyapiacpou Ba
XPEIQOTEITE:

(a) ARAwon ovopaTenwvUHOU.
(B) AiguBuvon nAekTpovikoU Taxudpopeiou (email).

(y) Na peraBeite 0T0 NAekTPOVIKO 0aC Taxudpopeio yia va deite To verification code nou
0a¢ €xel OTAAEl kal va CUPNANPWOETE TO NAdiIGIO 0To onoio aacg To {NTa.

(0) Kwdikd npdoRaong.
() Na napaleiyete TO BriKa NPoodBRKNG PwToypaAPIiac.
(oT)Na ypaweTe kAt NOAU GUVTOMO YIa £0AC.

(©) Na napaleiyete To BAPA Ke TIC ENAPEG Nou gugavifovtal, Bacesl Tou Aoyapiacpou
MOU EXETE OTO NAEKTPOVIKO TAXUOPOHEIO.

(n) Na eniAeEeTe kanola and Ta evolaPEPOVTA oac.

() Na eniAé€eTe KkaAnoleG enaQég anod TIC MNPOTEIVOPEVEG nou Ba BélaTte va
akoAouBnoeTe.

(1) Na napaAeiyete TNV Evepyonoinaon €I00MoINCEWV.

(1a) Na npayuaTtonoinosTe €€0d0 and Tov Aoyapiacuo oac.

Na npaypaTonoinoeTe €i0odo oTov Aoyaplacuo oag oTo twitter.

Me Tnv €l0aywyn 0ag oTov Aoyapiaopd oag, va €nNEEETe KCII OTNn OUVEXEID

| Edit profile...‘ ' ' ' ' '
: ~(OTE va KAVETE TIC NAPAKATW AAAayEG OTo NPOYIA oag:

(a) Na sioayayete pia @wToypagia (av dev EXETE MPOCWNIKA 0a4g PwToypadia vd
XPNOILONOINOETE Wia pwToypa®ia eniAoync aac anod To diadikTuo).

(B) Na oupnAnpwoeTe To Ovoud oac (av dev epPavileTal GURNANPWHEVO).
(y) Na dwoete gUvToun Nepypagn Tou Bloypagikou oag (Bio).
(0) Na ypaweTe Tn Xwpa nou OIaUEVETE.

(e) Na ypayeTe nuepopnvia yévvnong.
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Na enAEEeTe TO Kouuni Kal oTn ouvexela Settings and privacy. AkoAouBwg

va enAeéEeTe TIC puBpiosic anoppnTou (Privacy and safety) kai va kavete TIC €EAC

ahhayec:

(a) Kaveic va pnv pnopei va oag emonuaivel o€ kanoia ewrtoypagia (Photo tagging).

(B) Tic dnuooieloeic oac va TIC BAénouv oMol (To Protect your Tweets va pnv eivai
EMAEYHEVO).

(y) Na pnv epeaviletar TonoBeoia (Location information) oTic dnuooieuoeig (tweets)
oag,

(0) Na pnv pnopei Kaveic va 0ac evroniosl YEOWw TOU NAEKTPOVIKOU 0ag TaxudpoEiou
(Discoverability).

() Movo enagec nou akoAOUBEiTE va pNopouv va oag NPooBECouv O Kanolia opada
(Twitter for teams).

(oT)Na pnopeite va AauBavere ynvupaTa anod oAoug (receive messages from anyone).

ApaoTnpioTnTeg AEIoAGYNONG

Na aAAa&eTe TN @wTOypagia Tou NpoPiA oac e kamola AAAn Tng emAoyng oag (Tnv
onoia Pnopeite va Bpeite anod To diadikTuo).

Na npooBeceTe kanola GwToypagia TnG €nIAOYNG aag otnv ke@aAida Tou Npo®iA oag
(Tnv onoia pnopeite va Bpeite ano To d1adikTuo).

3TIC puUBUICEIC anoppnToU, va KAVETE TNV anapaitnTn aAAayr, €TOI WOTE va WMOPEi
KAMoIOG Va 0ag EVTOMICEl HEGW TOU NAEKTPOVIKOU Gag TaxudpoEiou.

>TIG puBNioEIC anoppATOU va KAVETE TNV anapaitnTn aliayn, £Tol WOTE va PNV PNopEi
KAMolog nou dev akoAOUBEITE va oag oTeiAel prvupa.

~+ Eninp6o0eTec ApaoTnpiéTnTECG

10.

11.

Na Bpeite pia pwToypagia oto d1adikTuo nou va aneikovifel To AoyoTuno Tou twitter kai
va TNV NPooBECETE 0av KEPAAida aTo NpogiA oac.

Av ano TI¢ pubuioelic anoppnTou €MIAEEETE va NPOCTATEUOETE TIC dnUoaleloel (tweets)
oac, T Ba neTUXETE;
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ApaocTnpIOTNTEG YIA TO ZNiTI

12. T €ival anapaitnTo va €XETE, yia va WNOPEITE va OnUIOUPYNOETE £vav Aoyapiacud oTo
twitter;
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®yvAAO EPrazIAz IN5.2.M9-M10
Xpnon Koiveavikov AikTuwv -Twitter

Ti 6a padoupe onpepa:

@ Na avalntoupe kai va akoAhouBouUue (follow) AoyapiacpouUc (aTopa, oeNideC, opyaviououg K.Am.)

% Na dnuioupyoupe B€pa npog oulnTnon (tweet)

% Na napakoAouBoUpe kai va oxoANialoupe BépaTta npog ouliTnon nou €xouv dnuioupyndei anod

aMoug (#hashtag)

@ Na anavrouye / oxohidloupe (reply), va koivornoioUye (re-tweet) kai va €mMONPAIVOUUE G

ayannuévo (favorite) kanoio Bua.
ApaoTtnpioTnTeG EPnédmong

1. Na avoiete é&vav  QUANOMETPNTR 10TOU Kal va MeTaBeite otnv  10TO0EAIDA
www.twitter.com

2. Na npaypaTtonoinosTe €i0000 TOV Aoydpiacuo oag oTo twitter.

3. Na avalnmioete kal va Bpeite TNV enionun oehida Tou TAvvn AVTEVTOKOUVHMO
(@Giannis_An34) aTo twitter kai va eniAeEeTe Akoloubia (follow).

4. Ano nou 6a kaTaAapeTe OTI TO NPOPIA Tou Aoyapiacpou nou BpRkaTe gival aubevTiko Kal
OXI WeUTIKO;

5. Na avalnTiosTe kal va Bpeite &va cupuadnT oag nou €xel Aoyapiacud oTo twitter kai
va eniAeEeTe Akoloubia (follow).

6. Na OnuioupynoeTe éva BEpa oulnTnong, N.X AnoTeAéopaTa aywva nodoogaipou, Kai va
YPAWETE Mia HIKPN MEPIYPAPN) OXETIKA HE TO AMOTEAECUA TOU TEAEUTAIOU aywva Tng
ayannuévng oag opadag (Mnv kavere akopn tweet).

7. Na Bpeite pia pwToypagia oto dIadikTuo OXETIKA e TNV ayannuévn oag opada, va Tnv
EMNICUVAYETE OTNV NEPIYPAP Nou dwodaTe aTnV aoknon 6 kal va natnoete Tweet.

8. Na anavTtroeTe o€ Tuxov oxoAia nou Ba yivouv kaTw and Tn dnuocicuon oag (reply).

9. Na yagete va PBpeite kanolo Bepa oulTNONG Nou 0ac vOIAMPEPEl KAl va OXONIAOETE
Kanola ano TIC dnPoaIeVUCEIC NMou €yIVE yia Ta B€ua auTo.

10. Na koivonoinoete (re-tweet) kanoia anod TIC dNUOOCIEUCEIC MOU EYIVE yia TO BEua nou
evronioarte aTnv acknon 9.

11. Na emonuavete wg ayannuévn (favorite) Tn dnUOGCIEUGN NMOU 0AC APECE MEPICOOTEPO

OXETIKA WE TO B€pa oulTnoNg TNG doknaong 9.
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ApaoTnpioTnTeg ASI0A0YNONG

12.

13.

14.

15.

16.

Na avalntioete kamolo Bépa oulnTnong oxetika Pe To NBA (National Basketball
Association).

Na diaBaceTe Ta diagopa oxOAia nou avapTnenkav yia To Bua auTo.
Na ypaweTe To 0IkO 0ac OXOAIO OXETIKA JE AUTO TO BENa.
Na koivonoinoeTe (re-tweet) kanoia anod TIC ONUOCIEVCEIG NOU £YIVE KAl A APECE.

Na emonpavete we ayannuevn (favorite) Tn dnuoaisuon autn.

=+ Eninpoo0eTec ApaoTnpioTNTEG

17.

18.

19.

Na dnuioupynoeTe éva Bpa npog oulnTnon (#6&ua_ouliTnong).

Na avalnTrioeTe kanolo Bpa oulnTNONG NoU 0ac evOIAPEPE! KAl va TO KOIVOMOINOETE (re-
tweet).

Na ypayeTe kaAnolo eNINAEOV OXONIO yia To BEWa auTo.

ApacTnpIOTNTEG yia TO ZNiTI

Ti  onuaivel TO nou ep@avileTal o€ kanoia NPogiA Aoyapiacpwyv oTo twitter;
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®YANO EPrAZIAZ L5.3.M1
EqapHoyEg ZUyxpovng Enikoivoviag- Skype

Ti 6a padoupe onpepa:

© Na dnuioupyoUpe Aoyapiacuo oto Skype
© Na eykaBioToUuue TNV epappoyn Skype
© Na eneEepyalOPaAcTe To NPOPIA pac.

ApaoTnpioTnTeg EUnédmwong

Na avoi&ete évav QUANOPETPNTR 10TOU Kal va PETABeITe oTn oghida www.skype.com

>Tn oeAida nou avoiyeTal pnpooTd oac, va eniAéEéste Download Skype yia va
npayuaTonoInosTe Awn TNG Epapuoync.

Na eykaTaoTrnoETE TNV €pApPUOYN Nou KaTeRAceTe O oTov UnoAoyioTr oac (aoknon 2).

3TN OUVEXEID va NPayuaTonolnoeTe eyypadn (sign up) oto Skype. MNa va 1o nNeTUXeTE
auTo, XpEIaleTal va CUPNANPWOETE TA MO KATW:

(a) ApiBuoc TNAepwvou 1y dieUBuvan NAEKTPOVIKOU TaxudPOMEiouU
(B) Kwdikoc Npoopaong

(y) Ovopatenwvupo

(0) Hpepounvia yévvnong kai xwpa

() EnaAnBeuon Aoyapiacpou pe kwdiko oTo email

(oT) ZupNANPWON AUTONATONOINKEVOU PNVUMATOG
Na npayuaTonoinoeTe €icodo aTnv e@appoyn oto Skype.

270 nNpoQiA 0ag va npocoBEéoeTe pia QwToypagia Tng emAoyng oag, Tnv omnoia va
kaTeBaosTe ano 1o AiadikTuo.

ApaoTnpioTnTeG AEI0AOYNONG

Na aMa&ete Tn QwToypagia Tou npo@iA cac. H kaivoupia QwToypagia nou 6a
aveBdaoeTe 0TO NPOPIA 0ac va gival npoownikr). EiTe va Tnv napete and Tov Aoyapiacuod
oag oTo facebook eiTe av €xeTe ouUVOEBEPEVN KAUEPA OTOV UMOAOYIOTH, va TPaBnEeTe pia
AuEDa Kal va Tn XPnoiKonoINCETE.

2TO NPOQIA 0ag, €niong, va NPooBETETE To Wrivupa 81aBeang: «Xaiapd!!!»

Tnv €@apyoyry Tou Skype nou KaTteBAcATE OTOV UMOAOYIOTH OAC, WMOPEITE va TNV
avTIYPAWYETE KAl va TNV EYKATAOTACETE Kal aA\ou;
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10. Na npaypaTonoinoste €£000 anod TNV EQapuoyn.
=+ EninpooeTec ApaoTnpioTnTEC
11. Na npaypaTonoinosTe €icodo oTnV papuoyn.
12. Na aAAa&ete To prvupa d1absonc oac and «Xahapa!!!» og «H {wn) gival wpaia».
13. Na npaypaTonoinoste €€0d0 anod Tnv EQpapuoyn.
ApaoTnpIOTNTEG yia TO ZNiTI
14. Na wa&ete oo BIBAio oag ) oo 81adikTuO Toucg AOYOUC yia TOUC Oroiouc XpnoildonolsiTal

n epappoyr Skype.
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®YAAO EPrazIAz IN.5.3.M2-M3
EQappoyég ZUyxpovng Enikoivaviag- Skype

Ti 6a padoupe onpepa:

©

@
©

Na e@apuoloupe anapaitnTeC pubuicsic Aoyapiacuol (puBuicelc anoppnTou, aMoKAEIGUOU
ENAPWV, PUBUIOCEIG EI00MOINOEWY, PUBUIOEIC KANOEWY, pUBIOEIG BivTE0)

Na avalnTouye Kal va NPooBETOUPE ATOUA OTIC ENAPEC

Na enikoivwvoUpe aueoa rj acuyxpova Je aAAa npoowna PYEow Tou Skype o€ aTOMIKO ) opadiko
eninedo e ypanta ynvupara.

ApaoTnpioTnTeC EUnédmwong

1. Na peraBeite oTnv epappoyr Skype.

2. Na npayuaTonoinosTe €i0000 TNV €QApPHOYN.

3. Na wda&ete va Bpeite kal va NPooOECETE OTIC ENAPEC 0AC TPEIG CUMKABNTEG 0ag nou
€Xouv, eniong, Aoyapiacud oto Skype.

4. Av kanoiol anod TouG CUMKABNTEG 0ac 0ac £XOUV OTEIAEI aiTnUa NPOoONKNG OTIG ENAPEC
TOUG, va eniAeEeTe anodoxn.

5. Na eniAé€&ete To NpwTo ATOPO aAnd TIC ENAPEG OAC KAl va TOU OTEIAETE TO ypanTod
MAVUMQ: «Z€ XAIPETW!».

6. Na dnuIoUpyNOETE OUAdA 2 ATOPWVY KAl VA TOUG OTEIAETE TO PAVUPA «TI KAVETE;».

7. ZTIG puBpioeIg va KAveTe TIG €ENG aAAayEC:
(a) Na aAAaete Tn yYAwooa npoBoAng TG EQApHoyng o€ EAANVIKA.
(B) Na emi\e€eTe éva anod Ta AToua OTIC ENAPEC 0aG KAl va TOV/TNV ArNOKAEIOETE.
(y) Na ypayete nwg To NETUXATE AUTO.

8. ZTIg pubpioeig anokAsIoKoU ENAPWV va KAVETE TIG ENG aANAYEG:
(a) Na apaipéoeTe TO ATOHO NOU ANOKAEIOATE ano TIG ANOKAEIOPEVEC ENAPEC.
(B) Na ypaweTe nwg To NETUXATE AUTO.

ApaoTtnpioTnTeg ASI0AOYNONG

9. Na anokAioeTe ano TIC ENAPEC 0ac TO NPWTO ATOUO NOoU NPooBEéaaTe aTn AioTa ENAPV
0ag,

10. Na dnpioupynosTe pia opada TpIwv atopwv (and auTd Nou EXETE OTIC ENAPEC 0AG) Kal

va Toug OTeiAeTE TQUTOXPOVA TO PAvupa: «Mape napalia;».
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11.

12.

Na avalpéoeTe TOV AnoKAEIONO ENAgnc Nou KAvaTte oTnv acknon 9.

Na npaypaTonoinosTe €£000 anod Tnv EQapuoyn.

=+ EninpooBerec ApacTnpioTnTEC

13.

14.

15.

16.

17.

18.

Na npaypaTonoinosTe €i0od0 oTnV £(papuoyn.
Na npooB&oeTe OTIC ENAPEC 0ag akoun dUo aTopa anod Tnv Taén oac.

Av kanoiol and TOUC CUPHABNTEC 0aC 0ac £XOUV OTEIAEl aiTnUa NPooBnKNG OTIC ENAPEC
TOUG, va eNIAEEETE anodoxn.

>Tnv opada nou dnuioupynoaTe oTnv doknon 10 va oTei\eTe TO ypanTd prvupa: « To
>appRaTo Aéw... ©a naye napaAia;»

Na OciTe noiol 6a 0ag anavToouv apvnTIKA Kal nolol BETIKA Kal va anavTrosTe Niow e
avaloyo oxoAio.

Na npaypaTonoinoste €£000 anod Tnv EQapuoyn.

ApacTnpIOTNTEG yia TO ZniTI

19.

20.

O1 enagEg nou £xeTe anokAecioel unopouv va €pbouv o€ enikoivwvia padi oag;

Ti yivetal oTnv nePINTWON MOU OTEIAOUME MNVUMA o€ kdanolov nou Oev  €ival
OUVOEDENEVOG EKEIVN TN OTIYHN;
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®YAAO EPraziAz IN.5.3.M4-M5
EQappoyég ZUyxpovng Enikoivaviag- Skype

Ti 6a padoupe onpepa:
© Na avraAAaloups apyeia, pwToypapisc, ENAPEC Kai BivreounvupaTa
© Na enikolvwvoUue dueaa n acuyxpova Pe AGAa npdowna PJEow Tou Skype oe AToHIKO ) opadiko

eninedo, TNAEPWVIKWG 1 PE BIVTEOKANON.

ApaoTnpioTnTeg EUnédmwong

10.

Na svepyornoinosTe Tnv epapuoyn Skype.
Na npaypaTonoinoeTe €i00do OTnV EPApuoyn.

Na eAayxioTonoinoere (minimize) Tnv e€pappoyr) Tou Skype kal va avoifete éva
kaivoupylo apyeio otn Word. Na ypdyete Hello there!!!. Na To ano®nkeloeTe oTov
unoAoyloTn oag We To ovopa Hello.docx

Na avoifete évav uAopeTpnTr 10TOU. 2T pnxavn avalitnong Goggle va ypayerte
«Hello there» kal va kavete avalnTnon ekovag. And Ta anoteAéopata nou Oa
€UPAVIOTOUV UNPOOTA 0aG, va €MAEEETE 2 PpWTOYPAPIEG TNG APECKEIAG 0AG Kal va TIG
anoBbnkeUCETE OTOV UMOAOYIOTH OaC.

Na peyioTonoinoeTe (maximize) Tnv epappoyn Skype.

Na oTeiAeTe o€ €vav and TOuG CUKHABNTEG 0ag, Nou EXETE OTIC ENAPEG 0ag aTo Skype,
TO NAPAKATW YPANTO WAVUMA: «Z0U OTEAVW TO APXEIO Kal TIC PWTOYPAPIEG MOU |ou

{nTnoeg!».

3TN OUVEXEIQ, va E€MICUVAYETE KAl va OTEIAETE OTO ATOWO AuTO To apxeio Tng Word
Hello.docx, nou €xeTe anoBnKeUPEVO GTOV UNOAOYIOTH OAG.

Eniong, va emouvayeTe kal va oTeiAeTe 0TO i010 ATOMO TIG 2 PWTOYPAPIES NOU BpNKaTe
oTo d1adikTuO Kal anobnkeloaTe OTOV UMOAOYIOTH OdC.

Na oTeileTe €va PBivreopnvupa oTO 010 ATOPO. Mnopeite; TI OUOKEUEC €nINAEOV
XPEIGlEOTE yIa va TO NETUXETE AUTO;

Na JoKIJAoeTE va npayhaTonoinoeTe BIVTEOKANON WE €va anod Ta ATOpd TWV E€NAP®V
0ac. Mnopeite; TI GUOKEUEG eniNAEoV XpelaleoTe yI' auTo;
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ApaoTnpioTnTeG AEIoAGYNONG

12. Na npooBeoeTe €va PIKPOPWVO Kal Wia KAPepa oTov unoAoyioTh oac (O NEPINTWaOn Nnou
TO OXOA€io dev DIABETEI KAPEPEC, VA NPOCBETETE HOVO TO HIKPOPWVO).

13. Na npaypaTtonoinoeTe BIVTEOKANON HE £va AToMo anod TIG ENAPEG 0ag To onoio EEPeTe OTI
gival o oUvdeon (0g nepINTwON Mou TO OYoAcio Oev OIaBETeEl KAUEPEC, va
NPAyHATONoINOETE TNAEPWVIKN KARON).

14. Katd tn d1apkeia TnG BIVTEOKANONG va KaAéoeTe aAAa 3 dtopa va AAaBouv PEPOC oTnV
idla PBivreokA\non (o€ nepinTwon Mou To OxoAcio Oev  OIaBETEl  KAPEPEC, VA
NPAyPaTonoINoeTe TNAEPWVIKA KARoN).

15. ApoU TeheiwoeTe pe TN PBivTeokAnon (N TNV TNAEQWVIKN KANON), va nNpaydaTonoinNosTe
€000 and Tov Aoyapiacpo oag oTnv papuoyn.

4+ Eninpoo0eTec ApaoTnpioTnTEC

16. Na npaypaTonoinosTe €i0odo TNV papuoyn.

17. Na npoonabnosTe va npaypaTonoinoeTe TNAEPWVIKN KARON ME Wia ano TIG enageg adc.

18. MpoonabnoTe va peTapeite ano TNAEPWVIKA KANaon o€ BivreokAnon. Mwg PNopeiTe va To
NETUXETE QUTO;

19. AokipaoTe va petaBeite and Tnv PIvTEOKANON niow oTnv TNAEQWVIKR KARon. Mwg
MMOPEITE va TO NETUXETE AUTO;

20. Na npaypartonoinoeTe €€000 and Tnv papuoyn.

ApaoTnpIOTNTEG YIa TO ZNiTI

21. Na €&nynosTe Ta NapakaTw €ikovidia:




5.3 Eqpappoyég AiadpaoTikig Enikoivoviag r.5.3.M4-M5
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®DYAAO EPrAzIAZ 5.3.M6
E@appoyég ZUyxpovng Enikoivaviag- Google Hangouts

Ti 6a padoupe onpepa:
@ Na ouvdeopaoTe oTto Google Hangouts
© Na evtonifoue Kal va NPOooBETOUHE ENAPEC,

ApaoTnpioTnTeg EUnédmong

Na avoiete é&vav  QUANOMETPNTA 10TOU Kal va WetaBeite otnv  10TooEAIDA
www.hangouts.google.com.

Na npaypaTonoinoeTe €loaywyn oTo hangouts.

Na wagete va PBpeite TPeIG QIAOUC KAl va TOUG NPOCOECETE OTIC ENAPEG OAG,
anoaTeA\OVTAg TOUG NPOGKANGN.

Av kanoiol and Toug QIAOUC N CUPHABNTEC 0ag 0acg amnooTeEiAOUV HE TN O€ipd TOUG
npOokAnon, va eniAe€eTe Anodoxn).

Na npaypaTonoinoste €€000 anod Tov Aoyapiacuo.

ApaoTnpioTnTeg ASI0AGYNONG

Ti Aoyapiaopd NAEKTPOVIKOU TaXUDPOUEIOU MPENEl va €EXETE, YiA va MNOPECETE va
npayuaTonoInosTe €i00d0 0To Hangouts;

Mépa and Toug @IAoUG Nou NpooBecaTte oTnv acknon 3, va Wa&ete va Ppeite akopa 2
QIAOUG Kal va Toug OTEIAETE NPOOKANGDN.

Av kdnoiol and Toug (IAOUG 1} CUMHABNTEG 0aG 0ag AnooTEIAOUV HE TN O€Ipd TOUG
npookAnon va eniAeEeTe Anodoxn.

=+ Eninp6o0eTec ApaoTnpioTnTES

Me Tnv €i0od0 oag oTtov Aoyapiacud Tou Hangouts, TI
duvaToTNTEC PAIVETAI VA EXETE O€ BEPATA EMIKOIVWVIAC;



http://www.hangouts.google.com./

5.3 Eqpappoyég AiadpaoTikig Enikoivoviag r.5.3.M6

ApaocTnpIOTNTEG YIA TO ZNiTI

10. XpeialeTal va npayuaTornoinosTe €yypa®r) oto Hangouts yia va HMNOPECETE va TO
XPNOILOMOINOETE;
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®YANO EPrAzIAZ .5.3.M7
EQappoyeg Zuyxpovng Enikoivaviag-Google Hangouts

Ti 6a padoupe onpepa:

@ Na enikolivwvoUue apeoa f aclyxpova pe aAa npoéowna péow Tou Google Hangouts o€ aTouIKO N
opadIko eninedo Pe ypanTd Pnvupara.

% Na enikolivwvoUpEe apeoa i aclyxpova he aAa npoowna péow Tou Google Hangouts o€ aTopiko N
opadikod €NiNedo TNAEPWVIKWG ) HE BIVTEOKANON.

ApaoTnpioTnTEG EPnédmong

1. Na avoiete ¢€vav  @uUANopeTpnT) I10TOU Kal  va WeTaBeite  oTn  oghida
www.hangouts.google.org

2. Na npayuartonoinoete €icodo oTo hangouts.

3. Na oteileTe TO ypanTd PAVUMA «KaAnuéPa» OTO MNPWTO ATOMO MOU EXETE OTIC EMAPEC
oac.

4. Na OnuIoUpyNOETE Mia opada TPIwWV ATOMWV Kal va TOUG anoaTEIAETE TAuTOXpOva TO
ypanTo pnvupa «Ti yivetal naidia; ‘'OAa kaAa;».

5. Na npaypatonoinoeTe BIVTEOKANON HE TO TEAEUTAIO ATOMO MOU EXETE OTIC ENAPEC OAC.
MnopeiTe va npaypatonoinoeTe BIVTEOKANON; Av OXI, TI XPEIQlEOTE yIa va TO METUXETE
auTo;

ApaoTnpioTnTeG AEIOAGYNONG

6. Na npooBEoETE HIKPOPWVO OTOV UNOAOYIOTH 0ac.

7. Mg Tnv npoaBnkn Tou HIKPOPWVOU, TI €I60UG KANON MNOPEITE va eNITUXETE (TNAEPWVIKA
N BIvTeokAnon);

8. Na npaypaTtonoinoeTe TNV avTioToixn KANon oTnv onoia kataAn&arte oTnv aoknon 7, yia
va OUVOUIANCETE HE Mia ano TIG ENagEG odg.

9. Kabwg WAATE, EMIAEETE TO €IKOVIOIO TOU HIKPOPWVOU Mou epgavifeTal oto napadupo
ouvopiAiac. TI napaTtnpeite;
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5.3 EpappoyEg AladpaocTiking Emkoivoviag r.5.3.mM7

10. Na EavaeniAéEeTe TO HIKPOPWVO Nou epgavileTal oTo Napabupo cuvopiAiac. Twpa T
napaTnpeiTe;

4+ EninpooBerec ApacTnpioTnTES

11. Na npaypatonoinosTe TNAEPWVIKN ENIKOIVWVIa TauTdXpova We 2 dToua Twv enagwv oag.

12. Mw¢ TO NETUXATE AUTO;

ApaocTnpIOTNTEG yia TO ZNiTI

13. Na &nynoste Ta ocUPBoAa nou gugavifovTal oTo Napabupo TNAEPWVIKAC ENIKOIVAVIAC:
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5.4 A1adIKTUaKEG EqpapHOYEG
XapTtoypagpnong
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®YAAO EPrAZIAZ 5.4.M1
Anpoupyia ka1 EneEgpyacia NMpoowmkou Xaptn Auo
AlaocTacswv

Ti 6a paboupe onpepa:

© Na dnuIoupyoUUE €vav Npoowniko XapTn

© Na ovopaloupe kai va nepypagpouie Evav NPoowniko XapTn

© Na sioayoups, va diaypapoupe kal va eneepyaldopacTe otpwpata (layers)
© Na npooBEToupe kal va ene€epyalOPaAcTe ONUEIa EVOIQPEPOVTOC,.

ApaoTnpioTnTeC EUnédmwong

1. Xpnolgornolwvtag TO MPooWNIKO ©ac Aoyapiacpd oTtnv  unnpeocia  Gmail, va
ONMIOUPYNOETE évav XapTn HE To Ovopa «Oi1 MOoAeIg Tng Kunpou».

2. Na dwoEeTE TO NI0 KATW OXOAI0 WG NePypagn: «O NpwTOC Hou XapTne»
3. Na dwoeTe ovopa oTo NpwTo oTpwia (Layer): «Or €€l nOAeIG TnG Kunpou»

4. Na npooB&oeTe onueia evOIaPEPOVTOC OTIG MIO KATW NOAEIC TnG Kunpou:
(a) Aeukwoia

(B) Aepeoog
(y) Adpvaka
(9) AppOXWOTOG
(e) Magog
(oT)Kepuveia

5. e ka@Be onueio va dwoete To ‘Ovopa Tng MOAng oTnv onoia BpioKeTal TOMNOBETNHEVO.

6. Na aMa&ete To €ikovidlo TwWV onueiwv evilaPEPOVTOG PE €IKOVIDIo BIKNG 0ag €nIAOYNG.
MnopeiTe va XpnolPonoInosTe kanolo anod Ta diabéaipa sikovidia.

7. Na xpnoiponoinosTe dIaQopeETIKO XpwHA Yia kABs Eva and Ta onueia evolapEPOVTOG.

8. XpnoiponoiwvTag pnxavr avalntnonc, va Bpeite NAnpopopiec yia kabe pia and Tic €8
NOAEIC Kal va NPooBEoETE dUO — TPEIC YPAMMEC OE KABE ONEio.

9. XpnolgonolwvTag Wnxavr avalnTnong, va PBpeiTe pia XapakTnpioTiKn €KOva yia Kaee
NOAN Kal va Tnv NPooBECETE 0€ KABE onueio.

ApaoTnpioTnTeg ASI0AOYNONG

10. Na dnpIoupyRoETE KaIvoUpIO OTPWHA KAl VA TO OVOUACETE «KWHONOAEIC».

11. Na npooB&oeTe 0TO KaAIvOUpIo OTpwHA dUo onueia evdlapePovToc, €va yia Tn Mopeou
kal é&va yia To Pilokapnaaco.
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12. Na dwoete TOo Ovopa «KwponoAn Mopgou» kal «KwuonoAn Pilokapndcou» oe KaBe
onueio, avTioToIXa.

13. Na aAAGEETE TO XpwHa Kal TO EIKOVIOIO TWV GNUEIWV.

14. Xpnoiponoiwvtag pnxavr avalntnone, va Bpeite nAnpo@opieg yia Ta dUo onueia kai va
NPOOBOECETE dUO — TPEIC YPAUUEG OE KABE ONEio.

15. XpnoidonoiwvTac pnxavr avalntnong, va Bpeite U0 XapakTNPIOTIKEG EIKOVEG yia KABe
KWHOMNOAN. TN OUVEXEld, va TIG NpooBeoeTe aTa dUo onpeia.

=+ EninpooBerec ApacTnpioTnTEC

16. 210 OTPWHA KWPOMNOAEIG va NpogBeceTe onuEio eviIaPEPOVTOG yia Tnv MoAn Xpuooxouc,.
Na OwoeTe TOo Ovopa «KwponoAn MOAewg XpuooxoUc». ZTn OUVEXeEld, va PpeiTe
NANPOPOPIEC kal TOUAdXIOTOV OUO EIKOVEC Kal va TIG NPOCBETETE OTO GNUEIO.

ApaoTnpIOTNTEG yia TO ZNiTI
17. Na npooBeoeTe o€ KaivoUpIo GTPWHA TO onoio kal 6a ovoudaceTe «Téooepa XwpIa TNG

enapxiac pou», TEooepa onueia evolapepovToc. Kabe éva onpeio Ba avTioToIxei o€ €va
Xwp10 dIKAC oag emnAoyng and Tnv enapxiac oac. EninAgov, yia kGBe onpeio Ba npenel va
BaAeTe eIkOveEG kal neplypa®n (1-2 ypappeg).
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®YANO EPTAZIAZ N.5.4.M2
Anpoupyia ka1 EneEgpyacia NMpoowmkou Xaptn Auo
AlaocTacswv

Ti 6a padoupe onpepa:

@

o2

Na dnuioupyoUpe kal va eneEepyalopaoTe dladpoeg Wéoa oTo xaptn (nefonopiag, auTokIviTou,
MEoWV PadKNG METAPOPAG: aEponAAvVoU, AEWPOpPEIoU, TPEVOU)
Na unoAoyilouye Tnv anooTaon.

ApaoTnpioTnTeC EUnédmwong

10.

11.

XpnoigonolwvTtag Tov Npoownikd oag Aoyapiaopod otnv  unnpecia  Gmail, va
ONMIOUPYNOETE £vav XApTn HE TO OVOUA «AnNHIOUpYWVTAG AIADPOHES».

Na dwoETE TO MIO KATW OXOAIO WG NEPIYPAPR) OTOV XAPTN: «O deUTEPOG POU XAPTNG»
Na dWOETE OTO NPWTO OTPWHA TOU XAPTN TO OVOUA: «TO OXOAEIO HOU».

Na evToniosTe To OXOA€I0O 0aG Weoa oTov XAPTN Kal, XPNOILONoInvVTag To epyaieio TG
onuioupyiag ypapung (draw line), va oxnUaTioeTe TNV NEPIOXN £TCI MOU va NEPIKAEIEI
MEoa To oxoAcio oac. Na ovopdoeTe To NoAUYwvo nou Ba oxnNUaTIoTeEl Je TO Ovopa Tou
oXOAgiou aag.

Na Jop@onoInoeTe To NOAUYWVO NOU GXNHATIOTNKE WG AKOAOUBWC:
Na aAGEeTe To XpwHa Tou NOAUYWVOU HE XpwHa OIKAG 0ag ENMIAOYNC.

Na Bpeite and pnxavn avalnTnong €IKOva yia To OXOAEI0 0ag Kal va TNV NPOoBECETE OTO
NoAUywvo. Q¢ axOAIo, va NpogBeaEeTe TNV NUEPOMNVia 1I0pUCEWG TOU OXOAEiOU.

Na evTonioeTe To ONiTI 0ag JEoa oTov XapTtn. 'Onwg kAvate kal oTnv aoknon 4 yia To
OXOA€io, va XpnOoIPoMnoINOsTeE TO €pyaAsio TnG dnuioupyiag ypapung kai va oxnuaTiosTe
TNV nepIoxn €TOl MOU va nepikAgiel Peoa To oniti oag. Na dWOETE OVopa OTO MOAUYWVO
nou Ba oxnuaTioTei «To OniTI Jou».

XpnaoiponolnvTag To epyaieio dnuioupyiag ypauung kai péoa and tnv evroAn add driving
route, va BpeiTe kal va oxedIA0ETE oTOV XAPTN TNV 0dIkA diadpour anod To OniTl 0dc OTo
OXOAeio.

Na aMda€ete Tnv odikn diadpopny kai va Ppeite Tn diadpoury nou Ba kaAvate oTnv
NEPINTWON NOU avTi yia auTokivnTo Ba nnyaivaTte oTo oxoAcio Pe Ta nodia.

Na PETPAOETE TNV anooTacn and TO OMiTI 0aG PEXPI TO OXOAEio, TOOO yia TNV 0dIKN
diadpopn 000 kai yia Tn diadpoun Pe Ta nddia.
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ApaoTnpioTnTeG AEIoAGYNONG

e autd TO oOnueio Ba enavaAdBoupe Tn dladikacia Mou KAvape OTIG OpAoTnPIOTNTEG
eunédwong, ald Twpa avTi va XPNoIYOMNoINCOUKE anod TN YPAUUN €PYAAEiV TO €IKOVIOIO
draw line, 6a xpnoiponoinooupe To €ikovidio add directions.

12.

13.

14.

15.

16.

17.

18.

Na eniAé€eTe To add directions kal 0To kavoupIo OTPpWKA MoU EPPavileTal va dWOETE TO
ovopa «Aiadpopn oniTl axoAgio — AeUTePOC TPOMOG»

Na npooBEoeTe £va anpeio evOIAPEPOVTOC OTO OXOAEIO 0AC Kal £va GTO ONiTI 0ac.
Na ovOPAoETE Kal va HOPPONOINCETE ONWE £0EIC VOUICeTE KaAUTEpa Ta dUo onpeia.

Na oxnuatioete Tn diadpopn and To oniTi oto oXoAeio. Na napaTnpnoeTe TOCO ThV
00IKr 000 Kal TV negn diadpoun.

Na npooBECETE €va TPITO ONUEIO EvOIAPEPOVTOC OTNV MIO KOVTIVA €vopia and To oniTl
0ag,

Na EVOWHATWOETE TO TPITO GNMEIO OTN dIAdPON NMoU EXETE PTIAEEL.

Na PETPNOETE TNV anooTacn, T6oo Ye Ta Nodia 600 Kal JE TO AUTOKivnTOo, and To oniTl
0ag 0To OXOA€io kal and To oniTI 0ag oTnV gvopia.

=+ Eninpoo0eTec ApaoTnpioTnTEC

19.

20.

XpnoidonolwvTag To epyaieio TnG dnuioupyiag ypaupng (draw line), va oxnuatiosTe
neEPIOXN £TOI MOU va MEPIKAEiEl pEoa €va onuavTiko PEPOG  (Uvnueio, aBANTIKO KEVTPO,
aflobeato k.An.) TnG neploxng omou Ceite. Na ovopdaceTe To noAUywvo nou 6a
OoXNHaTIOTEI e Ovopa dIKNG oag EMIAOYNC,.

A@OU POPPOMOINCETE ONWG £0€iG VOUICETE KAAUTEPA TO NOAUYWVO, va XPNGCILONOINCETE
TO €pyaAeio dnuioupyiag ypauung kair gEoa anod Tnv evroAn add driving route, va BpeiTte
Kal va oxedlidoeTe oTov Xaptn Tnv odikn diadpoun and To oniTi 0ag oTnv Mo navw
TonoBeaia.

ApaocTnpIOTNTEG yia TO ZniTI

21.

Na npooB&oeTe oTOV XAPTN €MmINA£ov onueia evdla@épovTog (and onuavTika Pepn Tng
nepioxnc onou Ceite) kal va TA EVOWHATWOETE Oc OIAdPOUEG, ME Tn PBonbela Tou
epyaAeiou add directions.

154




®dYANO EPrazIAz N.5.4.M3
Anpoupyia ka1 EneEgpyacia NMpoowmkou Xaptn Auo
AlaocTacswv

Ti 6a padoupe onpepa:

© Na €10ayouls onueia evOIaPEPOVTOC XAPTN HECW £PAPHOYNG UNOAOYIOTIKOU (PUAAOU
© Na koivornoloUue kai va diapoipaloupe (share) xaptn

© Na eEayoupe xaptn os KML.

ApaoTnpioTnTeCG EUnédmwong

1. Xpnolgonolwvtag Tov Npoownikd oac Aoyaplacuyd otnv  unnpecia Gmail, va
ONMIOUPYNOETE £vav XAapTn HE To Ovopa «EAAGDa».

2. Na dwoeTe TO M0 KATW OXOAIO WG MEPIYPAPr oTov XapTn: «Eioaywyn ZToixeiwv Ano
Microsoft Excel».

3. Na dwoETE 0TO NPWTO OTPWHA TOU XAPTN To Ovoua: «A&loBeaTta — Mvnueia ABrRvac».

4. Na o@Tmia&Te oTo Microsoft Excel Tov nio kATw nivaka kai va anodnkeUOETE TO APXEIO
oTNV ENIPAVEIa Epyaciac Tou UNoAoYIOTr oag Ke To Ovoua ABnva:

Ovopa

Axporoin

Zammslo MEyapo
NavabBnvaiko Itado
Mouageio Akpomolnc
Axadnpio ABnvwy

5. Xpnoigonoiwvtag To Microsoft Excel, va eicayayete péoa otov XApTn TA MO NAVW
Mvnueia — agloBeata Tng ABrivag, wg onueia evoiapEPOVTOC,

6. Na HopPONoINOETE ONWC E0€IG VOUICETE Ta MIO NAVW GNEia.

7. Na KoIvonoInoeTe Tov XapTn nou WOAIG PTIAEaTE oToug ouppaonTeg oac. Na kabopioeTe
€0€i¢ Nolol ouppabnTég oag anAwg 6a pnopoUv va douv Tov XapTn kai noiol 6a pnopouv
va Tov ene&epyaoTouv.

8. Na kavete e€aywyn Tou xapTtn o KML kal To apyeio va To anoBnkeUOETE OE HEPOG MOU
Ba oag unodeixBei and Tov kabnynTn oac.

ApaoTnpioTnTeg ASI0AOYNONG

9. Na si0aydyeTe Kaivoupio OTPWHA OTOV XAPTN KAl va TO OVOPAoeTe «AgloBEaTa — Mvnpeia
©eooalovikng (EupUTtepn Mepioxn)»

10. Na OnuioupynosTe oto npoypapupa Microsoft Excel Tov nio kaTtw nivaka Kkalr va

anobnkeUoETE TO APXEIO OTNV €NIPAVEId €pYaAciac TOU UMOAOYIOTH 0a¢ ME TO OVoUa
©eooalovikn:
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Ovopa

Meukag Mopyog

Aylog AnunTplog, Beooahovikng
Aylov Opog

Katappakteg ESsooag

Bepyiva

11. Inueiwvoupe oTnv doknon auTr Nwc dinAa and Tov Ayio AnuiTpio, av dev YPAWETE TN
AEEN Oeooalovikn, To Google maps Ba oac BaAel To onueio o€ aAAn nepiox.

12. Xpnoiponoiwvtag To Microsoft Excel, va eioayayete péoa oTov Xaptn TA Mo NAvw
pvnueia — a&loBéaTa Tng ABrivac, we onueia evolapEPOVTOC.

13. Na pop@onoInoeTe Onwc €0€ic VOUI(ETE Ta Mo NAvw oneia.

14. Na KoIvonoInoeTe Tov XapTn nou JOAIC PTIGEATE OTOUC GUPHABNTEC Oac.

15. Na kavete €Eaywyn Tou Xaptn o€ KML kal To apxeio va To anobnkeUOETE OE WEPOG NOU
0a oag unodelxBei anod Tov kabnynTr odc.

~+ Eninp6o0eTec ApaoTnpioTnTEG

16. Na eioayayste Kaivoupio OTPQOMA OTOV XAPTN KAl va TO OVOUAOETE E:r‘:f:‘
«Nnoia». ZTn Ouvéxela, Xpnoidonolwvtag To Microsoft Excel, va QTIGEETE |pésoc
TOV Mio KATw nivaka o onoiog nepiExel €€l vnald TnG EANAdag. Av BEAeTe, ﬁﬁp"UP“
MMOpPEITE va NPooBECETE Kal KA 0AG. XTn OUVEXEIQ, VA €I0AYAYETE PEOA E:‘Lg‘;‘;g
OTOV XAPTN TA vNOIA WG onueia evoiapEPOVTOC,. ZéxuvBog

ApacTnpIOTNTEG yia TO ZniTI
17. Na Bpeite emnAéov a&iobeata and Tnv EAAAda kai va Ta BAAETE pECA OTOV XAPTN WG

onuEia evolapEPOVTOC, XPNOIKOMNoIWVTAG To Npoypapua Microsoft Excel.
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®YAAO EPrazIAZ N.5.4.M4
Anpoupyia ka1 Ene€epyacia Npoowmkou Xaptn Avo
AlaocTacswv

Ti 6a padoupe onpepa:

COOH H©OOOH

Na dnuioupyoUpuEe €vav Npoowmniko XapTn

Na ovopaloupe kai va nNepypapoule Evav npoowniko XapTn

Na eilodyoups, va diaypdgoupe kai va eneEepyalopaoTe oTpwpata (layers)

Na npooBéToupe Kal va eneepyalduacTe onpeia evolapEPOVTOG

Na dnuioupyoUue kal va ensEepyaldpaoTe diadpopés peoa atov XapTn (nedonopiag, auToKIvhTou,
nodnAdrou)

Na unoAoyiloule Tnv anooTaon

Na l0ayoups anueia evOIaPEPOVTOC XAPTN UECW £PAPHOYNG UNOAOYIOTIKOU (PUAAOU

Na koivonoloUpe kai va diapoipaloupe (share) xaptn

Na €&ayoupe xapTtn o KML.

ApaoTnpioTnTeg EUnédwong

10.

11.

XpnoigonolwvTag Tov Npoownikd oag Aoyapiacuyd otnv unnpecia Gmail, va @TiaEeTe
€vav XapTn Ke To ovopa «Opooeipec TNG Kunpous.

Na dwoeTe TO N0 KATW OGXOAIO WG Neplypapn oTov Xaptn: «AuTo TO QUANO €pyaciag
givar pia enavaAnyn Twv 00wV €XOUME WABel péxpl Twpa yUpw anod TNV €papuoyn
xapToypdpnong Google maps».

Na dwoeTe Ovopa oTo npwTo oTpwHa (Layer): «Tpo6odog - MevTadakTuloc»

Na npooBeoeTe éva onueio evOIAPEPOVTOC OTNV OPOCEIPA TOU TPoOdOUC OTO GNHEIO
'OAUMNOG Kal va TO OVOPACoETE TPOOJOC.

Na aM\G&eTe To €IKOVIOIO TOU ONMEIOU EvOIAPEPOVTOC HE EIKOVIOIO JIKAG 0ag €MAOYNG.
MnopeiTe va XpnoIPonoINoETE kanolo anod Ta diabéaiua sikovidia.

XpnoigonolwvTag pnxav avalitnong, va PBpeite nAnpo@opieg yia TNV 0poseipd Tou
Tpoddoug kal va NpooBETeTe dUO — TPEIC YPAUMES WG NEPIYPAPT OTO ONuEio.

XpnoigonolwvTag To pyaleio TnG dnuioupyiag ypapung (draw line), va oxnuaTtioste TNV
nepIOXN €TOI MOU va MNEPIKAEiEl JEoa TNV opooelpa Tou MevradakTUAou. Na dWOETE TO
ovopa MevradakTuhog aTo MOAUYWVO NMou oxnHaTiceTal.

Na Jop@onoInoeTe To NOAUYWVO NOU GXNHATIOTNKE WG AKOAOUBWC:
Na aA\GEeTe To xpwpa Tou, HE XpwHa OIKAC 0ac EMAOYNC.

Na Bpeite ano pnxavn avaliiTnong XapakTnpioTIKn €lkova yia Tov MevtadakTulo kal va
TNV NPoCBECETE 0TO NOAUYOVO.

XpnoigonolwvTag pnxav avalditnong, va PBpeite NANpo@opiec yia TNV opooeipd Tou
MevtadakTUAoU kal va npooBeaeTe dUO — TPEIG YPAMMES WG NEPIYPAPH).
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12.

13.

14.

15.

XpnoiponolwvTag To epyaAsio dnuioupyiac ypaupng kal éoa anod Tnv evroAr add driving
route, va Bpeite kal va oxedIAoeTe oTov XAPTN 0JIKN dladpopn and To Tpoodoc oTov
MevTadakTuho.

Me Tn BonBeia Tou gpyal€iou PETPNONG TNG ANOOTAONG, VA WETPROETE TNV andoTaon
anoé 1o Tpoodoc¢ otov MMevradakTulo, Bacel Tng O01adpounG nMou oxnuaTioaTe oTnv
gepwTtnon 9.

Na KoIVOMOINCETE ToV XApTN Nou POAIC PTIGEATE 0TOUC oUPKAONTEG oac. Na kabopioeTe
€0€iC Nolol oUPPAdNTEC oac anAwe Ba punopouv va douv Tov XApTn Kai noiol 6a punopouv
va Tov ene€epyacTouv.

Na kavete eEaywyn Tou XapTtn o€ KML kal To apxeEio va To anobnkeUOETE O€ PHEPOC MoU
Ba oag unodelyxBei and Tov kabnynTn odg.

ApaoTnpioTnTeG AEIoAGYNONG

16.

17.

Na opioeTe €va onueio evdlapEépovTog oTnVv opooelpd Tou MevradakTulou. Na ovopdoTe
Kal va HopgOonoINCTE ONWG E0€iG VOUIETE KAAUTEPA TO ONUEIO.

Me Tn Bonbeia Tou epyaleiou add directions, va oxnuatioete Tn dladpoury anod To
Tpoodog oTo onpeio.

4+ Eninpoo0eTec ApaoTnpioTnTEC

18.

Na esioayayete kaivoUpio OTpWHA OTOV XAPTN KAl va TO OVOMACOETE «XwpIa». TN
OUVEXEIQ, va PBpeiTe Xwpid and TiG OU0 0POTEIPEC Kal XpnalhonolwvTag To Microsoft Excel
va Ta €l0ayayeTe oTov XapTn.

ApaoTnpIOTNTEG YIA TO ZNiTI

19.

Na Bpeite onuavTika pvnueia — aflobeata anod TIG dUO OPOCEIPEG Kal, XPNOILONoInVTAG
TO NpOypaypa Microsoft Excel, va BAAeTe Ta onueia Toug aTov XapTn.
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®YANO EPrAzIAZ .5.4.M5
Alaxeipion YpioTapevav Xaptav AUo AlaoTACEWV

Ti 6a padoupe onpepa:

& ©H66 6

Na nepinyoUuaoTe o€ £vav uploTauevo XapTn dUo diaoTaoswv

Na aAhaloupe Tov TPOMNO NPOBOANG ToU XApTN

Na xpnoidonoloUpE UPIOTAWPEVEG eIkOVEC (imagery) nou cival d1aB€0IUEG o€ Evav XapTn

Na napatnpoUpe alayec oe TonoBeoiec, yvnueia K.An. YEoa anod (pwTOYPAPIEG MPONYOUHEVWV
ETQV.

Na eAeéyxoupe TNV KukAogopia.

ApaoTnpioTnTeG EUnédmwong

XpnoigonolwvTag unxavn avalntnong, va Bpeite Tov XapTtn TnG EAAGdAC €101 ONwe auTog
NPoCoPEPETAl HEaa anod To Google.

Na Bpeite nAnpo@opieg yia To Nw¢ MNopeiTe va WetaBeite and Tnv ABnva oTn
©eooalovikn.  ZUYKeEKpIMEVA, va PBpeiTe Ta OlaB0Iya PEoA WETAPOPAC Kal TOV Mo
oUVTOMO XPOVO Mou XpeladeTal yia KaBe JECO Kal va CUMNANPWOETE TOV MIO KATW nivaka:

Méogo MeTagopag Aiapkeia Ta&idiou

AuTokivnTo

Tpévo — Aswopeio

Medog

AeponAavo

Na petaBeite TO00 otnv ABriva 6co kai otn Oegooalovikn kal va kataypayete dUo
OpOHOUC — AewPOPOUC yia KABE NOAN, NOU QuTn TN OTIYUN £XOUV TNV MNIO XaUNAR Kai nio
uWnAn Kuk\ogopia.

ABnva

YynAn KukAogopiakn Kivhon XapnAn KukAogopiakn Kivnon
a) a)
B) B)
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4.

Otooalovikn

YwnAn KukAogopiakn Kivnon XapnAn KukAogopiakn Kivaon

1) 1)

2) 2)

Na petaBeite otn BouAn Twv EAAAvwv (koivoBoUAio — ZUvtaypa) oTtnv ABrva Kai,
XpNOIKONoIwVTAG TNV npoBoAn Tou Opopou (street), va PBpeite and TIC OIABECIYES
PWTOYPAPIEG TN XpovoAoyia TNG NAAAIOTEPNG kal TNG Nio NpoOapATNG.

(a) Xpovohoyia MaAaidTepnc dwToypagiac:

(B) XpovoAoyia nio Mpdopatnc dwToypapiac:

Na petaBeite oTov Acuko MUpyo oTn ©eocalovikn Kai, XPNOIHONoInvVTac TNV npoBoAn
Tou Opopou (street), va Bpeite and TIC JIABECINEC PwTOYpPAPIEG TN XPOvoAoyia Tng
naAaidTepng Kai TNG Mo NpooPaTnc,.

(a) XpovoAoyia MaAaioTepnc dwToypagpiac:

(B) XpovoAoyia nio Mpdéopatng PwToypagiac:

ApaoTnpioTnTeG AEIOAGYNONG

Na BpeiTe NANPOPOPIEG yIa TO NWG WNOpPEITE va PeTaBeite and Tnv ABriva otnv Marpa.
JUYKEKPIPEVA, va Bpeite Ta 01aBE0INa PEoa PETAPOPAC Kal ToV N0 GUVTOHO XPOVO Mou
xpelaleTal yia kabe PECO Kal va GUKNANPWOETE TOV Mo KATW nivaka:

Méoo MeTagopag

Aiapkeia Ta&idiou

AuTokivnTo

Tpévo — AewPopeio

Medog

7. Na petaBeite oTnv €kkAnoia Tou AnooToAou Avdpea Kkal, XpNoIKONOoIWVTAC TNV NPOBOAN
Tou Opdpou (street), va Bpeite and TIC dIABEOCINEC PWTOYPAPIEC TN XPOvoAoyia Tng

naAaidTePNG Kai TnG mio NpdopaTng.

(a) XpovoAoyia MaiaioTepnc PwToypagpiac:
(B) XpovoAoyia nio Mpdopatng PwToypaiac:
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4+ EninpooBerec ApaoTnpidTnTEG

8. Na BpeiTe Kal va KATaypayeTe TOV Mo OUVTOHO XPOVO Mou Ba XpelaoTel kKANolog yia va
MeTaBei and Tnv ABnva otov MMelpaid, XpnoidonoiwvTac HEoa ouykoivwviac.  Na
KaTaypaweTe, €NioNG, Tov PEYAAUTEPO XPOVO YIia auTr) TnVv diadpopr).

(a) Xpdvog MpnyopoTepnc Aladpopunc:
(B) Xpdvog Mio Apync Aladpopnc:

9. Na BpeiTe Kal va KATaypayeTe TOV Mo OUVTOHO XPOVO Mou Ba XpelaoTel kKANoIog yia va
heTaBei ano Tov Meipaid otnv AKPOMNOAN, XPNOIMOMNOIWVTAC HEGA CUYKOIVWVIAc. ‘'Onwg Kai
oTNV nponyoupevn Aoknon, va KaTaypaweTe kal Tov PEYaAUTEPO XPOVO yia auTn Tnv
dladpopn.

(a) Xpdvoc MpnyopoTePNC AladPOuNG:
(B) Xpovog Mo Apyng Aladpoung:
ApacTnpIOTNTEG yia TO ZNiTI

10. Na Bpeite NANPOPOPIEC YIa TO NWC PNOpPeiTeE va PetaBeite and Tnv ABriva otn Adpioa.
JUYKEKPIYEVA, va BpeiTe Ta dIaBEoipa Yeoa PETAPOPAG Kal ToV Mo GUVTOHO XPOVO Mou
XPEIQlETal YIa KABE PECO KAl va GUUNANPWOETE TOV MO KATW Nivaka:

Méoo MeTagopag Aiapkeia Ta§idiou
AuTokivnTo

Tpevo — Aewpopeio

Medog

11.

Na Bpeite NANPOPOPIEC yIa TO NWE KNopeiTe va WeTaBeite ano Tnv ABrva ota Iwavviva.
JUYKEKPIYEVA, va BpeiTe Ta diaBEéaipa Peoa PETAPOPAG Kal ToV Mo GUVTOHO XPOVO Mou
xpeladeTal yia kabe PECO Kal va CUKNANPWOETE TOV MNIO KATW Nivaka:

Méoo MeTagopag Aiapkeia Ta&idiou

AuTokivnTo

Tpevo — Aewpopeio

Medog
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®YAAO EPrAzIAZ IN.5.4.M6-M7
Anpioupyia ka1 Eng€epyacia Npoowmekov XaprTn Auo
AwaoTracswv - Epyacia

Ti 6a padoupe onpepa:
% Na xpnoidonoinooupe OAa 000 EXOUE PABEI OXETIKA PE TN ONUIoUpYia Kal eNe€epyacia NpoownikoU
XapTn OUo 5Ia0TACEWY.

ApaoTnpioTnTeG Eunédmwong/A&ioAoynong

EPrAZIA - ZENAPIO

Xepoovnoog Kapnaociag

370 Padnua Tng IoTopiac Tng Kunpou, o kaBnynTng Tng IoTopiac {ATnoe and Toug HadnTeg
va @TIaEouv Wia epyacia yia Ta xwpia kal Ta pEpn Tng Kunpou, nou BpiokovTal onuepa uno
katoxn. O kabnynTng TOVIoE Nwg gival eAeUBepol va PTIAEoUV OTIOANOTE, (PTAVEI VA WMOPEI
va NPOoeAKUCEl E €va NPWTOTUNO TPONO TO €vOIAPEPOV TWV GUMMABNTWV TOug Kal Ol
HOVOV.

O MNavayiwtng ano@dcice va aoxoAnBei pe Tn xepoovnoo TnG Kapnaoiac kar va
XPNOIKONoINael To google maps, yia va oAoKANpwael TNV €pyacia Tou. H enidoyrn Tou autn
EXEl OKOMO VA MPOOQPEPEI OTOUC OUPHABNTEC Tou £vav 01adpacTikO Kal OUVAUA EAKUGTIKO
TPOMNO £KKUABNONG GNUAVTIKWY NANPOPOPIWV YIA TN CUYKEKPIPEVN NEPIOXN.

'ETO1, a@ou PEAETNOE yIa Tn OUYKEKPIKEVN MEPIOXN Kal BPRKE TIG anapaitnTeg NAnPoQopieg
nou xpelaloTav, anopacice Td N0 KATwW:

1.  Xpnoipgonoiwvtac Tov NPoownikd Tou Aoyapiacpo atnv unnpeoia gmail, va ¢miager évav
XapTn Ke To Ovoua Karpasia.

2. Na npooBoel wg onueia evdlagéPovTog Ta 6 nio KATw Xwplid:
1. Pifokapnaco
2. Tahouoa
3. Baagihi
4. Aeovapiooo
5. Ayiog AvOpOVIKOG
6

Kwpa Tou MNaAou
3. Na aA\a&el Tnv €Ikova TwV onueiwv evOIaPEPOVTOG HE EIKOVA JIKAG TOU EMIAOYNG.

4. Na popgonoinoel Ta onueia evdlaPEPOVTOC, WOTE KABE onueio va €xel To OIKO Tou
XpwHa.

5. Na xpnoigonoinosl gnxavrn avalntnong, yia va Bpel NANpo@opiec yia kabe éva ano Ta &
XWpIa kal va npoobeoel dUO — TPEIG YPAUUEG OE KABE onuEio.
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6.

10.

11.

12.

13.

Na xpnoiponoinael unxavn avalntnong, yia va Bpel eikdva yia kabe éva ano Ta €& xwpia
Kal va Tnv npooBeoel o kKABs anpeio.

Na Bpel To povacTipl Tou AnooToAou AvOpEa Kai, XPnOILOMOIWVTAG TO EPYAAEI0 TNG
ypaupng (line), va TonoBeTroel TNV NEPIOX TOU POVAOTNPIOU Péoa o noAUywvo. Na
dwoel oTo NoAUYywvo Ovopa OIKNG Tou €MIAOYNG, va NPoCoBEoEl Yia avTinpooWNEUTIKNA
€1KOVA Kal va To JoPPOroInoel Onwe autog Bewpei KaAUTEpA.

>e kaivoUupio aTpwua (layer) va epgavioel Tnv odikr diadpopun anod Tnv Kwua Tou MNalou
HEXPI TO povaoTnpl Tou AnooToAhou Avdpea. Na kataypayel Tn XINOPETPIKN anooTaor).

Na PJeTPAOEl Kal va kaTaypdwel TIG Mo KATw anooTdcel (o€ ubeia ypapun):
1. Kwpa Tou MNalou — MovaoTrpl Anootoou Avdpea
2. Pilokapnaoco — MovaoTrpl AnooTohou Avopea
3. Kwpa Tou TMahoU — Aeovapiooo — Ayiog Avdpovikog — Tlalouca —
Pilokapnaco.

Me Tn Xprion Tou npoypdupatog Microsoft Excel, va npoofeoel Ta onpeia Twv EKKANCIOV
TV MI0 NAVEW XWPIWV, CULPWVA KE ToV Mo KATW Nivaka:

Ovopa Neploxn

Ayia Tplada Puwokapmnaco, Kumpog
Apxayyehoc MixanA | Nalovoa, Kompog

AyLo¢ AnNUATPLOG Neovaplooo, KOTpog

Ayla Qwtewn Aylog Avépovikog, Kimpog

>nueiwon: To Agovapiooo yia va evrTonioTei anod To google, Ba npeEnel va ypapTei wg
Aewvapioo.

Na popgponoincel Ta kaivouplia onueia mMou €xouv npooTedei ONWG auTOG Bewpei
KaAUTepa.

Na yivel e€aywyn Tou xaptn o€ KML.

Na KolvoroInael Tov XapTn OTOUG CUMKABNTEG Tou, yia va PNOPECOUV Kal auToi va douv
TNV €pyaaia Tou.

'ExovTag unown 6Aa Ta nio navw onyeia Ta onoia 6a akoAoubnaoel o MavayiwTng, va PTIAEETE
Kal £0€IiC PE TN O£IPA 0AC TOV AVTIOTOIXO XApTn O0To google maps, nou va nepiAaupavel oAa
Ta nio Navw.
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®YANO EPraziAz I.5.4.M8
Anpoupyia kai Ene€gpyacia TpigdiaoTratou NMpoownikou
Xaptn

Ti 6a padoupe onpepa:

@ Na eEolkeiwBoUPE Pe To NEPIBAAOV TNG EPAPHOYAC

© Na avalnToupe kai va nAonyoUPacTe Jeoa oTo NEPIBANOV TNG EPAPHOYNC
% Na dnuIoUpyoUlE PAkeAo

© Na npooBETOUPE Kal va ene€epyalOPACTE ONPEIa EVOIAPEPOVTOC

% Na Bivreookonouye To Ta&idl kai va To eEayoupe wg KML n KMZ.

ApaoTnpioTnTeg EUnédmong

1. Na evepyonoinoete Tnv epapuoyn Google Earth. Z1o onuepivd @UAO epyaciag Ba
QTIAEETE €va Ta&idl nepinynong o diagopa vnaid Tng EAAGdac,.

2. Na dnuioupynosTe pakeAo We To dvopa «Nnoia Tng EANadac»

3. Na npooBeoeTe onyeia evdlagEPOVTOC aTa Mo KATw vnoia:
1. Kpnmn

POd0OG

Képkupa

Mapog

2KIG00¢

I

Zakuveoc

nueiwon: a) MNa ovopa o€ kGBe onpeio evOIAPEPOVTOC, va DWOETE TO OVOUA TOU KABE
vnoiou kai B) av Ta onueia evolapepovTog dev loaxbolv auTOPATA PEGA OTOV (PAKEAO
nou PTIAEATE, va Ta YETAKIVIOETE JEGA OTOV (PAKEAO.

4. Na aMda&ete TO €1kovidIo TwV ONUEinV EvOIaPEPOVTOC HE EIKOVIDIO BIKNG 0ag ENIAOYNC.
MnopeiTe va xpnolJonoInosTe kanolo and Ta diabéaiya eikovidia.

5. Na xpnoigonoinoeTe dIaPopPETIKO XpWHA Yia KABs anueio evoiapEPOVTOC,.

6. Xpnolgonoliwvrag Mnxavn avalitnong, va Bpeite NANPoPopies yia kabe éva and Ta £E
vNoia Kai va npooBeoeTe U0 — TPEIC YPAUKES WC NEPIYPAPT) OE KABE GNUEIO.

7. XpnolponolwvTag pnxavn avadntnong, va PpeiTe Wia XapakTnpioTiKn €lkova yia kabe
VNai Kal, XpnoIPonolmvTag TNV NAEKTpoVIKn Tng dielBuvon (Oe&i KAk oTnv ikdva nou Ba
Bpeite kal, akoAoUBwG, va enmIAéEETE To copy image location), va Tnv npooBioeTe o€
KGBe anpeio.

8. Na Ta&idéweTe pECa oTa vNoid, XpnoIKoNoIwvTac To €ikovidio Play Tour.

9. Na anobnkeuoete TO TAidI o€ pop®n .kml i .kmz, pe To dvopa «Ta&idl oTa EAAnvika
NNnaoi1a».
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ApaoTnpioTnTeg ASI0A0YNONG

10. Na npooBeoete dUO onueia evOlAPEPOVTOC, €va yid TO vnai TG ZAPou Kal €va yia To
vnai TN Xiou.

11. Na dwOoeTe TO OVOua TOU KABE vnoloU oTa Gnueia evOIaPEPOVTOC,.

12. Na aAAGEETE TO Xpwa Kal TO €IKOVIOIO TWV GNHEIWV.

13. XpnaoigonolmvTag pnxavn avalntnong, va Bpeite nAnpo@opiec yia Ta dUo onpeia kai va
NPooBEoETE dUO — TPEIG YPAUHEG OE KABE onpEio.

14. Na Ta&idéweTe péoa o€ OAa NAEovV Ta vnaold, XpnolonoliwvTag To ikovidio Play Tour.

15. Na anoBnkeUoeTe To véo auTo Ta&idl o popepn .kml n .kmz, ye 1o ovopa «Ta&idl oTa
EANVika Nnoia 2».

=+ Eninp6o0eTec ApaoTnpioTNTEG

16. Na npooBeoeTe anueio evdlagepovToc oTo vnoi TnG EUBolag. Apou dwaoeTe Gvopa OTo
ONMEIO, VA TO POPPONOINCETE ONWC £0€iC VopileTe kaAUTepa. Na npooBéoeTe dUO e
TPEIG YPAMMEG MEPIYPAPN Kal Mia XapakTnpioTIKn €kova. Na npaypaTtonoinoeTe TO
TeheuTaio oag Tagidl yia onuepa, OTO OMoio va CGupnePIAauPBaveTal kalr To vnai Tng
EuBoiac. Na anoBnkeloete To véo auto Ta&idl o popepn .kml n .kmz, pe 10 Ovopa
«Ta&idl ota EAnvika Nnoia 3».

ApacTnpIOTNTEG Yia TO ZNiTI
17. Me Tn BonBeia pnxavng avadntnong, va Bpeite 5 vnoid nou avnkouv oTiG KUKAAdEG kal

va TONOOETACETE O AUTA Onpeia evdlapepovToc. Ta NEVTE AuTd vnoild va Ta PAAETE
MEoa oOe &vav KaivoUplo (PAkeAo HE TO Ovopa «KUKAGDeG». ZTn OUVEXeEld, va Td
OVOMAOCETE Kal va TA HOPQOMOINOETE ONWG €0€iC VOMICeTe KAAUTEpA. Ze kaBe oneio,
eniong, va npooBeoeTe U0 HE TPEIG YPAUMES NEPIYPAPN KAl Hia XapakTnpIOTIKNA €IKOVA.
2T0 TENOG, va npaypaTtonoinoeTe Ta&idl Jeoa oTa vnold Kal va anodnkeUoeTe To Ta&iol
oag o€ popon .kml 1 .kmz pe To 6vopa «Ta&idl oTig KUKAGdEC.

165




®YAANO EPrAzIAz .5.4.M9
Anpoupyia ka1 Ene€gpyacia Tpigdiaoratou NMpoownikou
Xaptn

Ti 6a padoupe onpepa:

GO0 OOd

Na avalnToUue Kkal va nAonyoUHaoTe YEoa OoTO NEPIBAANOV TNG EPAPHOYNG
Na dnuioupyoUpe PAKENO

Na npooBéToupe kal va eneepyaldpaoTe onueia evoiapEPOVTOG

Na anoBnkeloupe oTIYHIOTUNO €IKOVAC JECA anod Tov XApTn

Na unoAoyioupe Tnv anooTacn

Na BivreookonoUpe To Ta&idl kail va To eEayoupe wg KML 1} KMZ.

ApaoTnpioTnTeg EUnédmong

10.

Na evepyonoinoete Tnv epappoyn Google Earth. 10 onuepivd @UAO epyaciac Oa
QTIAEETE €va Ta&idl nepinynong ota peyaila epdayuarta Tng Kunpou.

Na dnuIoupynoeTe PAKENO HE TO OVopa «dpayupata TnG Kunpou»

Na npooBeoeTe onueio evola@EPOVTOG OTO PPAyda Tou KoUppn. MAnKTpoAoywvTag
oTnVv neploxn TnG avalntnong, epayua KoUppn, n epapuoyn 6a oag HPETAQEPEl GTO
Ppaypa.

A@OU TO OVOWNACETE, VA HOPPOMOINCETE TO EIKOVIOIO TOU ONUEIOU ONWG €0€IC VOUICETE
KaAUTepa.

Na XpnoIKONOINOETE TNV KAPTEAA view anod TIC IO1I0TNTEC TOU ONUEIOU Kal va KaBopioeTe
&va oTIyHIOTUNO €Ikdvag (Snapshot current view) yia To anpeio.

Na Bpeite Tnv 0dikn diadpopn (Get Directions) and To @payua Tou Kouppn HéEXP! kal TNV
noAn Tng Aepeood.

Na anoBnkeuoeTe TNV €ikOva nou va Oeixvel Tn 0iadpopn and Tov Kouppn MEXPI TN
Nepeao, e To dvopa «Aladpopn Kouppng - Aepecdc»

Na unoAoyiceTe Tnv anootaon (o€ €uBeia ypauun) and 1o gppaypa Jexpl TN AePecd o€
METPA, XINIOPETPA Kal piNia.

MeTpa:

XINIOpETPA:

Mikia:

Twpa, Ba nNpooBEoeTe onueio evdlaPEéPOVTOC yia To @pdyua Tou AonpOKpeUHou. To
(ppayua Tou AcnpOKpPEPHOU gival To deUTEPO NIo pEyaio oTnv Kunpo.

'Onw¢ kKavaTe Kal oTo onueio yia To ¢ppayua Tou KoUppn, £T01 KAl TwPA Yid TO ONUEio
TOU AOCNPOKPEUHOU va TO OVOUACETE KAl va TO HOPQPOMOINCETE ONWC €0EIC VOMICETE
KaAUTepa.
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11. Na xpnoidonoInosTe TNV KapTéAa view anod TIG 1I010TNTEC TOU ONUEIOU Kal va kabopioeTe
€va oTIyHIoTUno €lkdvag (Snapshot current view) kai yia auto To onyeio.

12. Na Bpeite Tn diadpouny and 1o GpAypa Tou ACMPOKPEUHMOU HEXP!I Kal TNV nOAn Tng
rnagou.

13. Na anobnkeloeTe TNV €Ikova nou va deixvel Tn 01adpopr anod Tov ACTIPOKPEUHO HEXPI
TNV MNago, pe To 6voua «Aiadpopur) AonpOKpeUHOC - MApoc».

14. Na unoAoyioeTe Tnv andoTaon (o€ €uBeia ypauun) and To epayua Tou AonpOKpEUHOU
MEXP! TO ppayua Tou Kouppn o€ PETPA, XINOPETPA Kal HiAia.

MéeTpa:

XINIOPETPQ:

MiNia:

ApaoTnpioTnTeG ASI0AOYNONG

15. Twpa 6a nNpooBeceTe anuEio vOIAPEPOVTOC yia To @payua Tng Eupetou. To gpdyua
NG EupETou eival To TpiTo nio peyalo otnv KUnpo kai yia va To VTONioEl N Hnxavn
avalTnong TnG epappoyne, 6a npenel va NANKTPOAOYNOETE «Ppayua Eupetou, Nagoc»

16. 'Onwg kAvaTe Kal oTa NPonyouleva onpeia, €101 KAl TWPA, va TO OVOUACETE Kal va TO
HOPPOMOINOETE ONWC €0€IG VOMICETE KAAUTEPA.

17. Na xpnOoIKOnoINosTeE TNV KApTEAA view anod TIG 1I010TNTEC TOU ONUEIOU Kal va KaBopioeTe
€va oTIyHIoTUNo €lkdvag (Snapshot current view) kal yia auto To onyeio.

18. Na unoAoyiosTe TIG anooTdaoeig (o€ ubeia ypauun) o€ XINIOPETPA yia Td Mo KATW:

®paypa Eupetou - Gpaypa Kolppn

®payua Eupetou - Opdyua AcnpokpeUoU

®payua EupeTou —Magog

19. XpnoiponoiwvTag To gikovidio Play Tour va nepinynBeiTe oTa Tpia nio navw epAayuaTa.

20. Na anofnkeloste Tnv nepinynon o pop@n .kml n .kmz, pe 10 Ovopa «Ta Tpia
MeyaAUTepa Opayuara».

4+ Eninpoo®eTec ApaoTnpioTnTEG

21. Na npooBéoeTe 2 onueia evdiapepovToc yia Ta dUO PeyaAa @paypaTta Tng enapxiac
Adpvakac: a) ¢payda Twv AEUKApwv kal ¢ppayda Tou AinoTtagou. To @payda Twv
A€UKApPWV yia va TO &vToniosl n pnxav avalntnong Tng €papuoyng, 8a npenel va
nAnkTpoAoynoete «dpayua Aelkapa, Adpvaka» kal To ¢paypa Tou AinoTapou Ba npenel
va nAnkTpoAoynoeTe «®payua Ainotapou, Adpvaka»
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22. 'Onw¢ kavaTe kal oTa nponyouldeva onueia, €Tol Kal TWPA, va Td OVOUACETE Kal va Td
MOPPOMOINCETE ONWE ECEIC VOUIZETE KAAUTEPQ.

23. Na xpnolgonoinosTe TNV KapTéAa view anod TIC 1IDIOTNTEG TOU OnUEIOU Kal va KaBopioeTe
ano éva oTIyMIOTUNO €Ikovag (Snapshot current view) kai yia autd Ta onyeia.

24. Na unoloyioeTe TIC anooTAoelC (o€ euBeia ypauun) o XINOPETPA YIA TA MIO KATW:

dpaypa Asukapwv - ®payua AinoTapou

dpaypa Aeukapwv - Aapvaka

dpaypa Ainoétapou — Aapvaka

ApaoTnpIOTNTEG yia TO ZniTI

25. Me 1n BonBeia pnxaving avalitnong, va BpeiTe Ta ovopaTa akoun 3 YeyaAwv gpayuaTwy
NG KUnpou kal va TonoBeTnoeTe 0€ auTd onyeia evOIaPEPOVTOG. TN OUVEXEID, va Ta
OVOMAOETE Kal va Ta JOPPONOINOETE ONWG £0€iC VOUIleTe kaAUTEpa. Na XpnoILONoINoETE
Ta onueia, yia va Bpeite a) TI¢ anooTdoelg kal B) TIC dIadPOKES YIa TIG MIO KOVTIVEG O€
auTa NOAeIC.
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®YAAO EPraziAz IN.5.4.M10
Anpoupyia ka1 Ene€epyacia TpiogdiaoTatou Npocwnikou
Xaptn

Ti 6a padoupe onpepa:

©OOOHOHOoee

Na avalnTouUue kal va NnAonyoUHaoTe PETa OTo NEPIBANOV TNG EPAPHOYNG

Na dnuioupyoUpe PpAkeAo

Na npooBéToupe kal va eneepyaldpaoTe onueia evoiapEPOVTOG

Na dnpioupyoUue povonat (path)

Na emAEyoupe CUYKEKPIMEVN TonoBeaia Pe Tn Xprion noAUywvou (polygon)

Na unoAoyiloude Tnv anooTaon

Na BivreookonoUue To Taidl kai To eEayoupe we KML ) KMZ.

Na anooTtéAAoupe eikdva, apxeio KMZ fj KML, YEow nAekTpovikoU TaxudpopEiou
Na xpnoigonoloUpE Tov EEOUOIWTA NTHONG.

ApaoTnpioTnTeG EPnédmwong

Na evepyonoinoete Tnv €papuoyn Google Earth. 310 onuepivd QUAO epyaociag Ba
PTIAEETE, YEoa anod TNV EQappoyr, To JovonaTi and To oniTl 0ag PEXP! KANOIO GNUAvTIKO
KTAPIO TNG NEPIOXNC 0ac, n.X. oTAdIo, ONUAPXEIO, VOOOKOMEIO K.AM.

Na BpeiTe To ONiTI 0a¢ JEoA OTOV XAPTN KAl XPNOIKOMNOIOVTAC TO EPYAAgio TNG EMIAOYNG
TonoBeaiag Ye TN Xprion NoAUYwvou, va OXNHATIOETE TNV NEPIOXN ETOI MOU VA MEPIKAEIE!
MEoa To oniTi 0ac. Na ovopdaoeTe To NOAUYWVO nou Ba oxXnNUATIOTEN «TOo GNiTI HOU.

Na Jop@onoInoeTe To NOAUYWVO NOU OXNHATIOTNKE ONWG E0€IC VOUIZETE KAAUTEPQ.

Na enavalaBete TIC €pWTNAOEIC 2 KAl 3 KAl yid TO KTAPIO TNG MEPIOXNG MOU 0dag
evolapépel. Q¢ Ovopa oTo NoAUYwvo, va OWOETE TO OVOUA TOU KTNPIioU MOU EXETE
EMAEEEL

XpnoiponolwvTag To epyaleio yia Tn dnuioupyia povonaTiot va @TIAEETE To HovondTi
anodé To ONiTI 0ag MEXP! TO KTNPIO MouU €XETE BAAEl oTo noAUywvo. ®dpovTioTe a) va
BAAeTE apkeTa onueia yia To povondTi kal B) Ta onueia va BpiokovTal kKaTta WUNAKOG TOu
Opopou. O Aoyoc sival nw¢ n epappoyn 6a akoAoudnoel Ta onueia auTd, yia va oag
odnynoel and To oniTlI 0ag oTo KTAPIO. Av undpxouv onueia ekTog OpPOKHoU, ONWG NAvw
ano xwpd®i N navw anod kanoia aAAa KTnpia, To YovondaTl Ba nepdcel Yéoa anod autd
MEXPI Va PTACEI GTOV NPOOPICHO TOU Kal TO anoTeAeopa Oev Ba gival TO avapevOpEVO.

Mop@OnoINOTE TN YPAUKA TOU HovonaTiou, aAAalovTag To Xpwia kal To NAATog TnG.
KataypayTe Tnv andéoTacn and To oniTi 0ac 0To KTHPIO O PETPA, XINOUETPA Kal WiAia.
MéeTpa:

XINIOpETPA:

MiNia:

Na nepinynBeiTe Yyéoa oTo povondaTi oac, XpnolKonolwvTag To epyaleio Play Tour.

169




r.5.4.M10 I'5 AikTua YnoAoyioTov kai AiadikTuo

9. Na anobnkeuoeTe TNV NepInynon o€ pop®n .kml f .kmz, pye To ovopa «Aladpopn anod To
OniTl Jou OTOo ...». AvTi TpeIG TeAeieq, va PBAAETE TO OVOMA TOU KTNPIOU MOU €OEIG
eMAEEaTe.

10. Na oTeileTe PEOW NAEKTPOVIKOU Taxudpopeiou o€ dUO CUUHABNTEC 0ag TNV €IKOVA PE TO
MOVONATI NOU EXETE ONMIOUPYNOEL.

11. Na oTei\eTe PEOW NAEKTPOVIKOU TAXUDPOHEIOU O AA\OUC OUO CUPMABNTEC oac Tnv
€IKOVA PE TO POVONATI MOU EXETE ONUIOUPYNOEl, AAAG auTrh TN Qopd va Tnv anooTeIAeETE
o€ pop®r apxeiou KML.

12. Xpnoiponoiwvtag Tov €E0POIWTA NTAONG, Va NETAEETE NAvw and To ONiTI 0ac Kal oThv
eupUTEPN NEPIOXN YUPW anod To oniTl odc,.

ApaoTnpioTnTeG AEIOAGYNONG

13. Na Bpeite €va OeUTEPO KTNPIO NOU BPIOKETAI KOVTA OTO OMNITI 04 KAl va KAVETE TA NIO
KATW:

(a) Me Tn Xprion NoAUYwVOU va oXNUATIOETE TNV NEPIOXN, £TOI MOU va NEPIKAEIEl PEOA
TO OEUTEPO AUTO KTNPIO.

(B) Na dwoeTe Ovoua Kal va PHoppomnoINoETE TO MOAUYWVO MOU OXNHATIOTNKE ONwG €0€IC
VOMiCeTe KaAUTEpPQ.

(y) Xpnowponoiwvtag To €pyaieio yia Tn Onuioupyia povonaTtiou, va QTIAEETE TO
HOVOMATI and To OMiTI 0ag HEXP! TO KTNPIO.

(8) Na Pop@onoINCETE TN YPAKKN Tou povonaTiou, aAAalovTag To Xpwua kai To NAATog
™G

(¢) Na kataypdweTte TNV anodoTacn and To ONiTI 0aG OTO KTNPIO O WETPA, XINIOUETPA
Kal piAia.
MeTpa:
XINIOpETpQ:
Mikia:

14. 'Onw¢ KAvATE KAl MPONYOUHEVWC, VA OTEINETE PEOW NAEKTPOVIKOU TaxudpOWEiou oTov
€QUTO 0AG KAl O akOUN &vav cuhpaenTn oag Tnv €IKOva KE TO VEO HOVONATI MOU EXETE
OnMIoUpYNOEL.

15. Na oTeileTe Peow NAekTPOVIKOU OTOV €QUTO 0AG KAl O AKOWN €vav ouppaenTn oag tnv
€IKOVA PE TO POVONATI MOU EXETE ONUIOUPYNCEl, AAAG auTh TN Qopd va TNV anooTeIAETE
o€ pop®n apxeiou KML.

~+ Eninp6o0eTec ApaoTnpiéTnTEG
16. Na @TIG&eTE TO YJovonaTI Mou va evwvel Ta dUO0 KTAPIA TNG NEPIOXNG 0ac.
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17. Na kataypayeTe TNV anootacn YeTa&l Twv OU0 KTNpiwv o€ PETPA, XINOUETPA Kal WiAia.
MéETpa:

XINIOpETPQ:
Mikia:

18. Na anooTeiAeTE OTOV €aUTO OAC XPNOIKOMNOIWVTAG TO NAEKTPOVIKO TaXUOPOWEio, TO VEO
povonari, TOoo € PopPn IKOvAc 000 Kal o€ pop®r kml.

ApaocTnpIOTNTEG yia TO ZNiTI

19. Na BpeiTe onuavTika KTrpia TnG noANC oac, va Ta CnNUEIMOETE GTOV XAPTN EITE WG ONUEia
evOIaPEPOVTOC EITE VA TA OXNUATIOETE PEOA 0 NOAUYWVO Kal, OTN CUVEXEIQ, va PTIAEETE
Ta povondria anod To OniTl 0ag MEXP! auTa Ta kTnpid. Na KaTtaypAayweTe TIG ANoOTACEIC
QUTQV TWV KTNPI®V anod To oniTl 0ag Kal, 0T GUVEXEIQ, VA OTEIAETE OTO NAEKTPOVIKO 0AG
TaxudPOWEIO TIC EIKOVEC ano TIC SIAPOPEC d1IadPOUEC-ovondaTia.
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®yYAnO EPraziaz .5.4.M11
Anpoupyia kai Ene€gpyacia TpigdiaoTratou NMpoownikou
Xaptn

Ti 6a padoupe onpepa:

©OOOHHoe

Na avalnToUue Kkal va nAonyoUHaoTe YEoa OoTO NEPIBAANOV TNG EPAPHOYNG

Na dnuioupyoUpe PAKENO

Na npooBéToupe kal va eneepyaldpaoTe onueia evoiapEPOVTOG

Na emAéyoups OUYKeKpPIKEVN TonoBeaia Pe Tn xprion noAlywvou (polygon)

Na unoAoyioupe Tnv anooTacn

Na BivreookonoUpe To Ta&idl kal To eEayayoupe w¢ KML 1} KMZ.

Na anooTtéAAoupe eikdva, apxeio KMZ 1 KML, JEow nAeKTpovIKoU TaxudpOoUEioU
Na xpnoiponoloUpE Tov EEOUOIWTH) ATHONC.

ApaocTnpioTnTeG EUnédmong

1.

2TO OnMePIVO QUANO epyaciac Ba nepinynBeite OTIC NMOAUNANBECTEPEC MOAEIC TNG
Eupwnne. ZUpgwva pe 1o Bikingideia, ol 5 peyaAuTtepe¢ o€ nANBUOPO MOAEIC TNG
Eupwnng, kata ¢pBivouoa oeipd, €ival ol Nio KATw:

MoAn ka1 Xwpa MAnGuouog
Mapiol, FaAAia 10.247.794
Novdivo, Hvwuevo Baaikeio 7.512.400
BepoAivo, Meppavia 3.406.000
MadpiTn, Ionavia 3.187.062
ABrva, EMGda 3.090.508

Na evepyonoinoete TNV €@appoyrn Google Earth kalr va dnuioupynoeTe PAKEAO HE TO
ovopa «O1 peyaAUTepeg o€ NANBUoPO NOAeIC TNG Eupwnng».

Na npooB&éoeTe onueia evolaPEPOVTOG OTIC NIO NAVw NOAEIC. MNa dvopa os kABe onueEio
evOIaPEPOVTOG, Va OWOETE To Ovopa TNG KABs NOANG.

Na aAAG&eTe TO €IKovidIo TwV ONMEIwV EvOIAPEPOVTOC HE €IKOVIOIO DIKNG 0ag EMAOYNG.
Av TO €nIBUYEITE, YUNOPEITE Va XPNOILONOINCETE kKanolo and Ta diabeoiya eikovidia.

XpnoigonoiwvTag pnxavi avadntnong, va Bpeite nAnpogopieg yia kabe noAn kai va
NPoCBEoETE dUO — TPEIG YPAUHES WG NEPIYPAPN O KABe anpeio.

XpnoidonoiwvTag pnxavy avalntnong, va BPeiTe pia XapakTnpioTikh €ikova yia kabe
NOAN Kai, XpnoIHonoIwvTag TNV NAEKTPOVIKA TNG dieUBuvaON, va Tnv NpooBECETE 0 KABE
onueio.

Na Bpeite og kABs NOAN KAMOIO XAPAKTNPIOTIKO a&loBéaTto kal va To PAAETE PEOa O€
noAUywvo. Na dwoeTe To Ovoua Tou a&lobeaTou wG OVopa oTo KABe NoAUYwVo.
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8.

10.

11.

12.

Na XpnoIJOMOINCETE TNV KAPTEAG view anod TIG 1010TNTEG Tou noAUYywvou Kai va
kaBopioeTe &va oTIYMIOTUNO €IkOvag (Snapshot current view) yia To kaBe noAUywvo.

ApoU TeAelwoeTe Pe Ta noAUywva va WPeTaBeite otov QAakeAo «Oi PeyaAUTEPEC o€
nANBuouo noAeig TG Eupwnng» Kal va PJETAKIVAOETE Td NOAUywva, WOTE va BPioKETAl TO
KGBe €va and auta katw anod To onueio evoIAPEPOVTOC TNCG NOANG Tou. [.X. KATW ano To
onueio evdiapepovToc Tou Aovdivou va BpiokeTal To NoAUywvo Pe To afloBeaTo yia To
Aovdivo, KaTw ano To onueio evdlapepovTog Tou Mapioiou va BPIoKETAl TO NOAUYWVO HE
To a&loBgaTo yia TNV NoAn Tou Mapiciou K.Am.

Na enINéEETE Tov PAKEAO Kal, OTN OUVEXEIQ, va NePINyNOeiTE PYEoa oTa onueia kal oTa
noAUYywva oag, XpnoihonolwvTag To epyaAeio Play Tour.

Na anobnkeloeTe TNV MEPINYNON WG apxeio o pop®ny .kml 1 .kmz, pe TO Ovopa
«Mepifynon oTIC HEYAAUTEPEC O NANBUOHO NOAEIG».

Na anooTeiAeTe PEOW NAEKTPOVIKOU TAXUDPOWEIOU OTOV NPOCWNIKO Gag Aoyapiacuod Tov
Pakeho «O1 peyaAUTepeC o€ NANBUONO NOAeIC TG Eupwnng» o€ pHop®n apxeiou .KML.

ApaoTnpioTnTeg A§I0AOYNONG

13.

14.

15.

16.

17.

18.

Na npooBeoete aTov PAkeNO «OI PeyaAuTepeG o€ NANBUONO noOAeIG TG Eupwnng» kal
€va €KTO onueio evdla@epovToC yia Tn Pwun, n onoia ival kal €kTn nio Weyain o€
nAnBuopd ndAn Tng Eupwnng, pe 2.706.428 kaToiKoUuG.

XpnoigonolwvTag pnxav avalntnong, va Bpeite nAnpogopieg yia Tn Pwun kar va
NPooBETETE dUO — TPEIC YPAUMES WG NEPIYPAPT OTO OnNEio.

XpnaoigonolwvTag pnxavn avalntnong, va BPeiTe pia XapakTnpioTikh €ikdva TnG Pwung
Kal, XpNoIKonoIwvTac Tnv NAEKTpovikn TnG dielBuvon, va TNV NPOCHECETE OTO ONUEIO.

Na BpeiTe kANolo XapakTnpioTiko a&iobéato and Tn Pwun kKal va To BAAETE pEoa o€
noAUywvo. Na dwoeTe To Ovoua Tou a&loBeaTou wg OVopa aTo NOAUYwVo.

Na XpnolponoIiNoeTe TNV KapTéAa view and TIG 1010TNTEG TOU MOAUYWVOU Kal va
kaBopioeTe &va oTIYMIOTUNO €IkOvag (Snapshot current view) yia To noAUywvo.

Na anooTeiAeTe Eava HEOW NAEKTPOVIKOU TAXUDPOUEIOU GTOV NPOCWNIKO aac Aoyapiacuo
Tov QakeAo «O1 PeyaAUTEPEG o NANBUOPO NOAeIC TNG Eupwnng», o onoiog Twpa 6a
nepiAappaver kar Tn Popn.

4+ Eninpoo®eTec ApaoTnpioTnTEG

19.

Mo kaTw akoAouBei 0 Mivakag WE TIG ENOPEVEG TECOEPIC MOAEIG MOU CUUMANPWVOUV TV
npwTn dekada nNoAewv TnG Eupwnng oe NANBuouo. ‘Onwc KAvaTe Kal NPonNyoUREVWG, va
NPOCBOECETE £va ONUEI0 evOIAPEPOVTOC 0 KABE NOAN. Eniong, oe kGBs noAn va Bpeite
Kal va BdaAlete o noAUywvo €va a&idloyo KThpio- pvnueio —afiobeato nou va
xapakTtnpilel Tnv kabe noAn. ®povTioTe OAa Ta onueia kar noAlyova va sioaxbolv peoa
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oTov PpakeAo «OI peyahuTepeg oe NANBUCOHO NOAeIC TNG Eupwnng». ‘OTav TEAEIWOETE, va
oTeiNeTE yIa TPITN POPA MECW NAEKTPOVIKOU TAXUDPOMEIOU OTOV MPOCWMIKO 0aG
Aoyapiaopo Tov pAkeAo «O1 HeyaAUTEPEG 0 NANBUOPO NOAEIC TNG Eupwnng», o onoiog
Twpa 6a nepiAapBavel TiIc 10 peyaAlTepec o€ NANBUoPO NOAeIC TG Eupwnng.

MoAn ka1 Xwpa MAnGuopog
BoukoupéaTi, Poupavia 1.940.500
AuBouUpyo, M'eppavia 1.760.322
BapooBia, MoAwvia 1.703.198
BoudanéoTtn, Ouyyapia 1.696.128

ApaoTnpIOTNTEG YIA TO ZNiTI

20. Méoa oe kaivoupio @akeAo nou Ba Tov ovopdoeTe «OI 5 peyaAUTepeg o€ NANBUCHO
XWPEC TNG Eupwnng», va BaAeTe 5 onpueia evdlagepovTog, Ta onoia kal Ba avTioToixouv
oTIC 5 Xwpec TNG Eupwnnc pe Tov peyaAuTepo nAnBuopd. Mnopeite UkoAa va BpeiTte
MOIEC €ival AUTEG 01 XWPEG XPNOILONOINVTAG Hia pnxavr avalitnongc.

21. Na enIAeEeTe TOv (PAKEAO KAl OTN OUVEXEID va nepinynBeite peoa oTa onueia,
XpnolponoiwvTag To epyaAeio Play Tour.

22. Na anoBnkeUosTe TNV nNepINynon w¢ apxeio oe popen .kml n .kmz, pye 10 Ovopa
«MepInynon oTIG HEYAAUTEPECG O NANBUCGHO XWPES».

23. Na anooTei\eTe HEOW NAEKTPOVIKOU TaxUOPOWEiou GToV NPoownikd oac Aoyapiacpo Tov
Pakeho «O1 PeyaAUTePEG o NANBUOHO XWPES TNG Eupwnng», o€ Hop@r apxeiou .KML.
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®YAAO EPraziAz IN.5.4.M12
Anpoupyia ka1 Ene€epyacia TpiogdiaoTatou Npocwnikou
Xaptn

Ti 6a paboupe onpepa:

© Na eEgpeuvolpe TNV neployr Layer Tng epappoyng

© Na e&epeuvolpe eikdvec anod To Guoiko nepiBallov — TpiodiaoTaTa devTpa

© Na eEepeuvolpe €IKOVEG Kal va avTAoUPE NANPOQOPIEG yia TN ZeARvN, Tov Apn, TOo dIAOTNHUA, TOUG
wkeavouc.

ApaoTnpioTnTeC EUnédmwong

1. Na evepyonoinoete Tnv €@appoyn Google Earth kai va petaBeite otnv nepioxn NG
Kunpou og Uyog nepinou 200Km.

2. Na anoBnkeUoeTe TNV €IkOva Nou BAENETE, XPNOIMONOINVTAC TO EpyaAsio save image TnG
EPApHOYNG, HE To Ovopa «AopuPopIKOG XapTng TnG Kunpou».

3. Anod Tnv nepioxn Layers va eniAéEeTe To Roads. ©a napatnpnoeTe NWe NAvw oTov XapTn
NG KUnpou &xouv ep@avioTei ol KUpieg 0dIkeG apTnpieg. Na anoBnkeUceTe TV €IkOva
nou BAENETE e TO Gvopa «AopuPOPIKOG XapTng TNG Kunpou pe Apopouc».

4. Ano Tnv nepioxn Layers va eniAéEeTe pEoa anod Tnv katnyopia Ocean To Ocean Sports.
3TN OUVEXEld, va PBpeiTe TO oOnueEio nMou €xel NPooTeBel oTov XAPTN, QVOIKTA TNG
Adpvakag, yia 1o vauayio ZnvoBia. Na €nIAEEETE TO ONpEI0 WOTE va EPPAVIOTEI TO
napadupo Me TIC NANPOPOPIEC YUpw and To vaudylo. ZToV XwPO Mou akoAouBei va
nANKTpoAoynoeTe NOTE €ixe yivel n BUBION Tou NAoiou Kal NOCOo WeyaAo ATAv To NAoio.
XpovoAoyia BuBiong:

Mnkog MAoiou:

5. And Tnv nepioxn Layers va €nAéEETe pEoa anod Tnv katnyopia Gallery To Earthquakes.
Na PBpeite Tov PEYAAUTEPO CEIOPO MOU E€YIVE KAl O OMOIOG BPICKETAl NI0 KOVTA OTnV
nepioxn nou diapévete. Na ypaweTe To PEYEBOC TOU Kal TO £TOG MOU EYIVE.

MéeyeBog ZeiopoU:
XpovoAoyia:

6. A@oU evepyonoInosTe TNV €MIAOYN yia Ta TPIodIAGoTaTa O&vTpa, va YETABEITE oTnv ABriva
oTnVv nepioxn TnG AKPOnoAnc. A@oU KAVETE Wia nepiynon oTa d&vTpa TnG NEPIOXnG, va
oTeIAETE OTOV NPOOWNIKO 0ag Aoyapiaopod oto gmail €va oTIyHIOTUNO €IKOvVAG OMouU va
eupavidovral péoa TpiodiaoTaTa dEvTpa.

7. Na xpnolgonoinoeTe Tn duvaToTNTA NOU 0aG NAPEXEI N EPApHoyn Kal va JeTaBeite oTn
oehivn. AnoO ekei va PBpeiTe TO onueio OMOU €YIVE N NPOOCEANVWON TNG ANOCTOANG
AnoAMwv 11. Na OnUEIOETE OTOV XWPO MOU aKOAOUBEl NOTE £yIvE N NPWTN AUTH
NPOCCEANVWAN OTNV I0TOpia TNG avBpwnoTNTAG Kal Nolog ATav  apxnyog TNG anooToANG.

Xpovohoyia:
Apxnyoc AnooToARG:
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8.

Na peyebuveTe Yéoa oTnV NEPIOXN NPOCOEARVWONG Kal OTav BpeiTe kaTdAnAo (kaTta Tnv
Kpion oacg) oTIyhIOTUNo €IKOVAC, va To anooTeiAeTe o€ YopPpry KML aTov npoowmnikd oag
Aoyapiaouo ato gmail.

ApaoTnpioTnTeg AEIoAGYNnONG

10.

11.

Juvexidovtag pe Tnv €fepelivnon TNG OEAvnG, va PBpPeiTe To onueio Onou €yive n
NPOOCEANVWON TNG TeAeuTaiag anooToAng AnoAAwv, TG AnoAwv 17. Na peyeBuveTe
MEoa oTnVv nepioxn €€epelivnong TNG anooToANG Kal va anooTEIAETE OTOV NPOCWNIKO 0ag
Aoyapiaopo oto gmail To oTiyoTUNO €lkdvag nou va @aiveral 6An n e€epelivnon TnG
anooToAng AnoAAwv 17.

®elyovtag and Tn OeArvn, va XPNOIMOMNOINOETE Tn OuvaToOTNTA MOU O0adC MNAPEXEl N
€Qappoyn kal va peraBeite oto diAoTNHa. TNV nepioxn Layers va QpovTioeTe va ivai
emAeypévo a) To imagery kai B) To Our Solar System. 3Tn ouvexela, va natrnoeTe SINAO
KAIK oTov AAI0. To OTIYHIOTUNO €IKOVAG Nou Ba ePpavioTel JE ToV NAIO va TO ANOOTEIAETE
o€ pop@n KML atov npocwnikd oag Aoyapiacud oto gmail.

Na kavete 0INAO KAk aTov Kpovo (Saturn). Na anobnkeUoeTe TNV €IKOVA NOU BAENETE HE
TO Ovopa «Kpovocy.

4+ Eninpoo0eTec ApaoTnpioTnTEC

12.

Na e€epeuvnoTe OAOUG TOuG uMOAoINOUG NAAVATEG TOU NAIAKOU HAG OUCTAKATOC Kai va
anoBnkKeUOETE TIG EIKOVEG TOUG OMNWG AUTEG eP@avidovTal pEoa and Tnv epappoyn. Q¢
OVOpa yia kABe €IkOva va BWOETE TO OVORA TOU AVTIGTOIXOU NAQvATH.

ApaoTnpIOTNTEG YIA TO ZNiTI

13.

Méoa and Tov xaptn TnG Ing, €tol Oonw¢ napoucialetal and Tnv €papuoyn kai e
onoladnnoTte aAAn BonBeia xpeialeote and unxavr avalitnong, va PBpeite To vauayio
Tou TiTavikoU. XTn npoonabeia oag autn Ba npenel and Tnv nepioxn Layers va eniAEEeTe
a) Ocean kai, oTn ouvéxela, Tnv emioyn Shipwrecks kai B) 3D Buildings kai, otn
ouvexela, Photorealistic. To Photorealistic To emiAéyoupe yia va doUpe o€ TpIodIAOTATN
HOpP®N TNV NAWPN Kai Tnv NpUMVN TOu vauayiou, €Tol ONwG ival onuepa otov Bubo. To
OTIYMIOTUNO €IKOVAG Nou Ba gupavioTei and To vaudaylo va To anooTeiAeTe o€ Yop@r KML
oTov npoownikd oag Aoyapiacud oto gmail.  Eniong, va anoBnkeUoeTe TNV €IKOVA E TO
ovopa «TITavikoc».
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®YAAO EPraziAz IN.5.4.M13-M14
Anpoupyia ka1 Ene€epyacia TpiogdiaoTatou Npocwnikou
Xaptn

Ti 6a padoupe onpepa:
© Na XpnolJonoIinocoupde OAa 00a £XOUME UABEI OXETIKG PE TN dnuioupyia Kal eneEepyaaia npoowmnikoU
XapTn TpIwV OIA0TACEWY.

ApaoTnpioTnTeg EUnédmwong

EPrAZIA - ZENAPIO
Mvnueia Euponng
>TO PAdnua TG yewypagiac, o kabnynTng oTnv Npoondabsld Tou va To KAVEl Mo vOIapEPOV

Kal va KEVTPICEI TNV NPOCoXn Twv paénTwv Tou, {ATNOE ano auToug va XpnGoILOonoINoouV To
epyaieio Google Earth, yia va Bpouv kai va TONoBeTAoOUV HEPIKA and Ta M0 onNUavTika

hvnueia Tng Eupwnnc.

Ma Tov Adyo auTod, £dwaoE Tov NIO KATW Nivaka anod pvnueia:

MUpyoc Tou AlpeA Mapiol
Big Ben Novdivo
Mupyoc Tng Nidag Mica
BaTikavo BaTikavo

MUAN Tou BpavdepBoupyou | Meppavia

Ayida Tou OpiauBou Mapiot

>Tn ouvEXEld, £dWOE TNV NAPAkATw OEIPA anod odnyiec, KAAWVTAG TOUC va TIC aKOAOUBRCOUV:

(a) Evepyonoinote Tnv epappoyn Google Earth kai kavete eioaywyn (Sign In),
XPNOIKOMNOoIWVTAG TOUG AoyaplacioUg Nou EXETe aTnv unnpeaia Gmail.

(B) Na @Tia&ete pakelo e 1o ovopua Epyacia Fewypagiac,.

(y) Na npooBeéoete onueia evOla@EPOVTOG OTA MO MNAVW MVNUEid, OTn owoTh
YEWYPAPIKN Toug Beon. KaBe anpeio Ba npenel va To HOPPOMNOINCETE WG €ENG:

1. Ta ovopa os KABs onueio evOIaPEPOVTOC, va DWOETE TO OVOUA TOU KABE
MVNHEiou.
2. Na pHop@onoInNCeTE TO €IkOVIdIo ToU kABe onueiou (aAAayn €ikovac, alayn
XPWHATOC, ah\ayn XpwHaTog oTn ypauHaToosipd K.An.).
3. Na xpnoigonoinoste pnxavn avalntnong, yia va Bpeite NANPOPoOpIES Kal
va NpooBEcETE dUO — TPEIC YPAMMEG WG NEPIYPAPH.
4. Na xpnoIgonoInoeTe pnxavn aval(Tnong, yia va BPeEiTe Kal va NpooBEoETe
Mia xapakTnpIoTIKR €1kOva yia kabe pvnueio — a&loBeaTo.
() Na Bpeite otnv ABriva Tnv AKPONOAN Kal, XPNOILOMOIWVTAC TO €PYAAEio TNG
€MAoynG TonoBeaiac Ye Tn Xpron NoAUywvou, va OXNUATIOETE TNV NEPIOXN £TOI NMOU

177




r.5.4.M13-mM14 I'5 AikTua YnoAoyioTev kai AiadikTuo

(€)

va nepikAeiel péoa Tov Bpaxo TnG AkponoAnc. Na ovoudoeTe To noAUywvo nou Ba
oxnuatiotei «O Bpaxog TnG AkponoAnc». Na PoppOonoINCeTE TO MOAUYWVO Mou
OXNMATIOTNKE ONWG £0€iC VOMileTe KaAUTEPQ.

Na XpnoIJOMOINCETE TNV KAPTEAA view and TIG 1010TNTEC TOU MOAUYywVOU Kal va
KaBopioeTe €va oTIyHIOTUNO €IkOvVac (Snapshot current view) yia To noAUywvo.

(oT)Na kataypdyete Tn XINOUETPIKR anoéoTaon and Tnv AkponoAn oTta unoAoina

(@

(n)

(6)

(1)

hvnueia.

AkponoAn - MUpyog Tou AlpeA

AkponoAn - Big Ben

AkponoAn - Mupyog TnG Nifag

AkponoAn - Bartikavo

AkponoAn - NMUAn Tou Bpavdsppoupyou

A@oU peyebUveTE pEOa o€ KABE pvnueio, ouunepIAaUBavopévng kal TG AKkponoAng,
va anoBnkKeUOETE TIG EIKOVEC OTIC OMOIEC PpaiveTal kabapa To kabe a&lobéaro.

Na dnpioupynoete govondTi yia Tnv ABRva, To onoio va JgiXVvel TO IGTOPIKO TNG
KEVTPO. ZUYKEKPIYEVA, To MovondTtli Ba apxiCel and Tnv nAateia Opovoiac, 6a
aveBaivel and tTnv Akadnuia ABnvwv (navenioTnuio), ZUvtaypa, Zannsio Meyapo,
KaA\ipappapo Z1adio, ZTnAec Tou OAupniou Aidg kal 6a TepuaTiCel oTnv AKPOMOAN.

Inueiwon: Eival kaAUTepa va npooBeoeTe and éva onpeio evolapEPOVTOG GTA MIo
navw onueia (dev Xpelaletal va KAVETE OMNOIECONMOTE HOPPOMOINCEIC OTA Onueia
auTd) Kal, OTn OUVEXEId, Va NPOOBECETE TO PoOvondTI NATWVTAC NAVW OE KABE €va
ano Ta onueia kar akoAoubwvTac Toug KUPIoUG dpOOUC HEDA OTOV XApTn.

Na nepinynbeite péoa otov @akeho Epyaocia Mewypagiag, Ta&idevovrac ota 7
pvnueia TNG Eupwnng kal 0To 10TOPIKO KEVTPO TNG ABrvag,

Na anoBnkeUoeTe TNV NeEPInynon oTov @akeAo Epyacia Mewypagiag, Ye To Ovoua
«Takjdl ota Mvnueia T™NG Eupwnng». ZTn OUVEXEID, va TO KAVETE €EAymwyn wg
apxeio KML pe To ovopa «Ta&idi otnv Eupwnny».

(1a) Na oTeileTe oTOV NPOCWNIKO 0ag Aoyapiacud ato Gmail Tnv nepinynon «Ta&idl oTa

Mvnueia Tng Eupwnng», og pop@n apxeiou KML.

(IB) TéAog, w¢ euxapioTn dpacTnpIOTNTA MMOPEITE va KAVETE NTRON NAvw anod Tnv ABrva

N onoladnnoTe aAAn noAn, XPNOoILONOINVTAG TOV EE0MOIWT NTAONG.
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®dyano EpPraziaz r.5.5.M1
Baoikég ‘Evvoieg IoToogeAidwv

Ti 6a padoupe onpepa:

OO HOH

Na opiloupe T ival To AladikTuo (Internet)

Na opiloupe Ti €ival o Maykoouiog Iotoc MAnpopopinv (WWW)

Na opiloupe i eival IoTooeAida (Webpage) kai IotoTonog (Website)

Na opiloupe Ti gival 0 DulopeTpnTnG (Browser)

Na opiloupe Ti €ival URL kal va avapéPoups Ta PEPN NouU To anoTeAolv

Na opioupe TI €ival diaTagn IoTooeAidag kal va neplypapoupe Ta Baocika OOUIKA OTOIXEId NMou TV
anoTe\ouv.

ApaoTtnpioTnTeG EPnédmong

MoMoi Bewpolv 0TI diadikTuo kai Maykoopiog IoTdg MAnpoopiwv €ival To idIo.
JUMQWVEITE pe auTn TNV anown; Na dIKaloAOynOoETE TNV anavTnor| odc.

Na avapepete dUO QPUANOMETPNTEC MOU €XEI O UMOAOYIOTNG TOU €PYyacTnpiou TOu
oxoAgiou 0ag kal &vav QUAAOUETPNTN MOU EXETE OTO KIVNTO 0AC KAl va €ENYNOETE O€ T
XpnolpeUouv Ta npoypaupaTa auTa.

>1n dielBuvon https://www.wikipedia.org/ va evronioeTe Ta akoAouba:
(a) NPWTOKOAND (PrOtOCOI): civiiiiiiiiii ittt
(B) 'Ovopa TOMEA (AOMAIN NAME): ciiiiiiiieiieiie i e i e e e e e e e e e e et e e e e e e e e e e e e e e e e e e e e e e eeeeees

(Y) TOHEQG OPAGTIPIOTIITIIV: trruuuereerrerrrssnnssssesseeeeersssnsssseeeeeeeesssssnnsnseeeeeeeersssnnmnneeeeens

Kanolog ¢ihoc oag npoonabsi va petaBei oTov 10TOTONO TOU Ynoupyeiou Maideiag kal
MoNimiopoU, nAnkTpoloywvtac Tn OielBbuvon http://www.moec.com.cy. Na Tou
e€nynoete yiaTi auTth n dielBuvaon Ogv YiveTal va €ival owaoTr).
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6.

Na ava@eépete Tpia OOMIKG OTOIXEId MOU MMOPEi va NepIEXel Mia 10TooeAida kal va
€ENYNOETE TI EVVOOUNE We Tov Opo dIaTagn IoTooeAidac.

ApaoTnpioTnTeG ASI0AOYNONG

Na avoiéeTe To apyeio fel_quiz kal va anavtrosTe € OAEC TIG EPWTHOEIC.

*+ EninpooBerec ApacTnpioTnTEC

'Otav oxedialoupe pia 10TooEAIda e KAnolo AoyIoHIKO nou pag divel Tn duvatdTnTa va
emAgEoupe Tn dIaTagn Tng, €ival Baoiko va enmIAEEoUNE T owaTn diata&n anod Tnv apxn,
WOTE va Yivel EUKOAOTEPN N GUKNANPwWON TNG. Na dIKAaloAOYROETE TNV anoyn auTh.

Na avoi€ete €vav QUANOUETPNTN Kal We Tn PBonBeia piac unxavng avalitnong (n.x.
Google) va Bpeite kal va onueEIWOETE Mo kATw Tn dlelBuvon Tng Cytanet. Eniong, va
€ENYNOETE Ta PEPN Nou anoTeAouv Tn dielBuvon auTn.

ApaocTnpIOTNTEG yia TO ZNiTI

10.

11.

12.

Me Tn Xpnon Tou QUANOUETPNTN 0AC, VA YPAWETE TPEIC IOTOOENIOEC MOU NEPIEXEI O
loToTonog Wikipedia.

XpnoidonoiwvTag pia pnxavr avalntnong, va Ppeite kai va anobnkeUoeTe Wia eikova
nou, KaTa Tn yvwun oac, deixvel nio kabapd Tnv &vvoia Tou opou AiadikTuo (Internet).
O padbnTng nou Ba emAEEel TNV kaAUTEPN €lkdva Ba Tnv napouacidcel kal 6a Tnv Enynoel
oTnv unodloinn Tagn.

Na &nynoTe T €ival o Maykoopiog IoTog MAnpogopiwv (WWW).




®YAAO EPraziAz N.5.5.M2
Anpioupyia IoroTonou — Mevou kal EpyaAgi00nkn

Ti 6a padoupe onpepa:

OO 666

Na dnuioupyoUpe Aoyapiacuo otn diadiktuakr nAat@opua Weebly

Na dnuioupyoUpe 1oToTOMNO (dNUIoupyia, Ovoua Topea, NpOTUNO)

Na opiloupe Ovoua ICTOTOMOU

Na avayvwpiloupe TIC I0TOOEAIDEC TOU IOTOTOMOU WAG Kal va PETABaivoupe anod pia 1oTooehida ot
aAAn

Na avayvwpiloupe Ta Bacikda pevol Kal EpyaleioBbnKeg

Na aAAaloups npoBoAr)

Na dnuooIEUOUKE I0TOTOMO.

ApaoTnpioTnTeG EUNédmwong

0.

Na avoifete  évav  QUANoOpETPNT) kal  va  MetaBeite  otn  OlelBuvon
https://www.weebly.com.

Na naTnoeTe To KOUKNi Eyypagng.
Na cUPNANPWOETE TIC ANAPAITNTEC NANPOPOPIEC WOTE VA KAVETE EYYpaAPH.

>tnv epwTtnon What kind of website would you like to create? va eniAe€eTe I just need a
website.

AkoAoUBw¢ kaheioTe va emAeEeTe eva Bpa (Theme). Na emiAéEeTe TNV opdda BepdTwv
Portfolio.

Na emIAéEETE Eva BEpa nou oag apéael yia Tov 1I0ToTono oag. Apou deiTe Nwg Ba @aiveral

0 10TOTONOG 0ag, va natnoete Start Editing yia va 1o emAe€eTe, N *' yia va emIAEEETE
KAnolo aAAo B€ua.

Na enAeEeTe Eva dwpeav OVOWA TOHEA Yia TOV I0TOTONO OdC,.

Na eEepeuvnoeTe Ta Nio KATW HEVOU Kal va ONUEINCETE KAMOIEG ano TIG ASITOUPYIEG TOUG:
(o )T = 101 e P

(B) PGS . euniitiiie ettt e e aaarae
72 LI L= = PP

(o) =10 o 3 PPN

Na opioeTe w¢ dvopa Tou IoTOTONoU TN ppdacn My First Website.

10. Ze TI XpnoideUel N pyalelodnkn;
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11. Ano nolec 10TooeAIdeC anoTeAeital o 10TOTONOC oac; Na peTaBeite o pia and auTeg,
XPNOIKONOIWVTAG TA KOUKMIA NAOrynonc.

12. Ze 11 Xpnoiyevel To koupni Publish;

13. Na evtonioste TO €Ikovidlo alaync npoBoAnc. Na e&nynoete TIC OUO OIaBECIYEC
NPOBOAEC:

(o) DL S o PP
5 T Ao o] 1= PP
14. Na anoouvdebeite and Tov Aoyapiacuo oac.
ApaoTnpioTnreg ASI0A0YNONG

15. Na ouvdebeite otnv nAatgopua Weebly. Me Tn ouvdeon oac, epgaviletal To Dashboard
onou BAENETE OAOUG TOUG IOTOTOMOUG NOU EXETE ONUIOUPYNOTE.

16. Na Odnuioupynoste €vav veo 10TOTOMO. A va TO EMITUXETE AUTO, va E€NIAEEETE TO
€Ikovidlo oTnNV Navw O€&1d ywvia TngG 1I0TooeAIBAg, kal 0T guvexela va emnAeEeTe Add
Site.

17. Zmnv gpwTtnon What kind of website would you like to create? va eniAé€eTe I just need a
website.

18. Na dokipdaoete Ta diapopa Bpata. Na enIAéEeTe eva BEPa anod Tnv katnyopia Personal.

19. Na emAeEeTe éva dwpedv OVOWaA TOUEQ yia TOV IGTOTONO OdC.

20. XpnolponolwvTag To avTioToIXo Wevou, va aAa&eTe To npoTuno (theme) Tou 10TOTONOU
oag,

21. Ano To pevou Settings va opiosTe To Gvoua Tou 10TOTOMNOU O£ «Gaming».

22. Na peTaBeite kal va O&iTe OAEC TIC I0TOOEAIDEG TOU I0TOTONOU OaC,.

23. Na deite nw¢ Ba npoBAMeTal n apxikn oehida Tou I0TOTONOU 0AG O POPNTH CUOKEUN
(Mobile).

24. Na aM\a&ete kal naAi Tnv npoBoAn oag os npoBoAn enitpanediou unoAoyioTr (Desktop).

25. Na oneIwosTe Tpia avTIKEIEVA TNC EPYAAEIOBNKNG NOU UMNOPEITE va NPOCOECETE O Wia

IoTOOEAIdA:




5.5 Angioupyia IotooeAidag r.5.5.mM2

26. Na dnpooieUoeTE TOV I0TOTONO OAC.
27. Na anoouvdeBeiTe anod Tov Aoyapiacuod odc.

+ EninpooBerec ApacTnpioTnTES

28. e TI xpnoiueUouv Ta Pevou Apps kai Help;

ApaocTnpIOTNTEG yia TO ZNiTI

29. Ano nolec I0TooeAIOEC anoTeAeiTal o I0TOTONoC Gaming NOU KATAOKEUAOATE;
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®yYAnO EPraziAz .5.5.M3
IoTooeAidec kal Tunuara

Ti 6a padoupe onpepa:

@
@
@
@
@

Na npooBéToupe kal va diaypapoupe I0TOOENIDEG

Na aAAaloupe ovoua 10TogeAidag

Na npooBéToupe kal va diaypagoupe Tunpara (sections)

Na aAAaloupe Tnv kepaAida (header) piag IoToogAidag

Na aAAaloupe To @ovTo (background) TuRUATOC Kal OAOKANPNG TNG I0TOCEAIDAC.

ApaoTnpioTnTeG Enédmwong

10.

11.

12.

13.

Na avoifete  évav  QUMNopETPNT) KkaI  va  MetaBeite  otn  OleUBuvon
https://www.weebly.com.

Na ouvdeBeiTe Pe Tov Aoyapiacuo oac.

Na ermAe€eTe Tov I0TOTONO Gaming Kal, 0T Ouvexela, va emAeEeTte Ene€epyaoia (Edit
Website).

>Tnv apxikn oehida va enAéEeTe TUNO KePaAidac (Header Type) Splash.

Na aM\a&ete Tnv €ikOva QOVTOU TNG apXIKNG o€Aidac. Mnopeite va XpnoiKonoINosTe
KAnola ano TIG EIKOVEG Nou NePIEXEI N NAaTPOpHa Weebly 1 va BpeiTe pia nou oag apeoel
ano To d1adikTuo.

Na dilaypdyeTe OAeG TIG I0TOOEAIDEG TOU 10TOTONOU 0AG €KTOC AMO ThV APXIKN Kal TN
deUTEPN.

Na aA\a&eTe To Ovopa TnG delTePNG I0TO0EAIDAG o «About Us».
Na apaipeoeTe TNV ke@aAida (No Header) ano Tnv iotooeAida About Us.

Av n 10TooeAida About Us éxel nepiocoTepa and éva Tunuarta (sections), va Ta
dlaypAYETE WOTE va HEIVEl JOVO €va.

Na aMa€ete To @ovTo (background) Tou THAKATOC NOU anEPelve oTnv 10ToogAida About
Us, emA&yovTag éva XpwHa nou oac apecel.

Na npooBéoeTe pia 10TooeAida (Standard Page) oTov 10TOTONO 0ag. Na TnG dWOETE TO
ovopa Games. H 10ToogAida va pnv nepiexel kepalida (No Header).

Na npooBECETE 1 va APAIpECETE TUNKATA, WOTE N I0TooeAida Games va nepIEXel Tpia
TUAMaATA.

Na dnuooIeUOETE TOV I0TOTOMO.
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ApaoTnpioTnTeg AEIoAGYNONG

14.

15.

16.

17.

18.

19.

20.

21,

22,

23.

24,

Na npooBeosTe akopa Mia 10ToocAida pe Ovopa Photos. Na emNeEeTe va pnv €xel
Ke@aAida. H véa 10TooeNIda va NePIEXEI HOVO £va TUAKA.

Na aA\GEETe To XpwHa TOU GOVTOU TOU TUNHATOC, EMIAEYOVTAC OMOIO XPWHA 0A¢ APETEL.
Na diaypdyeTe €va and Ta TUNPATA TG I0ToogAidac Games, WOTE va anopeivouv dUo.
Na npooB&oeTe akdpa pia 10TooeAida pe ovopa New. Na emIAEEETE va €xel ke@aAida.

Na kaveTe TNV KePaAida 600 To duvaTov nio pIkpr (GUPOVTAG TNV NPOG Ta NAvw).

Na aAM\a€eTte Tnv €ikOva oOvTou TNG kepaAidag, BalovTag Wia anod TIG ETOIPEC EIKOVEG TNG
nAaT@opuac Weebly.

Na npooBecete akopa dUo TunPaTta oTnv 1oTooeAida New, Xwpi¢ va €nIAEEETE kanoia
oiaTaén (layout) yia Ta TUApaTa autd.

Na enAEEETE BIAPOPETIKO XPWHA POVTOU Yia KABE TUNHA TG IoTooeAidag New.

Na npooBeoeTe pia 10To0€Aida pe To ovopa Contact Us. Na pnv €xel ke@aAida kal va
nepIAapuBaver duo Tunuata. Na pnv emAEEeTe kanoia diATagn.

Na diaypaweTe Tnv IoTooeAida New.

Na dnpoaoIeUCETE TOV IOTOTOMO.

=+ Eninp6o0eTec ApaoTnpidTNTECG

25.

26.

Na aMda€ete 10 @OvTOo (background) o€ OAa Ta TMAMATAG TOU IOTOTOMOU OQG,
npoonabwvTag va Tou dWOETE 000 TO OUVATOV KAAUTEPN gupavion. Mnopeite va Bpeite
€IkOVEG and To dIadikTuo Kal va TIG XPNOIKOMOINCETE WG POVTO.

Na aMa&ete Tnv €ikova aTnv apyikn ogAida Tou 10TOTONOU 0ag. Mnopeite va Bpeite
€lkdva ano To d1adikTuo Kal va Tn XPNOIKOMOINCETE WG POVTO.

ApacTnpIOTNTEG YId TO ZNiTI

27.

Na npoBdAeTe Tov 10TOTONO 0AC WG ENIOKENTNG OTOV (PUANOMETPNTH. Na evrtoniosTe
XpwHaTa PpOvTou Kal EIKOVEG Nou deV 0ag ApECOUV Kal va T AVTIKATACTHOETE.
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®yYAnO EPraziaz '.5.5.M4-M5
Eicaywyn Keipyévou kar Eikovag

Ti 6a padoupe onpepa:

©OOOHee

Na npooBéToupe nAiola KEIPEVOU Kal TITAoU
Na npooBETOUE EIKOVEG

Na npooBéToupe diaxwpioTika (dividers)

Na npooBéToupe Kevo (spacer)

Na diaypapoupe EIKOVEG Kal KEINEVO

Na pgop@onoloUeE Keipevo

Na aA\aloupe To pEyebog eikdvac.

ApaoTnpioTnTeCG EUnédmwong

10.

11.

12.

13.

14.

15.

Na avoi€ete €vav  QUMopeTpnT) KAl va  MetaBeite otn  dleuBuvon
https://www.weebly.com.

Na ouvdeBeiTe Pe Tov Aoyapiacuo oac.
Na eniAeEeTe Tov I0TOTONO Gaming kal va natnoeTe eneepyaoia (Edit Website).
>TIG 10To0EAIdDEC Home kal About Us, va diaypdyeTe OAa Ta AVTIKEIPEVA NOU UNAPXOUV.

>Tnv 1oToceAida About Us va eioayayeTe éva nAaiolo keiyevou (Text), pia eikova (Image)
kal Eva dlaxwploTiko (Divider) HeTA&U TOUG, WOTE OTO APIOTEPO HEPOG TOU TUNMATOC va
gival To nAaiolo keiyévou, aTo Oe€i N eIKOva Kal HETAEU TOUC TO BIAXWPIOTIKO.

Na €AaxIoTOMOINCETE TOV XWPO METAEU KEIYEVOU Kal €IKOVAG, KAVOVTAG MO MHIKPO TO
dlaXwpPIOTIKO.

>To nAaiolo KelpEvou va nAnkTtpoloynote: «Kahwg NABate oTnv I1oTooeAida Jac.
MoipaoTeiTe padi pag To Nabog oag yia Ta NAEKTPovIKA naiyvidia. Edw 6a BpeiTe KPITIKEG,
oxOMia kal AUoeIg yia OAa oag Ta ayannuéva naiyvidia!»

Na au&noeTe To PeyeBOC TNG YpaKHaTooEIpag dUO (POpPEC.

Na enIAEEETE Eva XpwiHa YPAUHUATOOEIPAC MoU va Talplalel 0To XpwHa Tou TUAHATOG 0dc.
Na eQapuOOETE EVTOVN YPAPr) OTO KEIPEVO.

Na eQappOoeTE NANPN OTOIXION OTO KEIUEVO.

>To nAdiolo €IkOvag va el0ayayeTe Tnv eikova Gaming.jpg.

Na kavete Tnv €ikova Gaming.jpg Aiyo nio pikpn.

Na ecioayayete éva nAaiolo TiThou (Title) ndvw and Ta avTiKeEipeva nNou EXETE
TONOBETAOEI, WOTE VA EKTEIVETAI OE OAO TO WAKOC TOU TUAHATOG.

270 nAdioio TiTAOU va NANKTpoAoynoeTe Tn ppdon «Keep Calm and Play Video Games!».
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r.5.5 Anuioupyia IoTtooeAidag r.5.5.M4-M5

16. Na OdwoeTe kataMnho pEyeBOC kal Xpwua oTa ypdupata Tou TiTAou. Emiong, va
EQApPOoETE NAAYIA Ypagr, unoypdupion Kal OToiXIon OTO KEVTPO.

' ' ' ' ' T '
17. Na eniIAeEETE TO KEIPEVO TOU TITAOU KAl va NATHOETE TO €IKOVIOIO . TiI napatnpeiTe;

18. Na avaipéosTe TNV TEAEUTAIA EVEPYEIQ.

19. Na npooBeoeTe kevd Xwpo (Spacer) navw and To NAdICIO KEIYEVOU WOTE VA PETAPEPDEI
Aiyo nio KATw Kai va BPIioKETAl 0TO KEVTPO TNG €IKOVAC nou BpiokeTal Oe&id.

H 1oToogAida About Us npénel va poialel e TNV nio KATw €1KOVa:

20. Na sioayayeTe €va nAAiolo KEIPEVOU KATW anod TA AvTIKEIYeVa oag kal dinAa anod autd va
€l0ayayeTe nAaiolo ikovac.

21. Na dnpooieUoeTe TIG aAAayEC Nou KAVATE.

22. Me nolov TPOMO MMNopoUpE va dlaypayoupe €va onolodnnoTE avTIKEiJeEvO and Tnv
nAatpopua Weebly;

ApaoTnpioTnTeG AEIoAGYNONG

23. Na diaypayeTe To NAAioIo KEIYEVOU Kal TNV €IKOva nou BAAaTe oTo epwTnua 19.

24. Na petaBeite otnv 10ToocAida Games. H 10ToogAida autn nepidauBaver dUo TunRuara
(sections).

25. 370 NpWTO TUNAMUA va eioayayete MAgiolo TiTAOUu Kal va NANKTPOAOYNOETE T Ppaon
«KAaoika Maiyvidia».

26. Na €pappOOETE GTO KEIPEVO TOU TITAOU TIG AKOAOUBEG HOPPOMOINTEIG:
(a) Au&non peyebouc ypaupaTwy (Kia popd)
(B) 'Evrovn ypaon
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r.5.5.M4-M5 I'5 AikTua YnoAoyioTov kai AiadikTuo

27.

28.

29.

30.

31.

32.

33.

34.

35.

36.

37.

38.

39.

(v) Ynoypappion
(3) MAayia ypagn
(g) KOKKIVO Xpwua

(oT) ZT0IXION OTO KEVTPO

Katw and To nAdioio TiTAou, va eioayayeTe TIG €lkoveg Red_Alert.jpg, Diablo.jpg kai
San_andreas.jpg, Tn pia dinAa ano Tnv aAAn.

Na kavete Tnv €ikova San_Andreas nio PIKpr, WOTE va €Xel NEPINOU To idlIo UYOC JE TNV
elkdva Red_Alert.

Katw ano TIc IkOVeC, va eloayayeTe €va diaxwploTiko (divider).

Katw and 1o 31axwpIoTIKO va €10ayAyeTe €va NAAIOIO KEIMEVOU Kal va NANKTPOAOYNOETE:
«a nAnpogopieg kal oxXOAIa NATNOTE TNV €IKOVA ToU NaixVIOIoU Nou BEAETE.

Na PEIWOoETE pia popa To YEYEDOC TOU KEIYEVOU.
Na EQapuOOETE OTO KEIPEVO GTOIXION GTO KEVTPO.

270 OeUTEPO THNMA, va €l0ayayeTe €va NAQIoIo TITAOU kal va ypawete o’ autd «Nea
Maryvidia».

Na €QapuOCETE TIG IDIEC HOPPOMOINCEIC NOU EPAPHOCATE OTO MPONYOUKHEVO MAQICIO
TiTAOU.

Katw and To nAaiolo TiTAOU va sioayayeTe TIG eikoveg Doom.jpg kai FifalZ.jpg Tn pia
dinAa anod Tnv aAAn.

Avapeoa oTig U0 €IKOVEG va aProeTe Kevo Xwpo (Spacer).

Na au&opEiwoETE TO PEYEDOC TWV EIKOVWV KAl TOU KEVOU XWPOU, WOTE Ol OUO EIKOVEG va
MNV €xouv heyain dlagopa os UYoq.

Na dnuooieUoETE TOV I0TOTOMO.

Av o€ éva nAaiolo KEIYEVOU EPAPHOCOUNE HOPQPOMOINCEIC HE TN OEIpa nou BAENETE OTa
akoAouBa eikovidia, noia Ba eival n TEAIKN popgonoinon nou Ba €xel;

OOEO R
4 /4 4 !
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r.5.5 Anuioupyia IoTtooeAidag r.5.5.M4-M5

=+ Eninpoo0eTec ApaoTnpioTNTEG

40.

41.

42.

43.

Na npooB&aeTe £va veo TUNHA Katw and Ta dUo nou ndn undpyouv.

>TO VEO THNMA, va €l0aydyeTe £va nAQiolo TITAOU Kal va NANKTPOAOYNOETE «Ayannuéva
Maiyvidia».

Na epapHOOETE TIC HOPPOMOINTEIC NOU EQApuoOcaTe aTa aAa dUo nAaioia TiTAou.

Na Bpeite and To dIAdIKTUO EIKOVEG ANO TOUAAXIOTOV Tpia ayannuéva oag naiyvidia kai
va TIG €10ayAyeTE KATW ano To NAdiolo TiTAou. MMopeiTe va Toug dWOETE TO PEYEDOC nou
BENETE Kkal va XpnolponoinosTe diaxwploTika (dividers) kai keva (spacers), WOTE va TIG
OTOIXIOETE ONWC ENIBUEITE.

ApacTnpIOTNTEG yia TO ZNiTI

44,

Na €&nynoeTte o€ T XxpnolheUouy Ta avTikeipeva diaxwploTiko (Divider) kar kevo (Spacer).
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®YAAO EPraziAz IL5.5.M6
Eicaywyn Napouagiaaong, MkaAepi ka1 Bivreo

Ti 6a padoupe onpepa:

% Na npooBeToupe YkaAepi eikovawv (Gallery)

@ Na npooBsToups napouaciaon lkovwy (Slideshow)
% Na JopgponoloUpE napouaiaon eIKOVwv

% Na npooBeTOUE BivTeD

@ Na aM\aloupe peyeBoc oe BivTeo.

ApaoTnpioTnTeC EUnédmwong

10.

11.

12.

Na avoi€ete €vav  QUMopeTpnT) KaI  va  MetaBeite otn  dleuBuvon
https://www.weebly.com.

Na ouvdeBeiTe pe Tov Aoyapiacpo oag.
Na eniAeEeTe Tov 1I0TOTONO Gaming kal va natnoeTe ene&epyaoia (Edit Website).

>Tnv 1oTooeAida Photos va npooBéoete pia napouciaon eikovwv (Slideshow). Na
eMAEEeTE To TUA Simple Slideshow.

>Tnv napouaiaaorn, va NnpooBEoETE TIC IKOVEG minecraftl.jpg pExpl minecrafts.jpg.
Na anoBnkeUoETe TNV NApPouUadiacn IKOVWV.

Katw anod Tnv napouciaon va npocBeoeTe Wia ykalepi eikovwv (Gallery).

Na npooBETeTe OTNV YKAAEPI TIG EIKOVEG minecraft6.jpg péxpl minecraft11.jpg.

Katw anod tnv ykaAepi va npoaBeoeTe €va Bivreo anod To enionuo kavaAl Tou naiyvidiou
Minecraft oTo YouTube. lNa va To NETUXETE AuTO, va AKOAOUBAOETE Ta NIo KATW BAuara:

(a) Na sioayayeTe To avTikeipevo YouTube KGTw ano Tn YKAAEPi EIKOVWV.

(B) Na avoifeTe AN kapTéAa oTov PUANOHETPNTT) I0TOU.

(y) Na nhonyn®eite otn ogAida https://www.youtube.com/user/TeamMojang.

(0) Na naTtnoete o€ €va and Ta Bivreo.

(e) Na enmiAéEeTe kal va avTiypawete Tn dieuBuvon (URL) Tng 10TooeAidac.

(oT)Na Tnv enikoAnoeTe aTov Xwpo YouTube Video URL Tou avTikeiyévou YouTube.
Na aAAaEeTe To pEyeBog Tou Bivreo o€ Extra Large.

Na npooB&oeTe TNV €lkOva minecraft12.jpg oTnv napouaciacn IKOVwV.

Na aAAG&eTe Tnv TaxUTNTa Napouaciacnc TwV EIKOVWV O 3 OEUTEPOAENTA.
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r.5.5 Anuioupyia IotooeAidag r.5.5.M6

13

14.

15.

. Na aM\a&eTe To OTUA peTaBaong ano eikdva oe eikova, o Mosaic.
Na npooB&aeTe TNV €lkdva minecraft13.jpg oTnv YKAAEpPi EIKOVWV.

Na dnuooieUoETE TOV I0TOTOMO.

ApaoTnpioTnTeG AEIoAGYNnONG

16.

17.

18.

19.

20.

Na npooBéoeTe €va veo TURKA (section) kGTw and To TUAKA MOU NEPIEXEI TO UAIKO ToU
naiyvidiou Minecraft.

>T0 VEO TUAKA va €l0ayayeTe Hia napouciaon €IKOVWV Kai dinAa, pia ykaAepi eikovwv. Na
BAAETE TOUAAXIOTOV TEOOEPIC EIKOVEG OTO KABE €va kal va enIAEEETE OnoleC pubuioelg
enBupeite. MnopeiTe va BpeiTe eikOveC aTov pakeho Fortnite.

Na eloayayeTe €va dlaxwpIoTIKO KATW anod Ta dUO avTIKEIWeva.

Katw and To diaxwploTikd va sicayayete €va Bivreo and To Youtube oxeTIkO HE TO
naixvidl Fortnite. To BivTteo va éxel peyebog Large.

Na dnuooIEUCETE TOV IGTOTOMO.

=+ Eninpoo0eTec ApaoTnpioTNTEG

21.

Na BpeiTe €IkOveG Kkal Bivreo and To dIadikTuo yia &va ayannuevo oag naiyvidl kai va Ta
€10ayAYETE O€ VEO TUAKA OTO KATW HEPOG TNG 1I0TOOEAIDAC Photos.

ApacTnpIOTNTEG yia TO ZNiTI

22,

Moia €idn Bivreo pnopoUpE va €10ayouls o€ Wia 1I0TogeAida TG nAaTpoppac Weebly;
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®yYALO EPrAZIAZ NL5.5.M7

®opua Emkoivaviag, ‘Epguva, EvnuepwTikd AgATio kal XapTeg

Ti 6a padoupe onpepa:

© Na €I0ayoUE Kal va TPononoloUE pOpUa ENIKOIVWVIAG OE 1I0TOOEAIDa

% Na sl0ayoupe XapTn o< 10TooeAIda

% Na €l0Gyoue Kal va TpornomnoloUpE Epeuva (survey) o€ 10TooeAIda

© Na €I0ayoulE Kal va TPOonomnoloUKE (pOpUa eyypaprc o evnUepwTIKO deATio (newsletter).

ApaoTnpioTnTeCG EUnédmwong

10.

Na avoifete €évav  QUNopeTpNT) KAl va  petaBeite  otn  diuBuvon
https://www.weebly.com.

Na ouvdeBeiTe Pe Tov Aoyapiacuo oac.
Na eniAeEeTe Tov I0TOTONO Gaming kal va natnoeTe eneepyaoia (Edit Website).

>Tnv 1oTooeAida Contact Us, 0TO npwTo TUAMUA va €10AQYAYETE Wia POPHA ENIKOIVOVIAC
(Contact Form). Na pnv aA\G&ete kaveva nedio.

Agfid and Tn @OpHa eniKoIVWVIag va €ioayayete Xaptn. G dielbuvon WMopeiTe va
XxpnoiponoinosTe Tn dielbuvon Tou oniTioU oag f Tn dieubuvon Tou Ynoupyeiou Maideiag
kal MoAmopoU (Fwvia Kipwvog kal @oukudidou, AkponoAn, 1434, Acukwaia).

2T0 NpwTo TUAMA TnG loToogAidag Contact Us kal katw and Ta AdAAa avTikeipyeva va
eloayayete pia €peuva (Survey). Na diaypawete 6Aa Ta nedia, agprvovtag povo dia
€PWTNON HE TNV MNIO KATW HOPPR:

ApioTepd anod Tnv €peuva, va €i0ayayeTe pia QOpHa €yypapnc os evnUEPWTIKO OeATIO
(Newsletter Form). Na aA\GEeTe Tov TiTAO 0 «Eyypa®eiTe OTO EVNUEPWTIKO PAC DEATION.

Na eAéyEeTe OTI OAEC 01 POPUEC £xouv owoTn dlElBuvon NAEKTPOVIKOU Taxudpoeiou,
wOTE Ta gnvupaTa va épyxovral otn dikr) oag dieubuvan.

Na dnpoaieloeTe TOV I0TOTONO.

Na eniokePOeiTE TOV I0TOTOMNO NOU EPTIAEE KAMOIOG CUMKABNTAG 0ag Kal va agprosTe Eva
oXOAIo 0Tn POpua enikoivwviac. Eniong, va anavrioete otnv £peuva. To idio Ba kavouv
Kal ol CUMKAaBNTEG oag aTov JIKO 0ag IGTOTONO.
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r.5.5 Anuioupyia IotooeAidag r.5.5.mM7

11. Na eAéy&eTe TO NAeKTPOVIKO Taxudpoueio oag, woTe va deiTe Ta oxOAld nou apnoav ol
OUMPMAaBNTEC 0ag oTov I0TOTOMNO OdC.

ApaoTnpioTnTeG AZIoAOYNnOoNnG

12. ZTnv 10T00EAIda Photos oTo TUAMWA nMou nepiéxel UAIKO yia To nalyvidl Minecraft va
npooBeoeTe €vav xaptn. Na eioayayste T dieUBuvon SE-118 53 Stockholm nou €ival n
OleuBuvon TN eTaipeiag Mojang oTnv onoia avnkel To naiyviol.

13. 210 deUTEPO THAKA TNG IoTooeAidac Contact Us va €icaydyete Tnv €peuva nou BAENETE
oTNV Mo KAaTw €IKOVA:

14. Na TpononoINoETE TN POPKA ENIKOIVWVIAG WG EENG:

(a) ZTov TiTAO NANKTPOAOYNOTE TN PPAcn «APNOTE Ta OXOAIA 0aG».
(B) Katw ano To nedio Name, va npoaBeoete To nedio Phone Number (Short Text Box).
H oupnAfpwaon Tou va Pnv €ival UNoXpewTIK).

15. Na npooBeoeTe POpUa eyypa@ng o evnuUepwTIKO OeATiO (newsletter) oTo KaTW WEPOC
NG 1oTooeAidag Games. AMNAETe Tov TiTAO 0¢ «EvnuepwBeite yia Ta kaAUTepa vea
naryvidla nou KUKAOQopoUv».

16. Na €AEyEeTe OTI ONEC OI POPUEG EXOUV OWOTNH OlEUBUVON NAEKTPOVIKOU TaxudpouEiou
WOTE Ta Pnvupara va épxovral atn Oikn oag disubuvan.

17. Na dnuooIeUoETE TOV IGTOTOMO.

=+ Eninpoo0eTec ApaoTnpioTNTEG
18. Na €&nynosTe o€ TI XPNOIYEUOUV Ta MO KATW:

(A) DOPHA EMIKOIVIOVIAG: vveereerrrrrunsseeseererrrssssnsseessseeeessssssssreeeeeseeesssnnnreeeereerrrnn




r.5.5.M7 5 AikTua YnoAoyioTav kai AiadikTuo

(V) EVNHEPWTIKO OEATIO! tevrrrruuuiseeeeeerererrsnnnseeseserrrrrssnnsnseeeseeeeesssnnnnrreeeeeeeeenssnnnnnns

ApaocTnpIOTNTEG yia TO ZNiTI

19. Na npooBéoeTe dUO AKOPA EPWTNOEIC OTNV EPEUVA TOU EPWTAMATOC 14.
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®YAAO EPrAZIAZ N.5.5.M8
Anpioupyia IorooeAidac pe xpnon Aiadikruakng NAarpopuac

Ti 6a paboupe onpepa:

© Na €10ayoulE apyeia nou Pnopei va KaTeRAcel o XproTng

© Na €10ayoulE UNEPOUVOECHOUG KEIMEVOU Kal EIKOVAC

© Na sioayoupe AeEeIC kKAEIOIG, WOTE 0 I0TOTONOC KA va evronileTal EUKOAA OTIC UNXAvee avalnTnong
© Na OuvOEOUWE TOV IOTOTOMO Hac KE To NPOQIA ) TN 0eAida Pac os YETA KOIVWVIKNG dIKTUWONC.

ApaoTnpioTnTEG EUNEdmong

1. Na avoifete €évav  QUNoOPETPNT kai va  MeTaBeite ot dleuBuvon
https://www.weebly.com.

2. Na ouvdebeite pe Tov Aoyapiaopo odc.
3. Na eniAéEeTe Tov 1I0TOTONO Gaming kal va natnoete ene€epyaaia (Edit Website).
4. 270 KATW WEPOC TNC 10TO0EAIDAC Games va NPOooBECETE €va VEO TUAKA.

5. 2T0 VEO TUNMA va €l0ayayeTe TITAO Nou va ypagel «Maiyvidia nou dnuioupynoav ol Pilol
TNG I0TOCEAIDAG Hag».

6. Katw ano Tov TiTAo va sicayayeTe To apxeio (File) 1945.exe.

7. Katw and 10 nAQiolo Kelgévou TnG loTooeAidag About Us va eioayayete eikovidla
KOIVWVIKNG dIkTUwonNG (Social Icons).

8. Na apaipeosTe 0Aa Ta €ikovidia EKTOG and To eikovidio Tou Facebook.

9. Na ouvdeoeTe TO €Ikovidlo He To NPo®IA 1 Tn ogAida oag oTto Facebook. @a npénel va
nAaTe 0TO NPOYIA 0ag kai va avTiypayeTe Tn dieUBuvaon Tou.

10. XTnv 1oTo0€Aida Games va enmIAEEETE TNV €lkdva Tou nalyvidiou Diablo kal va sicayayeTe
Tov akOAouBo unepouvdeapo (link): http://us.battle.net/d3/en/

11. Ztnv 10To0€Aida PHOTOS, ndavw and Tnv napouciaon eikovwv (slideshow), va
€l0ayayeTe Tov TiTAO «Minecraft».

12. 3Tn Aé&n  Minecraft va eioayayete Tov  akdhouBo  unepouvdeopo  (link):
https://minecraft.net

13. ZTI¢ puBpioeig SEO, va npoobeoeTe TV nepiypagr «Website about video games».
14. Na npooBéoeTte TIC AeEeIc kA€1BIG: Gaming, Video, Games.

15. Na dnuooieUoEeTE TOV IGTOTOMO.
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r.5.5.M8 I'5 AikTua YnoAoyioTov kai AiadikTuo

ApaoTnpioTnTeg ASI0AOYNONG

16.

17.

18.

19.

20.

21.

>Tnv 10Too0eAida Games, OinAa and To apyeio 1945.exe va NPOCHECETE TO ApPXEIO
octopus.exe.

>Tnv 1otooeAida About Us, va enmINEEETE Tn @PACN «NAEKTPOVIKA nalyvidia» kal va
€l0ayayeTe évav unepoUvOeTo yia Tn dielbuvon:

https://en.wikipedia.org/wiki/Electronic_game

>Tnv 1oTooeAida Contact Us, katw and Tov XApTn va €10ayayeTe €lkovidla mou va
OUVOEOUV TOV I0TOTOMO 0AC KE TO NPOPIA 0a¢ 0 OAA TA PECA KOIVWVIKNG JIKTUWGONG Nou
€ioTe PéENOC.

>Tnv eikova Doom Tng 10To0eAidag Games va NpocBEoEeTE Tov oUVOECHO doom.com.

Na npooBeoeTe akOUa TEOOEPIG AEEEIC KAEIDIA NOU VOMICETE OTI €ival XPNOIYEG, WOTE O
I0TOTONOC 0ac va evronieTal eUKOAA OTIG PNXavee avalitnong.

Na dnpoaieloeTE TOV I0TOTONO.

+ Eninpoo0eTec ApaoTnpiéTnTEG

22,

23.

24,

Mépa and To avoryda al\ou €EwTePIKOU I0TOTOMNOU, MOIEC AANEG EMIAOYEC EXOUME OTAV
€10ayoupE €va unepoUVOEDHO;

ApacTnpIOTNTEG YIA TO ZNiTI

25.

Na €l0ayayeTe uNEPOUVOECHOUG NOU 0dNYOUV OTIC ENIONUES I0TOOEAIOEG TWV NalyVIBIWV
TNG 10TooeAidag Games. Mnopeite va evronioeTe TIG OIEUBUVOEIC TwV ICTOOEAIDWY,

XpnoidonolwvTag pia pnxavn avalntnong.
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®YAAO EPrAZIAZ N.5.5.M9
Mpootnkn Kwdika, Eqpappoyeg Koupma

Ti 6a padoupe onyuepa:

© Na ei10dyoupe K)OIKa O€ I0TOOEAIDA

© Na €10ayoule Koupnia

© Na npooBEToupe epappoyec (Apps) Kal va €I0AYOULE TA AVTIOTOIXa AVTIKEIPEVA.

ApaoTtnpioTnTeG EPnédmong

10.

11.

12.

13.

Na avoifete  évav  QUAopETPNT) Kal  va  PetaBeite  otn  OielBuvon
https://www.weebly.com.

Na ouvdeBeiTe oTov Aoyapiacuo odg,
Na emAé€eTe Tov I0TOTONO Gaming Kal va naTtnosTe ene€epyacia (Edit Website).

Ano To pevou e@apupoywv (Apps), oTnv katnyopia Spike Sales va npooB&éoete TNV
epappoyn TrustedSite. Znueiwon: H epapuoyn autn dev xpeldleTal va TonobetnOei ot
kdnola 10ToogAida Tou I0ToToNoU oac. ‘OTav o 10TéToNoG dnUoaoieubei, Ba spgavilel oTnv
KaTw O€€Ia ywvia KaBe 16TO0EAIBAG OTI O I0TOTONOG 0AG €ival EAEYUEVOG Kal OEV NEPIEXEI
10UG.

>Tnv Iotooehida Contact Us va TonoBeTrnoeTe éva koupni (Button) kdtw and Tov Xaptn.
270 koupni va ypawete Email Us kal va epapuoceTe OMNOIEC HOPPOMOINTEIC ENIBULEITE.
AkohoUBwg, oTo Link va emiAéEeTe Email kal va ypaweTe Tn dielBuvon 0ag, WOTE HE TO
nNAaTnUa TOU KOUMMIOU va WnopoUV va 0ag OTEAVOUV  PNvUHaTa  NAEKTPOVIKOU
TaXUOPOEIOU Ol EMIOKEMNTEC.

Y€ auTo To Briua, Ba npooBEcoupE £va avTikeipevo PeTpnTn (counter) To onoio Ba PeTpa
TOUG EMIOKENTEC TOU IOTOTOMOU Mac. ©a XPnoIJOMOINCOUKME TO QVTIKEIHEVO KwdIKa
(Embed Code) kai 6a napoupe €ToIpo Kwdika and aAAo 16ToTomno.

Na TOnoBETNOETE OTO KATW MEPOG TNG NPWTNG TNG deUTEPN 10TOCEAIDAG TOU 10TOTONOU
oag eva avTikeipevo kwdika (embed code).

Na avoi&eTe pia véa kapTeAa oTov PUANOUETPNTN 0AC KAl va NIOKEPOEITE pia 10ToogAida
nou nNpoogepel dwpeav PeTpnTn (n.x. http://www.hitwebcounter.com).

Na eMIAEEETE TOV PETPNTN MOU 0AC APEDEL.
>70 nAaiolo Page Name va nAnkTpoAoynoete Tn dielBuvon Tou 10TOTONOU 0ac.

210 Counter Type va eniAéEeTe Unique Visitors, wOTE va PHETPA HOVO TOUG EMIOKENTEG KAl
OXI NOOEG POPEG EMICKEPONKE 0 iBI0G EMNICKEMTNG OTOV I0TOTONO OdC.

Na natrioeTe To koupni Get Your Counter Code.

Na emAEEETE kal va avTiypAWeTe Tov KWIIKA anod To AeUkO nAdiclo.
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r.5.5.M9 I'5 AikTua YnoAoyioTov kai AiadikTuo

14.

15.

Na €MIOTPEYETE OTNV KAPTEAA TOU 10TOTONOU OAG KAl va €NIKOANNOETE TOV KwJIKA OTO
nAQiolo KwJIKA NMou EXETe TONOBETAOEI OTO BriKa a.

Na dnuooIeUOETE TOV I0TOTOMO.

ApaoTnpioTnTeg ASI0AOYNONG

16.

17.

18.

19.

And TO pevou epappoywv (Apps), oTnv kaTtnyopia Get Social va npooBeoste TNV
epappoyr) Comments Plus+. H epappoyn auTn divel Tn duvaToTnTa OTOUG EMIOKENTEC VA
apnvouv oxXoAia opata o€ OAouc. AQoU NPoaBECETE TNV epappoyn, oTo pevou Build Ba
npooTedei To €ikovidio Comments, TO OMOIO PMOPEITE va TONOBETAOETE OTIC IOTOOEAIOEG
0ag Je TNV TEXVIKN oUpe kal apnoe (drag and drop), 6nwg kai Ta undAoina avTiKeipeva.

Na TonoBeTnoeTe To avTikeipevo Comments g€ ONoIo onNUEio Tou I0TOTONOU 0AG KPIVETE
oTI Taipialel kaAUTepa. Ekei Ba a@rvouv Ta oXOAIG TOUG Ol EMIOKENTEG TOU I0TOTOMOU
oac.

>Tnv 1oTooeAida Games va TonoBeTnoeTe £va koupni dinAa anod Ta apyeia. Na ypayere
oTo  koudni  «More» kal va TO OUVOECETE ME TNV 10TOOEAIdA
https://player.yoyogames.com/.

XpnoiponoiwvTag avTikeigeva kwdika (Embed Code), va eicayayete eikovidia Like kai
Share, woTe 01 XprOTEG TOU KOIVWVIKOU OIkTUoU Facebook va pnopolv va kavouv Like
kal Share Tov 10TOTONO OAG,.

(a) Na TonoBetnoTe OUO avTikeideva kwdika oTnv apxikn cehida r oTnv 1I0TooeAIda
About Us.

(B) Na avoitete pia véa kapTéAa OTOV QUANOMETPNTN OAG Kal va ENIOKEPOEITE TNV
lIoTooeAida https://developers.facebook.com/docs/plugins/like-button.

(y) ZTto nAaioio URL to Like va nAnkTpoAoynoete Tn dilBuvaon Tou I0TOTONOU 0ag,.
(8) ZT0 nAaiolo Layout va eniAéEeTe standard.
(¢) ZTo nmAaiolo Action Type va enmiAegeTe Like.

(oT)Na BeBaiwbeite 6T n emAoyn Include Share Button €ival evepyonoinuevn, €kTog av
DENETE Ol EMIOKENTEC TOU 10TOTOMOU 0AC va KAvouv Wovo Like, aA\a oxi Share Tov
I0TOTONO OAC.

(0) Na naTtnoete To Koupuni Get Code.
(n) Na emAEEETE kal va avTiypdyeTe Tov KOOIKA and To NpwTo NAdicio.

(0) Na emoTpeweTe 0TNV KAPTEAA TOU 10TOTONOU 0Ag Kal va €MIKOANCETE TOV KWOIKA
oTo €va anod Ta duo nAaigia KwdIka Nou EXETe ToNoBeTNOEI 0TO PBriua a.

(1) Na emAEEeTe kal va avTiypayeTe Tov Kwdika and To deUTePO nAdialo.
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(1a) Na enioTpEYeTE OTNV KAPTEAA TOU 10TOTONOU 0aC Kal va €MIKOAMNOETE TovV KWOIKA
0TO AA\o nAdiolo kwdIKa Nou EXETE TONOBETNOEI 0To BrUA a. Z& auTtd To nAaicio Ba
EugavioTouv Ta eikovidia Like kar Share, ondTte BeBaiwBeite OTI Autd TO MAQICIO
KwJIKa €ival 0TO onpEIo Nou BENETE va eugavioTolV Ta glkovidia.

20. Na dnpoaoIeUCETE TOV IOTOTOMO.

*+ Eninpoo0erec ApaoTnpioTnTEG

21. Na npoobeoeTe éva akopa nAaiolo kwdika kal, akoAoUBwc, pe Tn BonBeia Tou kabnynTn
0ac va €loayayeTe £vav Xproiho Kwdika aTov I0TOTONO 0dac,.

22. € TI XpNOIPEUOUV Ol EPAPHOYEC;

ApaoTnpIOTNTEG YIA TO ZNiTI

23. Na onueiwoeTe dUO EPAPHOYEC MOU OEV EXOUKE XPNOIKOMNOINCEl Kal va €ENYNOETE T
NPoCoBETOUV O€ €vav I0TOTOMO.
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®YAAO EPTrAZIAZ .5.5.M10
Anpoupyia IoTooeAidag - Tehikn Epyacia

Ti 6a padoupe onpepa:
© Od dnNUIOUPYNOOUKE OAOKANPWHEVO IGTOTOMNO, XPNOIKOMNOIMVTAG OAEC TIG YVWOEIG NoU PAdaue oTa
nponyouUueva pyadbnuara.

ApaoTtnpioTnTeg EPnédmwong kai AEIoAdynong

Na dnMIoUPYNOETE €vav OAOKANPWHEVO IGTOTOMO, XPNOIKOMNOIWVTAG Ta pyaAsia nou padaTe
oTa nponyoupeva pabnuarta. H epyacia pnopei va ivar atopikn f; opadikn. Mnopeite va
XPNOIHONOoINOETE UANIKO (£IKOVEG, BivTeo K.AM.) and To d1adikTuo N va QPEPETE dIKO 0aG UAIKO
Mou NNPATE WE TNV Yn@Iakn oag Kapepa.

MpoTeivopeva B€para:
(a) IoTdTONnOG YIa TNV ENIXEIPNON TNG OIKOYEVEIAG OAG
(B) NMpoownikdg I0TOTONOG — Bioypagiko
(y) IoToTonog yia €va ayannuevo oag Xouni
(6) IoToTonog yia Texvoloyia (KivnTd, UNoAOYIOTEG K.Am.)
(¢) AMo B£pa, o€ ouvevvonon We Tov kaBnynTr/kabnynTpia oag
Anpioupyia:
MnopeiTe va eMIAEEETE TO OVOWA TOU I0TOTOMOU, TO OVOUA TOMEA KAl TO MPOTUMO Mou

EMIOUEITE.

IoTooeAidEG:
O 10TOTONOG 0ag va NeEPIEXEI TOUAAXIOTOV TPEIG IGTOOEAIDE,

(a) Ze ka@Be 10TOOEAIDA Vva NepINABETE Goa TUNMATA KPIVETE NWG XpelalovTai.
(B) Mnopeite va xpnaoiponoinoete onolo €idog kepaAidag (header) BEAeTE.

(y) Zta Tunuarta kdale 1oTooeAidag va xpnoiponoinoste diaxwploTika (dividers) kai
Keva (spacers), WOTE TA AVTIKEIYEVA 0AC va €XOUV OWOTH GTOIXION.

(0) e kaBe 10TOOEAIDA KAl TUNUA MMOPEITE VA XPNOIUOMOINCETE OMoIO POVTO DEAETE.
Na XpnOILONOINCETE EIKOVEC KAl XpPWHATA WC (POVTO.

AvTikeipeva:
O 10TOTONOG 0aG va NePIEXEI TOUAAXIOTOV EVVEA anod Ta akOAouba avTiKeipeva:
(a) MAqioio TITAOU HE TIG KATAAANAEC HOPPOMOINTEIG

(B) MAqioio keIpevou PE TIG KATAANAEG HOPPOMOINTEIG
(y) Eixova
(8) Napouaciaon €IKOVWV

(e) TkaAepi €IKOVWV
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(oT)BivTeo: MnopeiTe va XpnoidonoinoeTe Bivreo and Tov 1oToTono YouTube
(O) DoOppa enikovwviag

(n) Xaptn

(8) 'Epeuva

(1) ®Opua eyypadng os evnUepwTIKO deATio (newsletter)

(1a) Apxeio

(1B) Koupni

Méoa KoIVWVIKNG JIKTUWONG:

(a) Na ouvdEoeTe ToV IOTOTOMO WE TO MPOMIA 0ac ) TNV avTioToIXn I0TOOEAIda o€
KAMoIO PETO KOIVWVIKNG SIKTUWANG.

(B) Na sioayayete kwdIKA WOTE O ENICKENTEC va Pnopouv va kavouv Like kai Share
ToV 10TOTONO 0ag oTo Facebook.

(y) Na npooBeoeTe TIC KATAMNAECG AEEEIC KA€IOIA, WOTE 0 1I0TOTONOC 0Ac va evTonileTal
€UKOAa ano TIC unxavéc avaldnTnonc.

(®) Na eicayayete TOUAAXIOTOV €vav UNEPOUVOECHO KEIMEVOU Kal Evav UNEPOUVOECHO
eIkovac.
(¢) Na npocBeoeTe [ia epappoyn oTov I6TOTONO OdC,

(oT)Na OnuooieloeTe TOV 10TOTONO OAC Kal va Tov NPOBAAeTe og emiTpaneio
unoAoyIoTr Kal OE @OpPNTH OUCKeUn (TNAEQWVO N TAPnAETa). Av XpeiaoTouv
aMayég (yia napddelypa oTa XpwuaTa Tou I0TOTONoU), va TIG KAVETE.
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